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Remedies

Unauthorized use, copying or disclosure of the Software, Coded Font Programs, Typefaces, Trademarks or accompanying documentation will result in automatic 
termination of this license and will make available to Electronics For Imaging other legal remedies.

Limited Warranty And Disclaimer

Electronics For Imaging warrants that, for a period of ninety (90) days from the date of delivery to you, the Software under normal use will perform without 
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For warranty service, please contact your authorized service/support center.
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Export Controls

You agree that you will not export or re-export the Software or Coded Font Programs in any form without the appropriate United States and foreign government 
licenses. Your failure to comply with this provision is a material breach of this Agreement.

Government Use

Use, duplication or disclosure of the Software by the United States Government is subject to restrictions as set forth in subdivision (c) (1) (ii) of the Rights in 
Technical Data and Computer Software clause at DFARS 252.227-7013 or in subparagraphs (c) (1) and (2) of the Commercial Computer Software—Restricted 
Right Clause at 48 CFR 52.227-19, as applicable.

Third Party Beneficiary

You are hereby notified that Adobe Systems Incorporated, a California corporation located at 345 Park Avenue, San Jose, CA  95110-2704 (“Adobe”) is a third-
party beneficiary to this Agreement to the extent that this Agreement contains provisions which relate to your use of the Fonts, the Coded Font Programs, the 
Typefaces and the Trademarks licensed hereby.  Such provisions are made expressly for the benefit of Adobe and are enforceable by Adobe in addition to Electronics 
For Imaging.

General

This Agreement will be governed by the laws of the State of California.

This Agreement is the entire agreement held between us and supersedes any other communications or advertising with respect to the Software, Coded Font 
Programs and accompanying documentation.

If any provision of this Agreement is held invalid, the remainder of this Agreement shall continue in full force and effect.

If you have any questions concerning this Agreement, please write to Electronics For Imaging, Inc., Attn: Licensing Dept. or see Electronics For Imaging’s web 
site at www.efi.com.

Electronics For Imaging
303 Velocity Way
Foster City, CA 94404
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xiii About this manual

                 
This manual is intended for Fiery X12 or Fiery XP12 Color Server™ operators or 
administrators, or users with the necessary access privileges, who monitor and manage 
job flow, and troubleshoot problems that may arise. It describes the functions and 
features of Fiery® utilities and Fiery WebTools™ for the purposes of print job 
management and color quality control. 

NOTE: The term “Fiery” is used in this manual to refer to the Fiery X12 or Fiery XP12 
Color Server. The Fiery supports the DocuColor 12 digital copier printer. The term 
“copier” is used to refer to the DocuColor 12.

This icon specifies information, features, or procedures that apply only to the 
Fiery X12.

This icon specifies information, features, or procedures that apply only to the 
Fiery XP12.

The Fiery includes Command WorkStation™ software, which enables an operator to 
manage all jobs sent to the Fiery. Although it may not be the case at all sites, the 
documentation for this product assumes the presence of an operator who controls and 
manages jobs sent by users from remote workstations.

Client utilities can be installed onto the Fiery from the User Software CD if the Fiery 
Advanced Controller Interface option is installed. Do not install any other applications 
onto the Fiery. Other applications are not supported and can cause system problems.

About this manual
This manual is organized as follows:

• Chapter 1 describes the Fiery Control Panel. It explains the various messages and 
icons that you might see on the Control Panel and describes how to print system 
information pages from the Control Panel. It also explains how to start up and shut 
down the Fiery.

• Chapter 2 describes the FieryBar™. It explains the various messages and icons that 
you might see and also explains how to start up and shut down the Fiery if you have 
the Fiery Advanced Controller Interface installed.

Preface

X12

XP12
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• Chapters 3 and 4 describe the Command WorkStation interface. The Command 
WorkStation application can be installed on networked Windows 95/98 and 
Windows NT 4.0 computers and is used to view and manage virtually all aspects of 
Fiery activity. In addition to providing a graphic display of the job flow, the 
Command WorkStation allows you to reprint or hold jobs, view and override print 
option settings, download files, manage printer fonts, preview print jobs, merge 
rasterized jobs, calibrate the Fiery, and perform Setup (server configuration). This 
chapter also provides information on archiving jobs, moving jobs between Fiery 
color servers, and printing variable data documents.

• Chapter 5 describes how to use the Imposition feature of DocBuilder Pro™ to 
arrange the pages of your print job in special layouts for folding, binding, or cutting 
after printing. The Imposition feature is only available if you have the DocBuilder 
Pro Upgrade for the Command WorkStation installed.

• Chapter 6 provides instructions on using the advanced aspects of the Imposition 
feature of DocBuilder Pro to create custom layouts and get the most from the 
Imposition feature.

• Chapter 7 introduces Fiery WebTools, explains how to access them, and directs you 
to sources of more information (in this manual or in other manuals in the 
documentation set).

• Chapter 8 describes Fiery WebSpooler and Fiery Spooler™, which can be used to 
view and manage Fiery job activity. The interface and features of Fiery WebSpooler 
have identical counterparts in the Command WorkStation; therefore, this chapter 
refers you to Chapters 3 and 4 for details about many Fiery WebSpooler functions.

• Appendix A provides an overview of the terms and concepts of Imposition including 
various folding, binding, and cutting methods.

• Appendix B includes descriptions of the built-in templates available from the 
Imposition feature of DocBuilder Pro.

• Appendix C lists error messages that you might see on the Fiery Control Panel, the 
FieryBar, the Command WorkStation, Fiery WebSpooler, Fiery Spooler, or the 
copier, and contains some troubleshooting information.
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Terminology
Specific terms are explained as they are introduced. However, the following general 
terms are used throughout:

• PostScript (PS) —A computer language designed as a page description language. The 
Fiery uses this language for imaging the page and for communication with 
applications and with the print engine.

The term “PostScript” can also be used to refer to PDF data jobs. PDF is a 
structured form of PostScript that provides the ability to preview, scale, and reorder 
pages. Where applicable, the term “PDF” is specifically used to refer to PDF data or 
jobs.

• Printer Control Language (PCL)— A computer language designed as a page 
description language. The Fiery uses this language for imaging the page and for 
communication with applications and with the print engine.

• Job—A file consisting of PostScript or PCL commands and comments that describe 
the graphics, sampled images, and text that should appear on each page of a 
document, and the printer options that should be used in printing, such as media or 
color rendering style.

• Spool —Write to a disk. Usually used in this manual to refer to a PostScript or PCL 
print job being saved to the Fiery hard disk in preparation for processing and 
printing.

• RIP—Acronym for raster image processing, which changes text and graphics 
commands into descriptions of each mark on a page. In common use as a noun, a 
“raster image processor” (RIP) is the computer processor that performs this function.

• Print—The process of rendering, or imaging, a page or a job on a printer.

These concepts can explain how the Fiery and the copier work together as a powerful 
printing system. The Fiery RIP changes text and graphics commands in PostScript or 
PCL into color specifications for each dot of toner deposited on a page by the copier.
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About the documentation
This manual is part of the set of Fiery documentation, which includes the following 
manuals for users and system administrators:

• The Configuration Guide explains basic configuration and administration of the 
Fiery for the supported platforms and network environments. It also includes 
guidelines for setting up UNIX, Windows NT 4.0, and Novell NetWare servers to 
provide PostScript and PCL printing services to clients.

• Getting Started describes how to install software to enable users to print to the Fiery. 
Specifically, it describes installation of PostScript and PCL printer drivers, printer 
description files, and other user software provided on the User Software CD. It also 
explains how to connect each user to the network.

• The Printing Guide describes the printing features of the Fiery for users who send 
jobs via remote workstations on the network.

• The Color Guide provides information on managing the color output of your 
Fiery X12/XP12 Color Server. It addresses concepts and issues associated with 
printing to the Fiery and outlines key workflow scenarios. This manual explains how 
to calibrate your copier and take advantage of the ColorWise® color management 
system as well as features in ColorWise Pro Tools™. In addition, the Color Guide 
offers information on printing from popular Windows and Mac OS applications.

• The Job Management Guide explains the functions of the Fiery client utilities, 
including the Command WorkStation, and how they can be used to manage jobs. 
This manual is intended for an operator or administrator, or a user with the 
necessary access privileges, who needs to monitor and manage job flow, and 
troubleshoot problems that may arise.

• Release Notes provide last-minute product information and workarounds for some of 
the problems you may encounter.

Fiery job environments
The Fiery supports several levels of control of printing, job management, and setup, 
and offers you the flexibility to choose the configuration that corresponds to the 
requirements of your site. Your situation may correspond to one of the descriptions 
outlined below, or you may prefer an intermediate level of control.
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At one extreme, an administrator or operator in a high-volume printing environment 
controls the entire job flow and all printing. Print jobs arriving from remote users are 
spooled to the server disk and stored until the operator decides it is time to print them. 
Additional functions (calibration, job overrides, prioritizing, font management) are 
reserved for the administrator or operator.

At the other extreme, anyone on the local network can control all printing and server 
functions; operator intervention is not necessary. Users can print from their 
workstations to any of the published print connections. Anyone can use the Command 
WorkStation, Fiery WebSpooler, or Fiery Spooler to control any print job.

The spectrum of control that an administrator can implement is described fully in the 
Configuration Guide.

Permissions
Support for these job environments is achieved by a combination of Fiery Setup 
options. By default, anyone can access Setup, but the administrator can limit access to 
Setup by specifying an Administrator password for the Fiery (see the Configuration 
Guide).

Also by default, anyone can log in to the Command WorkStation, Fiery WebSpooler, 
or Fiery Spooler and control job flow, but an administrator can restrict access to these 
functions by specifying an Operator password.

The three security levels from greatest to least control are:

• Administrator —confers control of Setup and is the highest level of control. The 
person who has access to Setup can control the printing and job management 
environment by choosing which queues are enabled, and by electing to set 
passwords. The Administrator can also manage the fonts on the server, clear the 
server disk when necessary, and set a common web link for all users who log in to the 
Fiery using their web browser. 

• Operator —includes control of print jobs that arrive at the server and the ability to 
perform calibration and reboot the server.
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• Guest—allows users to view the status of active jobs and the list of stored jobs. They 
cannot make changes to jobs or change their printing instructions. A password is not 
needed to log in as Guest and view jobs from the Command WorkStation, Fiery 
WebSpooler, or Fiery Spooler windows.

This manual describes the features of the Fiery client utilities, including the Command 
WorkStation, and all operator privileges, whether those privileges are available to 
everyone or are exclusive to only certain people. It also includes descriptions of 
administrator functions, sometimes referring you to other manuals for more 
information.

Safety warnings
The Fiery display window is a liquid crystal display (LCD) that is made of glass and 
can break. Do not subject it to strong shocks.

If the display window breaks and the liquid crystal material leaks out, do not inhale, 
ingest, or touch it. If the material gets on your skin or clothing, wash it off with soap 
and water immediately.

Do not touch or put pressure on the panel. This will change the color of the panel.

Cleaning the Fiery
Clean the Fiery with a soft cloth moistened with isopropyl alcohol or ethyl alcohol. 
Never use water or ketone as these may permanently alter the display.
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You can use the Fiery Control Panel to view status information, print special pages, 
and set up printing. While most elements in the Control Panel display have 
counterparts in the Command WorkStation, you can view current functions on the 
Control Panel even when the Command WorkStation is not connected to the server or 
is not running.

Introduction to the Fiery Control Panel
The Control Panel shown below is located on the front of the Fiery.

Fiery X12

Fiery XP12
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Line selection buttons
Up button

Menu buttons
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Line selection buttons

Activity light

Display window

Up button
Menu button

Down button
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Activity light
The activity light indicates the current Fiery activity. If the light is:

Buttons

Solid red An error has occurred causing the Fiery to be disabled.

Flashing red There is an error causing printing to be disabled, but the 
Fiery is capable of processing.

Solid green The Fiery is idle.

Flashing green The Fiery is processing or printing a job, or communicating 
with a remote computer.

No light The Fiery is off or starting up.

Line selection 
buttons

There are four line selection buttons on the right side of the 
Control Panel. Use these buttons to select the command 
displayed on the corresponding line of the display window. 
When a button is active, a special character (>) appears in the 
display window next to the button.

Up and down 
buttons

Use these buttons to scroll to different screens in multi-
screen lists, to select Setup options from a list of available 
options, and to scroll alphanumeric characters. 

Menu button Press this button to view other screens. Under normal 
operation, the Control Panel displays the Info, RIP, or Print 
Status screen with information about the status of the Fiery. 
If you press the Menu button, the Functions menu is 
displayed and you can perform additional operations (see 
page 1-5). If a job is processing or printing, press the Menu 
button to cycle among the active screens.



11-3 Introduction to the Fiery Control Panel
Display window
The display window provides information about the status of the Fiery, displays menu 
information, and enables you to view and edit information in the Setup menus.

The status area at the bottom of the display window displays text that tells you what 
screen you are looking at and highlights one of the icons to indicate what the Fiery is 
doing. Only the icons for the screens that are currently available appear. The menu 
button cycles among the active screens.

The screens are:

Alert Status If there is a problem with processing a job or printing functions, an error message 
appears on the Control Panel. For information on error messages, see 
Appendix C, “Troubleshooting.” 

Print Status When the Fiery is printing a job, the Print Status screen appears. This screen 
displays the following:

Cancel Job —Press the top line selection button to cancel the job currently 
printing. 

User name —The name of the user who sent the job currently processing.

Pages/Total —The number of copies of the current job printed and the total 
number of copies of the job requested.

RIP Status When the Fiery is processing a job, the RIP Status screen appears. This screen 
displays the following:

Cancel Job —Press the top line selection button to cancel the job currently 
processing. The Fiery cancels the job before printing begins.

Document name —The name of the document currently processing.

User name —The name of the user who sent the job currently processing.

Kilobytes—The size (in kilobytes) of the job processed so far. 

NOTE: This number is always displayed in kilobytes; for example, 10MB is 
displayed as 10000KB.
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Info Status When the Fiery is not processing or printing a job, it displays information about 
the current server and software. It displays the following information:

Server Name —The Fiery name, as it is configured in Setup.

Status —The current status of the Fiery. The Fiery status can be: Idle, Initializing, 
Busy, Processing, or Printing.

Megabytes —The space (in megabytes) available on the Fiery hard disk, for 
example, 756MB.

Version—The system software version running on the Fiery.

Functions You can press the Menu button to display the Functions menu. Use the up and 
down buttons to scroll through the list. Press the line selection button to the right 
of a command to select that command. See page 1-5 for more information.

Network The network icon appears at the bottom left of any of the other screens when a 
job is being sent to the Fiery, either over the network or through the parallel port. 
The network icon also appears, together with a flashing green activity light, when 
a remote utility is running.
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Functions menu
The Functions menu provides many of the options available from the Command 
WorkStation. You can choose the following commands from this menu:

Print Pages Print special pages from the Fiery. You can print the following pages from the 
submenu that appears:

PS Test Page /PCL Test Page —A Test Page enables you to confirm that the Fiery is 
properly connected to the copier, and provides color and grayscale samples to 
troubleshoot problems with the copier or the Fiery. The following settings are 
among those listed on the Test Page: Server Name, Printer Model, color settings, 
calibration information, date and time the Test Page was printed.

Configuration —Prints the Configuration page, which gives the current server and 
device configuration. This page lists general information about the hardware and 
software configuration of the Fiery, the current options for all Setup settings, 
information about the current calibration, and the Ethernet and Token Ring 
addresses of the Fiery. 

Job Log—Prints a log of the last 55 jobs. For information on the fields in the Job 
Log and on printing it in other forms, see “Job Log window” on page 3-34.

Control Panel Map— Prints the Control Panel Map, which is an overview of the 
screens you can access from the Control Panel. For information about using these 
screens to set up the Fiery, see the Configuration Guide.

Color Charts —Prints samples of the RGB, CMY, and PANTONE colors available 
from the Fiery. 

PS Font List/PCL Font List—Prints a list of all fonts currently on the Fiery hard disk.

Suspend Printing Suspend communication between the Fiery and the copier. You must suspend 
printing if you want to interrupt the current Fiery job so that you can use the 
copier to make copies. Jobs continue to process on the Fiery. After you make the 
copies, select Resume Printing  to continue printing jobs from the Fiery.

Resume  Printing Resume communication between the copier and the Fiery after you have finished 
making copies. 
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Starting and shutting down the Fiery
Generally, you can leave the Fiery running all the time. This section describes how to 
shut down and restart the Fiery when necessary.

Starting the Fiery
To start the Fiery, move the power switch on the back of the Fiery to the On position. 
If the copier is also powered off, power it on before powering on the Fiery.

Shut  Down Shut down all Fiery activity in the correct manner and then restart. You should use 
this option instead of the power switch on the back of the Fiery. The following 
options are available from the submenu that appears:

Restart Server —Restarts the server without shutting down the Fiery hard disk.

Shut Down System —Shuts down the Fiery hard disk.

Reboot System —Restarts the system after shutting down the Fiery hard disk.

Clear  Server Clear all jobs in all server queues as well as all jobs archived on the Fiery hard disk, 
the index of archived jobs (in the Archive window), all FreeForm masters, the index 
of FreeForm masters (in the FreeForm window), and the Job Log. Check with your 
administrator or operator before choosing Clear Server. If an Administrator password 
has been set, you must enter it to access Clear Server.

Run Setup Enter the Setup menu and change Setup option settings. See the Configuration 
Guide for more details.

Run Diagnostics This function is provided for service representatives only. Contact your authorized 
service/support technician for information about running diagnostics.

Calibration Calibrate the Fiery using AutoCal. For more information, see the Color Guide. If an 
Administrator password has been set, you must enter it to access Calibration.
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Fiery X12

Fiery XP12

Diagnostic messages appear on the Fiery Control Panel. If any diagnostics fail, more 
information and instructions appear. Contact your service representative if the Fiery 
encounters problems while running the diagnostics. The Fiery continues starting up 
and displays the message Idle when it is ready to receive data.

NOTE: If an Administrator password has been set, you are required to enter it to access 
Setup. 

When the display reads Idle, press the Menu button to enter the Functions menu. 
Choose Run Setup, and the following options appear. For information about the Setup 
menus and options, see the Configuration Guide.

Choose: To do this:

Exit Setup Exit the Setup menus; the Fiery reboots.

Server Setup Enter the Server Setup menus. 

Network Setup Enter the Network Setup menus.

Printer Setup Enter the Printer Setup menus.

X12

Power switch

XP12

Power switch
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Restarting the Fiery
You should use the procedure described below to restart the Fiery rather than using the 
power switch on the back of the Fiery. 

TO RESTART THE FIERY:

1. Make sure that the Fiery is not receiving, processing, or printing a job. 

Make sure that the status message on the Control Panel is Idle.

NOTE: If the Fiery is restarted when jobs are waiting to RIP or print, these jobs are 
moved to the Hold queue. Once the server is restarted, you must select these jobs in 
the Hold queue and select RIP and Hold, Print, or Print and Hold from the Job menu.

2. Press the Menu button to display the Functions menu.

3. Use the down button to scroll to the last screen and choose Shut Down.

4. Use the line selection button to choose Restart Server.

PS Setup Enter the PostScript Setup menu.

PCL Setup Enter the PCL Setup menu.

Color Setup Enter the Color Setup menu.

Job Log Setup Enter the Job Log Setup menu.

Change Password Change the Administrator password.

Choose: To do this:
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Shutting down the Fiery
You may need to shut down the Fiery for service. When you do so, fonts that have 
been downloaded to the hard disk drive are not deleted. Print jobs in the Hold and 
Printed queues and jobs that have been processed but not printed are not deleted and 
are available for printing when you restart the Fiery.

TO SHUT DOWN THE FIERY:

1. Make sure that the Fiery is not receiving, processing, or printing a job.

Make sure that the status message on the Control Panel is Idle. If a job has just finished 
processing or printing, wait at least five seconds after the Control Panel status message 
changes to Idle before proceeding.

NOTE: If the Fiery is restarted when jobs are waiting to RIP or print, these jobs are 
moved to the Hold queue. Once the server is restarted, you must select these jobs in 
the Hold queue and select RIP and Hold, Print, or Print and Hold from the Job menu.

2. Press the Menu button to display the Functions menu.

3. Use the down button to scroll to the last screen and choose Shut Down.

4. Use the line selection button to choose Shut Down System.

Proceed to the next step when the screen displays the message, “It is now safe to power 
off the server.”

5. Power off the Fiery by moving the power switch on the back to the Off position.

NOTE: After powering off the Fiery, make sure to also power off the copier. Leaving the 
copier powered on while the Fiery is powered off can lead to excessive drain on the 
Fiery motherboard battery.
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If you have the Fiery Advanced Controller Interface option installed, you can use the 
FieryBar to view Fiery status information, launch software, set up and restart the Fiery, 
delete stored jobs, cancel active jobs, and log off Windows. While most elements in the 
FieryBar have counterparts in the Command WorkStation, you can view current 
functions on the FieryBar even when the Command WorkStation is not running.

Introduction to the FieryBar
The FieryBar, located at the top of the monitor screen, comprises the following parts:

Status
The FieryBar displays information about the status of the Fiery:

RIPping area Displays the name of the job currently processing.

RIP status area Displays the amount of the job that has processed.

Printing area Displays the name of the job currently printing.

Message area Displays error messages and other Fiery information.
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Activity light
The activity light in the right corner of the FieryBar indicates current Fiery activity. If 
the light is:

Commands
Right-clicking the FieryBar or the Fiery icon on the right side of the Windows taskbar 
enables you to access many Fiery features. You can choose the following commands 
from the menu that appears:

Solid red An error has occurred causing the Fiery to be disabled. 
Check the message area for details of the error.

Flashing red There is an error causing printing to be disabled, but the 
Fiery is capable of processing. Check the message area for 
details of the error.

Solid green The Fiery is idle.

Flashing green The Fiery is processing or printing a job, or communicating 
with a remote computer. Check the RIPping area, the RIP 
status area, and the printing area for details.

No light The Fiery is starting up.

Command WorkStation Launches the Command WorkStation. For more 
information on connecting to and using the features of 
the Command WorkStation, see Chapters 3 and 4.

ColorWise Pro Tools Launches ColorWise Pro Tools. For more information 
on connecting to and using the features of ColorWise 
Pro Tools, see the Color Guide. 

Set Up Fiery Opens the Fiery Setup dialog box. For more 
information about the Setup options, see the 
Configuration Guide.

Restart Fiery Shuts down all Fiery activity in the correct manner 
before restarting. You should use this option instead of 
the power switch on the back of the Fiery (see 
“Starting and shutting down the Fiery” on page 2-4).



22-3 Introduction to the FieryBar
Clear Server Clears all jobs in all server queues as well as all jobs 
archived on the Fiery hard disk, the index of archived 
jobs (in the Archive window), all FreeForm masters, 
the index of FreeForm masters (in the FreeForm 
window), and the Job Log. Check with your 
administrator or operator before choosing 
Clear Server. After choosing this option from the 
FieryBar, a warning message appears; click OK to clear 
the server and restart the Fiery.

Cancel RIP Cancels the job currently processing on the Fiery.

Cancel Print Cancels the job currently printing on the Fiery.

Suspend Print Suspends communication between the Fiery and the 
copier. You must suspend printing if you want to 
interrupt the current Fiery job so that you can use the 
copier to make copies. Jobs continue to process on the 
Fiery. After you make the copies, select Resume 
Printing to continue printing jobs from the Fiery.

Resume Print Resumes communication between the copier and the 
Fiery after you have finished making copies.

Run Diagnostics
Test Scan/Print
Test I/F board

This option is provided for service representatives only. 
Contact your authorized service/support technician 
for information about running diagnostics.

Log Off Windows Closes all open programs, enabling you to log on as a 
different user. After choosing this option from the 
FieryBar, a warning message appears; click OK to log 
off.

Hide FieryBar Hides the FieryBar. To show the FieryBar after hiding 
it, right-click the Fiery icon on the right side of the 
Windows taskbar and choose Show FieryBar from the 
menu that appears.



22-4 Using the FieryBar
Starting and shutting down the Fiery
Generally, you can leave the Fiery running all the time. This section describes how to 
shut down and restart the Fiery when necessary.

TO START THE FIERY:

• Push the power switch on the back of the Fiery (see page 1-6). If the copier is 
also powered off, power it on before powering on the Fiery.

When the FieryBar displays Idle, you can enter Fiery Setup by right-clicking the 
FieryBar and choosing Set Up Fiery from the menu that appears.

In the Fiery Setup dialog box, there are three tabs:

For information about the Setup options, see the Configuration Guide.

Restarting the Fiery
You should use the procedure described below to restart the Fiery rather than using the 
power switch on the back of the Fiery. 

Click: To do this:

General Setup Configure the General Setup options. 

Network Setup Configure the Network Setup options.

Printer Setup Configure the Printer Setup options.
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TO RESTART THE FIERY:

1. Make sure that the Fiery is not receiving, processing, or printing a job. 

Make sure that the RIPping and Printing areas on the FieryBar both read Idle.

NOTE: If the Fiery is restarted when jobs are waiting to RIP or print, these jobs are 
moved to the Hold queue. Once the server is restarted, you must select these jobs in 
the Hold queue and select RIP and Hold, Print, or Print and Hold from the Job menu.

2. Right-click the FieryBar, and choose Restart Fiery from the menu that appears.

A Warning dialog box appears.

3. Click OK to restart the Fiery.

Shutting down the Fiery
You may need to shut down the Fiery for service. When you do so, fonts that have 
been downloaded to the hard disk drive are not deleted. Print jobs in the Hold and 
Printed queues and jobs that have been processed but not printed are not deleted and 
are available for printing when you restart the Fiery.

TO SHUT DOWN THE FIERY:

1. Make sure that the Fiery is not receiving, processing, or printing a job.

Make sure that the RIPping and Printing areas on the FieryBar both read Idle. If a job 
has just finished processing or printing, wait at least five seconds after the RIPping and 
Printing areas switch to Idle before proceeding to step 2.

NOTE: If the Fiery is restarted when jobs are waiting to RIP or print, these jobs are 
moved to the Hold queue. Once the server is restarted, you must select these jobs in 
the Hold queue and select RIP and Hold, Print, or Print and Hold from the Job menu.

2. Click the Windows Start button, and choose Shut Down.

3. Select “Shut down the computer?” and click Yes.

A message appears, informing you that it is safe to shut down the computer.

4. Power off the system by pushing the power switch on the back of the Fiery.
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This chapter introduces you to the graphical user interface of the Command 
WorkStation. First, you select a user level and log in to the Fiery. Once you have 
logged in, you can tour the Command WorkStation windows. Your exploration will be 
more complete if you have some jobs in the Spool area (jobs printed to the Hold 
queue) and can send more jobs from a nearby computer.

Chapter 4 builds on the information in this chapter and describes job monitoring and 
control in more depth. 

About the Command WorkStation
The Command WorkStation provides a window on Fiery and copier functions, and an 
interface from which you can control those functions. The Command WorkStation 
application can be installed on a Windows 95/98 or a Windows NT 4.0 computer 
with a network connection to the Fiery. 

By default, no passwords are set on the Fiery—in this default state, anyone can 
perform Setup and use all Command WorkStation functions. Until an Administrator 
password is defined in Fiery Setup, you can log in to the Command WorkStation as an 
Administrator without entering a password, and you are given full privileges. 

After the Administrator has performed Setup and specified passwords, Command 
WorkStation user options depend on your login level. See the table below for a list of 
which privileges are available for each level of access.

Privilege: Guest: Operator: Administrato:r

A view of current printing 
jobs and jobs stored on the 
Fiery

X X X

Control of printing jobs X X

Use of the functions and 
features of DocBuilder Pro

X X
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NOTE: The Imposition feature is available only if you have installed the DocBuilder Pro 
Upgrade for the Command WorkStation. For more information on imposition, see 
Chapter 5.

For information about Setup and specifying passwords, see the Configuration Guide.

After you connect to a Fiery and log in, your first view of the Command WorkStation 
is the Queues window (as indicated by the tab at the bottom), which is divided into 
three regions by Spool, RIP, and Print status bars. The Queues window is surrounded 
by a frame that includes slider buttons and menus.

Once the Fiery receives print jobs, the Queues window becomes a dynamic display, 
filled with the names of jobs and their characteristics. Status bars animate in real time 
as new jobs are processed and printed, and jobs move to different display areas. An 
operator, who has complete job control, sets the process in motion for each job.

Access to Setup, management 
of resident fonts, and clearing 
of the Fiery disk and the Job 
Log

X

Privilege: Guest: Operator: Administrato:r
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The Spool, RIP, and Print areas of the Queues window represent the stages of printing 
a job. Jobs come in at the top level (Spool) and drop down to the Print level, unless 
they are held along the way.

• Spooled jobs —Jobs listed below the Spool status bar area are PostScript or PCL files 
stored on the Fiery disk. These jobs were sent to either the Print queue (white 
printer icons) or the Hold queue (yellow icons).

NOTE: The term “PostScript” is used in this manual to refer to both PostScript and 
PDF data jobs. PDF is a structured form of PostScript that provides the ability to 
preview, scale, and reorder pages. Where applicable, the term “PDF” is specifically used 
to refer to PDF data or jobs.

Spool status bar

RIP status bar

Rasterized (RIPped) jobs

Print status bar

Printed jobs

Spooled jobs

Menu bar
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• RIPped jobs —Jobs listed below the RIP status bar are ready to print. They have 
already been rasterized (RIPped, or processed for printing) and are waiting, in order, 
for access to the printer. Rasterized jobs can also be held; held jobs are displayed on a 
yellow background.

• Printed jobs —Jobs listed below the Print status bar have already been printed. 
Printed jobs can be stored on the Fiery disk. The number of jobs that can be stored 
(from 1 to 99) is defined in Setup.

You can interact with jobs in the window by selecting them and choosing from Job 
menu commands or right-mouse menu commands, or by double-clicking them. 
(However, if passwords have been set and you log in as Guest, you can only view jobs; 
you cannot change or route them.) This chapter and the next explain the Command 
WorkStation interface in detail.

Starting up and logging in
To start up the Command WorkStation application, click the Windows Start button 
and choose Command WorkStation from the Programs menu; or, if you have created a 
shortcut to the Command WorkStation application, double-click the Command 
WorkStation icon.



33-5 Starting up and logging in
Connecting to the server
If the Command WorkStation was previously connected to a server, you are prompted 
to choose a Fiery from the list of servers.

NOTE: If the Command WorkStation has never been connected to a Fiery, you are 
prompted to configure an entry for the server. Click OK and see Getting Started for 
instructions on how to configure a new connection.

With the Fiery device name (DC12) selected, click OK. If the device name is not 
displayed, click the plus sign (+) to expand the Fiery entry.

The Command WorkStation connects to the server and you are prompted to choose a 
login level and enter a password to log in (see the next section). If you have any 
difficulties connecting to the server, see Appendix C for error messages and 
troubleshooting information.
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Logging in
When the Command WorkStation has connected to a server, the Log in/out slider 
appears, prompting you to select a login level and enter a password. Before you log in, 
the Administrator key is in the vertical position, and the Operator and Guest keys are 
in the flat (horizontal) position. When you click your login level, the corresponding 
key turns to the vertical position.

For Administrator or Operator access to the Fiery, click the corresponding key, enter 
the password, and click Log in or press Enter. For Guest access only, click the Guest 
key, and then click Log in. No password is required for Guest access.

If you change your mind about logging in, or do not have the password you need, click 
Cancel.

When you have entered the appropriate password and logged in, the Log in/out slider 
retracts and the full Command WorkStation display appears. The color of the key in 
the lock indicates your login level. If the Fiery is handling a large number of jobs, it 
may take a few moments to display the entire job list.

When you reopen the slider after you have logged in, the Log in button will have 
changed to the Log out button.

Access levels

The three possible levels of access to Command WorkStation functions are 
Administrator, Operator, and Guest. To enable maximum password protection, 
Administrator and Operator passwords must be specified in Setup (see the 
Configuration Guide).

Log in/out slider
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When both Administrator and Operator passwords have been specified, the access 
levels are as follows:

NOTE: Access privileges alone do not confer control of print jobs. If the operator is 
going to manage all print jobs, the administrator must route all user jobs to the Hold 
queue (that is, all jobs are spooled and held on the server). To accomplish this, only the 
Hold queue, and not the Direct connection or the Print queue, should be enabled in 
Setup. See the Configuration Guide for more information.

Logging out
There are two ways to log out from the server:

• From the Server menu, choose Log out

• Open the Log in/out slider (click the key icon just below the Fiery logo) and click 
Log out

The Command WorkStation interface
The display illustrated below is the default Command WorkStation display in the 
middle of job processing. There are three other windows, Archive, FreeForm, and Job 
Log, which you access via tabs at the bottom of the display (3). The elements 
numbered 1 through 4 are common to all Command WorkStation displays, those 
numbered 5 through 7 appear only in the Queues window, and element number 8 is 
common to the Queues, Archive, and FreeForm windows.

Access level: Privileges and password requirements:

Administrator Has full access to all Command WorkStation and Fiery Control Panel 
functions; Administrator password required

Operator Has access to all Command WorkStation functions except Setup, 
clearing the server disk, clearing the Job Log, and font management; 
Operator password required 

Guest Can view job status, but cannot make changes to jobs or Setup, and can 
view the Queues window only; no password required



33-8 Introduction to the Command WorkStation
NOTE: The FreeForm window is always available for the Fiery XP12, but for the 
Fiery X12, the FreeForm window is available only if the Fiery Advanced Controller 
Interface is installed. See Getting Started for more information on enabling installed 
options.

1 Server selection tabs

2 Sliders and system information

3 Window selection tabs

4 Job ticket information

5–7 Queues window display

8 Thumbnail tabs

1

2

3

4
5

6

7

8
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The Command WorkStation provides access to a great deal of information and many 
features that are accessed in various ways—buttons, menus, double-clicking, and 
right-mouse commands. It is a powerful interface that allows for a great deal of 
interaction and flexibility in the production process. This section describes each of the 
elements that compose the Command WorkStation display.

Window area (Queues, Archive, FreeForm, Job Log)
This area can display one of four windows: the Queues window (shown below), the 
Archive window, the FreeForm window, or the Job Log window (only the Queues 
window is available if you logged in as Guest). The Queues window is the default 
window; it shows spooled, processing, and printing jobs in a display that changes 
dynamically.
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Menu bar
The menu bar has six menus. When an action is not available in the current context, 
the command is dimmed.

For information on: See:

Queues area “Queues window” on page 3-16

Archive area “Archive window” on page 3-27

FreeForm area “FreeForm window” on page 3-29

Job Log area “Job Log window” on page 3-34

Menu: Choose this: To do this:

File Preferences Set Command WorkStation preferences; see page 4-5.

Print Pages Print any or all of the following pages to the Fiery: Configuration 
page, PS Test Page, PCL Test Page, Control Panel Map, PS Font 
List, PCL Font List, Color Charts, Job Log. You can also print the 
Configuration page to any printer you specify; see page 4-6.

Exit Log out from the server, exit the Command WorkStation 
application, and return to the Windows desktop.

Job 
(For more 
information 
on these 
commands, 
see page 3-24)

Delete Delete one or more selected jobs.

Duplicate Duplicate one or more selected PostScript or PCL data jobs in the 
Spool or Print areas; see page 3-20, page 3-23, and page 3-24.

Rename Rename a selected job.

Hold Hold the selected job(s); see page 3-19.

RIP and Hold RIP and then hold the selected job(s); see page 3-19.

Print Print the selected job(s); see page 3-23.

Print and Hold Print the selected job(s) and then hold it in the RIP area; see 
page 3-19.
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Process Next Give top priority to this job (Spool area only).

Remove Raster Remove the raster information from the selected job(s); see 
page 3-25.

Properties View and edit print option settings for the selected job(s) and print 
job(s) with new settings; see page 3-40.

Thumbnail A Open a selected held job in the Thumbnail A window, where you 
can view a full-screen preview of the job, edit the job, or merge it 
with like data from other jobs. In order to merge jobs, they must be 
of the same data type (i.e., PostScript jobs cannot be merged with 
raster jobs) and page size. Held jobs in the Spool area are 
automatically converted to PDF files, but are not saved as PDF files 
unless you assign the job a new name or overwrite the existing job; 
see page 3-41.

Thumbnail B Open a selected job in the Thumbnail B window for viewing a full-
screen preview of the job, or for copying pages into a job in the 
Thumbnail A window. In order to merge jobs, they must be of the 
same data type (i.e., PostScript jobs cannot be merged with raster 
jobs) and page size. Held jobs in the Spool area are automatically 
converted to PDF files, but are not saved as PDF files unless you 
assign the job a new name or overwrite the existing job; see 
page 3-42.

Impose Open a selected held PostScript job in the Imposition window; for 
more information, see Chapter 5.

Download Download files and fonts to the Fiery; see page 4-26. You can also 
choose this command by right-clicking the Spool status bar.

Archive Archive one or more selected jobs; see page 3-27 and page 4-32

Import Retrieve one or more archived jobs from an external device; see 
page 4-34. You can also choose this command by right-clicking the 
Spool status bar.

Send to<Server> Send the selected job(s) to another connected Fiery; see page 4-30. 
(This option is only visible when you are connected to more than 
one Fiery at once.)

Menu: Choose this: To do this:

XP12
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Page
(DocBuilder Pro 
commands for 
Thumbnail A)

Delete Delete the selected page(s).

Duplicate Duplicate the selected page(s).

Preview View a full-screen preview of the selected page; see page 3-44.

Undo Undo previous Page menu commands (multiple undos available).

Server Cancel RIPping Stop RIPping the current job. You can also choose this command 
by right-clicking the RIP status bar.

Cancel Printing Stop printing the current job. You can also choose this command by 
right-clicking the Print status bar.

Suspend Printing Temporarily halt printing. You can also choose this command by 
right-clicking the Print status bar.

Resume Printing Restart printing (after a Suspend Printing command). You can also 
choose this command by right-clicking the Print status bar.

Manage Fonts View the fonts currently installed on the Fiery disk, download 
additional fonts, or delete fonts (requires Administrator privileges); 
see “Other server management commands” on page 4-37.

Manage Color Start ColorWise Pro Tools; see the Color Guide.

Clear Job Log Clear all jobs from the Job Log (requires Administrator privileges); 
see “Other server management commands” on page 4-37.

Reboot Perform a soft reboot of the Fiery (requires Operator or 
Administrator privileges); see “Other server management 
commands” on page 4-37.

Clear Clear all jobs in all queues as well as all jobs archived on the Fiery 
hard disk, the index of archived jobs, all FreeForm masters, the 
index of FreeForm masters, and the Job Log (requires 
Administrator privileges); see “Other server management 
commands” on page 4-37.

Setup Start the Fiery Setup program (requires Administrator privileges); 
see “Other server management commands” on page 4-37 and the 
Configuration Guide.

Duplex Alignment Adjust the alignment of text and images on the page for duplexing; 
see “Duplex Alignment” on page 4-36.

Menu: Choose this: To do this:
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Server selection tabs

The Server selection tabs, just below the menu bar at the top of the display, can be used 
to log in to additional Fiery servers (if your site has more than one) and to switch 
between Fiery servers currently connected to the Command WorkStation.

If you click a blank tab, you are prompted to connect to a server in the list or configure 
a new server entry (see “Connecting to the server” on page 3-5). A limit of five Fierys 
can be connected to a single Command WorkStation.

You can access the Server selection tabs from all Command WorkStation windows 
(Queues, Archive, FreeForm, and Job Log).

Log out Log out of the server.

Window Filter Open the Filter dialog box for the active window; see page 3-36.

Export Save the information in the active window as a tab-delimited text 
file; see page 3-29, page 3-32, and page 3-35.

Print Print the active window.

View in Helper App Open the active window in a particular application you specify; see 
page 4-5.

Refresh Update the Job Log window with the latest information.

Revert to Default Settings Restore default settings for the status areas, the column headings, 
and the column widths.

Help About View the Command WorkStation information screen.

Menu: Choose this: To do this:
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Sliders
Along the left side of the display are buttons you click to activate function sliders.

To retract any slider, click the icon at the far right of the slider.

Server information slider

The Server information slider displays name and version information about the 
currently connected server and the Command WorkStation. To retract the slider, click 
the Fiery logo at the far right of the bar.

Click to view server information

Click to open the Log in/out slider

Click to start a Fiery utility

Click to view disk space and 
RAM availability
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Log in/out slider

This slider is described in “Logging in” on page 3-6 and “Logging out” on page 3-7. To 
retract the slider, click the lock icon at the far right of the bar.

Utilities shortcut slider

This slider can be used to access Fiery Downloader and ColorWise Pro Tools. These 
utilities can also be accessed from the Job menu and Server menu, respectively. To 
retract the slider, click the icon at the far right of the bar.

RAM and disk space slider

The System information indicators show the current availability of RAM and hard disk 
space on the currently selected Fiery server. To retract the slider, click the icon at the far 
right of the bar.

Job ticket information

All the jobs listed by name in the Queues, Archive, and FreeForm windows can display 
the job ticket information specified by the person who originated the print job. The 
Command WorkStation can display this information because it parses the PostScript 
or PCL file before it is RIPped. 

Total RAM Total hard disk capacity

RAM currently in use

Disk space
used



33-16 Introduction to the Command WorkStation
You have considerable flexibility in arranging this information in the display. For 
example, you can add Media Type to the display if you want to see which jobs call for 
special paper or other media. 

You can choose not to display headers for options that are not used at your site, or you 
can display all possible options and scroll to see the ones that are less important to you. 
If you just want to experiment, when you are finished you can choose Revert to 
Default Settings from the Window menu.

For instructions on customizing the display in the Queues, Archive, and FreeForm 
windows, see page 4-4.

Window selection tabs

The Command WorkStation always starts out by displaying the Queues window, from 
which you view current job processes and control job flow and file storage. To go to 
another window, click the corresponding tab at the bottom of the Command 
WorkStation display.

Queues window
The Queues window is a dynamic display of the job staging area: jobs are lined up for 
processing and printing, some of them are being held waiting for directions, some are 
moving from one stage or queue to another and are finally dropped from the list, some 
are held for processing by the operator, and some are held in a different queue in case 
you need to reprint them.

One approach to understanding the dynamic display is to imagine the three parts of 
the Queues window corresponding to the three stages of printing, illustrated as a 
downhill flow.

Spooling

RIPping

Printing
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Spooling —a PostScript or PCL file is saved on the server’s hard disk. The file can come 
in packets from the network, or from another place on the server hard disk. Jobs are 
added to a queue in the order in which they arrive, and they generally move to another 
queue in the same order, unless an operator intervenes to change the order. 

Rasterizing (RIPping) —PostScript or PCL commands are interpreted in the Fiery to 
allow the DocuColor 12 to print the file the way its originator intended. The result of 
this interpretation is a raster file associated with the original PostScript or PCL file. In 
this raster file (raster image), color data is associated with each dot that can be rendered 
by the print engine. The color data tells the print engine whether or not to apply cyan, 
magenta, yellow, or black toner to each position on the page.

Printing —transferring the raster image from the server to the print engine at high 
speed, freeing up RAM for the next job. While the PostScript or PCL file is usually 
saved to disk, raster images are held in RAM during and after each print job. However, 
both users and operators can request that the Fiery save the raster image to disk along 
with the PostScript or PCL file.

Saving the raster image to disk offers some advantages—raster files are already 
processed so they print quickly, and each part of the raster file is still identified with a 
page in the original document, which means that individual pages of a saved raster file 
can be accessed.

Status bars
Jobs actively involved in the three processes (spooling, rasterizing, and printing) are 
listed in the status bars that span the Queues window.

Status bars show the filename and user name for the active process, and an indication 
of its progress. Each status bar heads the list of jobs that have completed the process. 
Thus, beneath the Spool status bar, you see a list of spooled files; beneath the RIP 
status bar, you see a list of rasterized (RIPped) files; beneath the Print status bar, you 
see a list of jobs that have already been printed.
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NOTE: In the Spool status bar, the filename and user information always appear as 
“Unknown” (as shown below). This information is not available until the job has 
finished spooling to the Fiery disk.

When a job is being processed, provided animation is enabled (see page 4-5), the 
corresponding status bar is animated, indicating that the process is active. 

If an error occurs, the Print status bar alerts you by displaying a message on a red 
background instead of the normal blue background. 

Enlarging the status bars  Click the small arrows at the left of the status bar to 
expand the status bar display. Click the arrows again to collapse the status bar to its 
original size. To expand all the status bars at the same time, press Ctrl-E . Click the 
arrows or press Ctrl-E  again to collapse them to their original size.

Changing proportions  By default, the status bars divide the window area into three 
equal parts. You can drag the RIP and Print status bars up or down to change the 
proportion of the window devoted to each job area. For example, drag the RIP status 
bar down if you have a long list of spooled jobs you want to see without scrolling.

Spooled jobs on Hold (yellow)
Active spooled jobs (white)

RIPped jobs on Hold (yellow)
Active RIPped jobs (white)

Printed jobs (white); some include 
raster data stored in RAM
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Making space  If your workflow includes holding many jobs, and you don’t want to 
view the held jobs all the time, consider moving some of them to the Archive window. 
You can move jobs back and forth between the Queues window and the Archive 
window with a single right-mouse command (see page 3-24).

Active jobs and held jobs

In the description that follows, assume the operator has full control of jobs; that is, the 
administrator has disabled the Direct connection and the Print queue, and all user jobs 
come to the Hold queue. For more information about print connections, see the 
Configuration Guide.

The operator’s job management functions permit holding a job at any stage of the 
process we have described, as illustrated below. In the figure, boxes indicate types of job 
icons you would see in the Queues window.

Spooled and held

RIPped and held

Print and hold

RIP

Print

Printed

PostScript, PCL, 
and raster data

Deleted

Spool

Spooled for printing

RIPped for printing

Print*

*A copy of the held job is printed; the held job remains in the RIP area.

PostScript and 
PCL data

Preview, edit, and impose

Preview and edit
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Jobs that are held are shown with a yellow icon in a yellow row, just beneath the Spool 
or RIP status bar. Jobs that are held must be activated with a command in order to 
print.

Active jobs are shown in white with white icons; new jobs are added above older jobs.

Job icons
Three types of icons are used for both active jobs and jobs on hold.

Spool area
The job icons in the Spool area are described below: 

Icon: Active jobs:
(white icons and rows)

Jobs on Hold:
(yellow icons and rows)

Printer icons

PostScript, PCL, or raster 
data headed for printing 
(top) or after printing 
(bottom)

PostScript or PCL data headed for 
Print and Hold or job on Hold 
after printing (Hold)

Raster icon

PostScript, PCL, and raster 
data after printing, ready for 
fast reprint

PostScript or PCL data already 
rasterized and held

Spool area icon: What it indicates: How long you see the job:

1

Yellow printer icon 
Yellow job row

PostScript or PCL data from a 
user on the network; no 
destination is defined

Until a destination is chosen
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The Spool area is both the receiving area for jobs from users on the network (Hold 
queue) and the waiting area for jobs that will be RIPped.

Hold queue jobs  When printing requires an operator (because the Print queue and 
Direct connection are disabled), the operator must assign a destination to all jobs 
received from users on the network (icon 1 in the table above). Once assigned, jobs 
(icons 2, 3, and 4) move down the Spool queue for processing. All jobs printed to the 
Hold queue require routing by an operator. The Hold queue also enables you to use all 
workflow features of the Command WorkStation with PDF files, including 
DocBuilder Pro and the Imposition feature.

Print queue jobs  When printing does not require an operator, network jobs sent to 
the Print queue appear in the Spool area, where they are shown with a white printer 
icon (icon 2). When they reach the head of the queue, they are RIPped and printed 
without operator intervention.

Direct connection jobs  Jobs printed to the Direct connection are not displayed in the 
Command WorkStation job lists. They are displayed briefly in the status bars (where 
they cannot be selected) and are included in the Job Log.

2

White printer icon 
White job row 

PostScript or PCL data 
headed for Print

Until the RIP is free

3

Yellow raster icon 
White job row 

PostScript or PCL data 
headed for RIP and Hold

4

Yellow printer icon
White job row 

PostScript or PCL data 
headed for Print and Hold

Spool area icon: What it indicates: How long you see the job:
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RIP area
The job icons in the RIP area are described below: 

After a job is rasterized, it goes into the RIP area. The RIP area holds only raster data 
(i.e., jobs that have been rasterized). Jobs in the RIP area are either waiting for the 
copier to be free (Print queue jobs, icon 2 in the above table), or they are being held. 
Held jobs in the RIP area have already been rasterized (RIP and Hold) or they have 
been printed and their raster data has been routed back to the RIP area (Print and 
Hold), where they are shown in yellow rows (icon 1).

NOTE: Raster jobs in the RIP area that are waiting to print (icon 2 in the table above) 
cannot be manipulated by job commands.

Jobs held in the RIP area remain there until the operator moves them to the Archive 
window or deletes them. Printing these jobs does not remove them from the RIP area. 
Instead, a copy of the job is created and printed.

NOTE: For all rasterized jobs, the print option settings, in addition to the current 
calibration state of the Fiery, remain with the saved raster data each time the job is 
reprinted. To print the job with new print option settings and with new calibration 
data, you must remove the raster data and reRIP the job.

RIP area icon: What it indicates: How long you see the job:

1

Yellow raster icon 
Yellow job row

Raster data, no destination 
defined; may have been 
printed before and held

Until it is deleted, moved to 
the Archive window, or 
stripped of its raster data and 
sent to the Spool area

2

White printer icon 
White job row 

Raster data headed for Print 
in its turn; no hold defined

Until copier is free to print 
the job
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Print area
The job icons in the Print area are described below:

The Print area, also referred to as the Printed queue, contains jobs that have already 
been printed. These jobs were assigned the Print destination (white printer icon in the 
Spool or RIP areas) without any Hold instructions; therefore, they all have white icons 
and rows.

NOTE: A job row that appears in light red indicates that an error occurred while 
printing the job. To see the error, double-click anywhere in the row.

Newly printed jobs are added to the Printed queue, and are shown at the top of the list. 
Jobs are saved in the Printed queue until the job limit is reached. When the first job 
over the limit is printed, the oldest job is deleted from the disk. The default job limit is 
10 jobs. The value for Jobs Saved in Printed Queue  can be changed in Setup by the 
administrator.

NOTE: If you reprint a job in the Printed queue, the job returns to its original position 
in the Printed queue after it is printed.

While it is printing, a job consists of PostScript or PCL and raster data. The raster data 
in RAM is not cleared until memory is needed to rasterize the next job. As long as the 
raster data is intact, the job can be reprinted from the Printed queue. Printed jobs that 
still have their raster data are represented by a white raster icon in the Printed queue 
(icon 2 in the previous table); jobs with only PostScript or PCL data remaining are 

Print area icon: What it indicates: How long you see the job:

1

White printer icon 
White job row 

PostScript or PCL data 
only—raster data has been 
deleted

Until the job limit is reached

2

White raster icon 
White job row 

Raster, PCL, and PostScript 
data

If RAM is needed to RIP an 
active job, the raster data is 
deleted and the job gets the 
PS icon (icon 1, above)

Until the job is reprinted or 
the job limit is reached
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represented by a white PS icon (icon 1). If the job was printed from a held raster job 
(in the RIP area), the raster data in the RIP area remains and can be used to reprint the 
job after the raster data has been cleared from the Printed queue.

Job commands
Job commands are used to assign a selected job to a new destination or process. These 
commands are available from the Job menu (see page 3-10). Many are also available as 
right-mouse commands (described following the list of commands below). The job 
commands available at a given time depend on the context; unavailable commands are 
dimmed. Job commands are available in the Queues, Archive, and FreeForm windows.

The job commands available for selected jobs in the Queues, Archive, and FreeForm 
windows are listed in the following table. The table also describes the effect of each 
command on raster data associated with the affected job(s).

Choose this: To do this: Raster data is:

Delete Delete the job(s) Deleted

Duplicate Duplicate one or more selected PostScript, PCL, 
or PDF data jobs in the Spool or Print areas. You 
can use the duplicate job(s) for different print 
options or a different destination. (The Duplicate 
command actually creates a reference to the 
original job, with the same name)

n/a
(The Duplicate command is not available 
for raster jobs)

Rename Rename the job (PostScript, PCL, or PDF file 
with or without raster)

Unaffected, but associated with the new 
name

Hold Hold the job in the current place (except for a job 
in the Print area, which is moved to the Spool or 
RIP area, depending on whether it still has raster 
data associated with it)

Held in RIP area, if included with job

RIP and Hold RIP the job and hold it in the RIP area Held in RIP area indefinitely

Print Print the job in its turn (RIP it first if it does not 
have raster data)
After printing, keep the printed job in the Print 
area until the job limit is reached

Temporarily held in RAM after printing 
until memory is needed for another job
(If the job was printed from a held job in 
the RIP area, the raster data in the RIP 
area is kept indefinitely)
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Print and Hold
(Like the user print 
option Save Fast 
Reprint)

Print the job in its turn (RIP it first if it does not 
have raster data) 
After printing, hold the PostScript data and the 
raster in the RIP area

Held in RIP area indefinitely (saved to 
disk)

Process Next Give top priority to this job
RIP (and then print) it as soon as the processor is 
free, before other waiting jobs
Option is dimmed if there are no other waiting 
jobs

n/a

NOTE: This command is available only 
for jobs in the Spool area that are not 
currently held.

Remove Raster Remove the raster data from a job that has raster 
data (indicated by a raster icon); leave the 
PostScript data unaffected

Deleted

NOTE: If you remove raster from a job in 
the RIP area, the job is sent to the Spool 
area.

Properties View, override print option settings, and print a 
selected job or a group of selected jobs

Possibly deleted and regenerated, 
depending on whether you change any 
settings that require re-RIPping

Thumbnail A Open a selected held job in the Thumbnail A 
window where you can view a full-screen preview 
of the job, edit the job, or merge it with like data 
from other jobs. In order to merge jobs, they 
must be of the same data type (i.e., PostScript 
jobs cannot be merged with raster jobs) and page 
size

Changed if job is edited, unaffected if job 
is only viewed

Thumbnail B Open a selected job in the Thumbnail B window 
for viewing a full-screen preview of the job, or for 
copying pages into a job in the Thumbnail A 
window. In order to merge jobs, they must be of 
the same data type (i.e., PostScript jobs cannot be 
merged with raster jobs) and page size

Unchanged

Impose Open a selected held PostScript or PDF job in 
the Imposition window; for more information, 
see Chapter 5

Unchanged

Download Download files and fonts to the Fiery with Fiery 
Downloader; see page 4-26

n/a

Choose this: To do this: Raster data is:

XP12
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Using right-mouse commands 

Use the following instructions to activate job commands with a single right-mouse 
click.

TO ROUTE JOBS WITH RIGHT-MOUSE  COMMANDS:

1. To route a single job in the job list, right-click the job.

2. Select one of the commands or destinations and release the mouse button.

The command is carried out or the job is routed to the destination you chose. 
Depending on your choice, the job line may reappear in a different part of the window 
or a different window, or the job line may be deleted.

3. To route multiple jobs at the same time, select the jobs first. 
Click the job line to select the first job. Shift-click to select adjacent jobs. Ctrl-
click to select nonadjacent jobs.

NOTE: Select jobs with the same job icon; otherwise, the destination options may not 
be the same. For example, select multiple jobs in the Spool area, and choose Print .

4. With the cursor still in one of the selected job lines, press the right mouse 
button.

5. Select one of the commands or destinations and release the mouse button.

The command is carried out or the jobs are routed to the destination you chose.

Archive Archive the selected held job(s) to the Fiery hard 
disk, the Fiery internal ZIP drive, the local 
Command WorkStation hard disk, or to a device 
on the network and move the job icon to the 
Archive window; see page 3-27

Archived with the job, if archiving of 
raster data is specified

Import Import PostScript, PCL, or raster data jobs 
previously archived to external volumes; see 
page 4-34

Imported with the job, if it is available

Send to<Server> Transfer the selected job(s) to another currently 
connected Fiery; see page 4-30

Transferred with the job

Choose this: To do this: Raster data is:
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Archive window
If you want to store jobs before or after printing them, you can archive them. The Fiery 
can archive jobs internally (on the Fiery hard disk) and externally, on the Command 
WorkStation hard drive, the ZIP disk, or on network drives. For instructions on how 
to archive jobs, see page 4-32.

NOTE: The Archive window is not available if you logged in as Guest.

PostScript and raster data jobs can be archived, but jobs must first be held in the Spool 
or RIP areas of the Queues window before they can be archived. 

When you archive a job, the job is moved, not copied, to the archive destination (the 
Fiery archive area or the external device). The Archive window shows a cumulative list 
of all jobs that have been archived. This list is cleared (along with all jobs on the server) 
by choosing Clear Server on the Fiery Control Panel (see page 1-6) or by using the 
Clear command from the Command WorkStation (see page 3-12).

The job icons in the Archive window are described below:

The job commands described on page 3-24 can also be used with jobs in the Archive 
window.

Archive icon: What it indicates:

Printer icon

PostScript or PCL data only—raster data not present or 
deleted

Job was archived from the Spool area

Raster icon 

Raster, PCL, and PostScript data

Job was archived from the RIP area
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The icons that appear in the Archive window are always white, since they have no 
destination (as long as they are in the Archive window). 

By default, the Archive window displays all archived jobs. Until they are deleted, 
archived jobs remain in the Archive window indefinitely. You can display a subset of 
archived jobs based on various selection criteria by using the Filter command (see 
page 3-36). 

For jobs archived to external devices (such as the ZIP drive), the Volume column shows 
the volume and pathname of the device. For jobs that were archived to the Fiery hard 
disk, the Volume column is blank. 

As with the Queues window, you can select the headings for the display and use Job 
menu or right-mouse commands; you can also sort jobs.

To: Do this:

Sort jobs in a category, such as 
by Date

Double-click the Date/Time heading. A small arrow indicates whether jobs are sorted in 
ascending or descending order. Double-click again to sort in the reverse order.

Route a job to a destination in 
the Queues window

Use job commands from the Job menu or the right-mouse command menu. For example, to 
print a job, choose Print or Print and Hold. You can also select and route multiple jobs. For 
details, see page 3-26.
The other options, RIP and Hold or Hold, send a copy of the job to the Queues window (to 
the RIP and Spool areas, respectively) without printing it; Remove Raster (which applies 
only to jobs with the raster icon) leaves only the PostScript data for the job in the Archive 
window.

View only particular jobs Choose Filter from the Window menu and make entries in the Filter dialog box (see 
page 3-36).

Delete a job Select the job(s) and choose Delete from the Job menu or right-mouse command menu.

Sort order indicator

External volume
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FreeForm window
The Fiery FreeForm printing feature provides a flexible and efficient method for 
printing variable data jobs (such as direct-mail advertising pieces). FreeForm allows 
users to preRIP and store the master elements of their variable data jobs on the Fiery, 
and then use that master data as needed, for multiple variable data jobs. The 
preRIPped master-element jobs are stored on the Fiery as FreeForm Masters, and are 
displayed in the FreeForm window.

NOTE: The FreeForm window is not available if you logged in as Guest. The FreeForm 
printing feature is not available for PCL jobs.

About FreeForm printing
FreeForm printing involves combining a preRIPped FreeForm Master with a variable-
elements job to create the final variable data job. This final job can be soft-proofed 
before printing with the Thumbnail windows and the full-screen preview display.

To create a FreeForm Master, the job comprising the master elements must be RIPped 
with the Create Master print option set to a value from 1 to 100 (that is, a setting other 
than None). Users can set this option to a value from 1 to 15 when they send a job, but 
the printer driver interface prevents them from choosing numbers greater than 15. To 
create a FreeForm Master with a number greater than 15, you must override the Create 
Master job setting from the Properties dialog box and RIP (or reRIP) the job.

Display or move job ticket 
information headers in the 
Archive window

Click the right mouse button on the appropriate column head; choose Add from the 
drop-down menu to list the columns that you can add to the display. The categories are the 
same as in the Queues window (see page 3-15) but you can arrange them differently. The 
column head arrangements you set in the Archive window are independent of those you set 
in the Queues window. 

Adjust the width of a column Click the column border in the heading and drag left or right.

Export the currently displayed 
list of archived jobs to a 
tab-delimited text file

Choose Export from the Window menu. Specify a filename (the default name is archive.log) 
and a location for the file and click Save. You can then open the exported file with a 
spreadsheet, database, or word processing application.

To: Do this:
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To combine a variable-elements job with a FreeForm Master, the variable-elements job 
must be RIPped with the Use Master print option set to the number of the 
corresponding FreeForm Master. As with the Create Master print option setting, users 
can set this option to a value from 1 to 15 only. To specify a number greater than 15, 
you must override the Use Master job setting from the Properties dialog box and RIP 
(or reRIP) the job.

Using the FreeForm window
The FreeForm window displays up to 100 FreeForm masters that can be used for 
variable data jobs. However, users on the network can specify Create Master job setting 
values of 1 through 15 only, due to limitations of the printer driver interface.

The Create Master job setting values can range from 1 to 100, but values from 16 to 
100 can be assigned only with job overrides from the Properties dialog box. When 
assigning new FreeForm Master numbers, it is very important to not choose a number 
already in use; doing so may result in the original FreeForm Master being overwritten.

Only white raster data icons appear in the FreeForm window, as all FreeForm Masters 
have already been rasterized. Their raster data is kept indefinitely until the FreeForm 
Master is deleted.

NOTE: For all rasterized jobs, the print option settings, in addition to the Fiery’s current 
calibration state, remain with the saved raster data each time the job is reprinted. To 
print the job with new print option settings and with new calibration data, you must 
remove the raster data and reRIP the job.
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By default, the FreeForm window displays all FreeForm Masters, which remain in the 
window until they are deleted. FreeForm Masters (along with all other jobs on the 
server) and the index of FreeForm Masters are deleted by choosing Clear Server on the 
Fiery Control Panel (see page 1-6) or by using the Clear command from the 
Command WorkStation (see page 3-12).

You can display a subset of FreeForm Masters based on various selection criteria by 
using the Filter command (see page 3-33). 

As with the Queues window, you can select the headings for the display and use Job 
menu or right-mouse commands; you can also sort jobs.

To: Do this:

Sort jobs in a category, such 
as by Date

Double-click the Date/Time heading. A small arrow indicates whether jobs are sorted in 
ascending or descending order. Double-click again to sort in the reverse order.

View only particular jobs Choose Filter from the Window menu, and make entries in the Filter dialog box (see 
page 3-36).

Delete a job Select the job(s) and choose Delete from the Job menu or right-mouse command menu.

Display or move job ticket 
information headers in the 
FreeForm window

Click the right mouse button on the appropriate column head; choose Add from the 
drop-down menu to list the columns that you can add to the display. The categories are the 
same as in the Queues window (see page 3-15) but you can arrange them differently. The 
column head arrangements you set in the FreeForm window are independent of those you set 
in other windows. 

View a thumbnail of a 
FreeForm Master

Right-click the job and choose Thumbnail A or Thumbnail B from the menu that appears, 
or left-click the job and choose Thumbnail A or Thumbnail B from the Job menu.

View the print option settings 
of a Free Form Master

Right-click the job and choose Properties from the menu that appears, or left-click the job 
and choose Properties from the Job menu.

NOTE: Print option settings for FreeForm Masters can be viewed only; they cannot be 
changed.

Display all variable element 
documents associated with a 
FreeForm Master

Right-click the job and choose Associated variables from the menu that appears.
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Job commands for FreeForm master jobs
The following job commands, described on page 3-24, can be used with jobs in the 
FreeForm window:

• Delete

• Associated variables

• Properties

• Thumbnail A

• Thumbnail B

NOTE: The Associated variables command is available only by right-clicking a 
FreeForm Master job. Selecting this command displays all jobs that have used that 
specific FreeForm Master as a master document.

Adjust the width of a column Click the column border in the heading and drag left or right.

Export the currently 
displayed list of FreeForm 
jobs to a tab-delimited text 
file

Choose Export from the Window menu. Specify a filename (the default name is 
freeform.log) and a location for the file and click Save. You can then open the exported file 
with a spreadsheet, database, or word-processing application.

To: Do this:
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Filtering jobs in the FreeForm window
The FreeForm window displays a cumulative list of all FreeForm Masters. If the 
window contains a large number of FreeForm Masters, you may want to display only a 
specified subset of these jobs. You can do this by filtering jobs in the FreeForm window.

The Filter command for the FreeForm window works exactly the same way as the 
Filter command for the Archive window. For instructions on using this feature, see the 
description given in “Filtering jobs” on page 3-36.

Assigning and monitoring FreeForm Masters
Users can assign FreeForm Master numbers from 1 to 15 using the Create Master print 
option when they send a job. These numbers can be changed to a number from 1 to 
100 with job overrides from the Properties dialog box.

NOTE: As with all job overrides that have a reRIP icon, in order for any new settings to 
take effect (including Create Master and Use Master), the job must be reRIPped. For 
information on using the Properties dialog box to change job settings, see “Viewing 
and overriding print settings” on page 4-22.

When the first 15 FreeForm Master numbers have been used, users may inadvertently 
overwrite existing FreeForm Masters by assigning what they think are new, unused 
FreeForm Master numbers. When users choose a master number from the Create 
Master print option, an existing job using that master number will be overwritten (the 
user will receive a message warning them that they are about to replace an existing job). 
For this reason, the operator may bear the responsibility of deleting existing master 
jobs or reassigning master numbers 1 through 15 in order to avoid any overwriting 
problems. Since the operator is the only person who can assign numbers from 16 to 
100, he or she can maintain a high level of control over the FreeForm Master numbers 
in use.

Tips for using FreeForm

At sites where a small number of users print FreeForm jobs, the operator may want to 
assign specific FreeForm Master numbers to specific users. In this way, users bear the 
responsibility of monitoring their own master numbers. Users can then use the Create 
Master print option to assign new masters or to overwrite existing masters. Users can 
also instruct the operator to reassign master numbers (to a number greater than 15) for 
FreeForm Masters they want to keep available on the Fiery.



33-34 Introduction to the Command WorkStation
At sites where a large number of users print FreeForm jobs, the operator may want to 
instruct users to not use the Create Master print option at all, but rather to RIP and 
Hold all their jobs. In this way, the operator can decide which FreeForm Master 
numbers to assign before printing.

For all jobs sent to the Fiery, it is a good practice for users to specify information to the 
operator with the Notes and Instructions fields in the Printer Job Notes dialog box. It 
is then very important for the operator to check the Notes and Instructions columns 
for such information.

For example, the user could send a variable-elements job named “Variable1.ps” to the 
Fiery with the instruction “Use Master5.ps as master.” The operator then:

• Locates “Master5.ps” in the FreeForm window

• Notes the number in the Create Master column

• Double-clicks “Variable1.ps” to view the Properties dialog box

• Chooses the matching FreeForm Master number with the Use Master print option

The job “Variable1.ps” will then print with the master data (“Master5.ps”), as specified 
by the user.

For more information on using FreeForm features, see “Printing variable data 
documents (FreeForm)” on page 4-25 and the Printing Guide.

Job Log window
The Job Log is a list of processed and printed jobs, the date and time they were 
processed or printed, and the characteristics of the job. It includes downloaded files 
and fonts and RIP and Hold jobs.

NOTE: The Job Log window is not available if you logged in as Guest.

At any given time, the Job Log includes only those jobs processed or printed since the 
Job Log was last cleared. The Job Log can be cleared manually by choosing “Clear Job 
Log” from the Server menu or automatically if the administrator has enabled 
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autoclearing of the Job Log in Setup. The Job Log is also cleared by choosing Clear 
Server on the Fiery Control Panel (see page 1-6) or by using the Clear command from 
the Command WorkStation (see page 3-12).

You can adjust the column widths in the Job Log display by clicking the column 
border in the heading and dragging left or right. For more information, see Chapter 4.

When you open the Job Log, you can choose to display all jobs in the current Job Log 
or only the jobs in a specified date range. By default, all jobs are displayed. To specify a 
date range, choose Filter from the Window menu, click Range, and enter dates in the 
From and To fields; or, click the calendar icons next to the From and To fields and 
select dates by clicking them in the calendars. Use the arrows at the upper corners of 
the calendars to display different months.

NOTE: In the Job Log, “Start Time” reflects the time that the job began RIPping; “End 
Time” reflects the time that the job printed; and “Process Time” reflects the total RIP 
time for the job. These times do not correspond to the Date/Time values displayed in 
the Queues window.

Updating the Job Log display  To update the Job Log window display after specifying 
a date range (or at any other time), choose Refresh from the Window menu.

Exporting the Job Log  From the Job Log window, you can export the Job Log to a 
tab-delimited text file (the default name is job.log) by choosing Export from the 
Window menu. The exported file can be opened with a spreadsheet, database, or word 
processing application. The exported Job Log contains the jobs for the date range you 
specified.
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Clearing the Job Log  The Job Log is stored on the server disk. When logged in as 
Administrator, you can clear the Job Log by choosing Clear Job Log from the Server 
menu. The Job Log is cleared whenever an Administrator clears the server or installs 
new software. In addition, the Job Log can be cleared automatically after every 55 jobs.

Printing the Job Log  To print the Job Log, choose Print Pages from the File menu, 
select Job Log, click Print, and click OK. The Job Log is sent to the Print queue and 
then prints to the Fiery. You can use Job menu commands to manipulate the Job Log 
print job as you would any other job. The printed Job Log contains the jobs for the 
date range you specified. See “Using the Job Log” on page 4-35 for more information.

Printing and clearing the Job Log automatically  You can decide how you want to 
handle the Job Log. If you have Administrator privileges, you can choose Setup from 
the Server menu and enter your preferences in the Job Log Setup. You can choose to 
print the Job Log automatically every 55 jobs, or both print and clear the Job Log 
automatically every 55 jobs. You can also choose the Job Log page size.

Filtering jobs
The Queues, Archive, FreeForm, and Job Log windows display a cumulative list of all 
jobs. If a large number of jobs are listed, it may be difficult to locate a particular job or 
a particular group of jobs. You can display a specified subset of jobs by filtering jobs in 
the Queues, Archive, FreeForm, and Job Log windows.
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To open the Filter dialog box, choose Filter from the Window menu.

In the Queues window you can filter jobs according to any or all of the following 
criteria:

• Job title

• User name

• Date created (or a date range)

• Notes 1 or Notes 2 

• Instructions

In the Archive and FreeForm windows you can filter jobs according to any or all of the 
following criteria:

• Job title

• User name

• Date created (or a date range)
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• Notes 1 or Notes 2 

• Instructions 

• Volume

In the Job Log window, you can filter jobs by date only.

The Filter command lets you perform a search based on any and all values you specify 
in the Filter dialog box. Enter values in all fields relevant to your filtering criteria. If 
you enter values in more than one field, only jobs that meet all the criteria are 
displayed. For example, if you enter 10 in the Job Title field and <UserName> in the 
User field, only those jobs whose titles somewhere contain “10” and whose User name 
somewhere contains “<UserName>” will be displayed.

To filter by date, select Range in the Date created area and enter dates in the From and 
To fields; or, click the arrows next to the From and To fields and select dates by clicking 
them in the calendar that appears. Click the arrows at the upper corners of the calendar 
to display different months. The range of dates available for filtering is 
01/01/1980 to 12/31/2099.
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Creating Filter templates

If you often filter jobs according to specific criteria, you can create a filter template. In 
this way, you can filter jobs easily in one step and avoid the need to enter specific 
information each time you want to filter jobs.

TO CREATE A FILTER TEMPLATE:

1. Open the Filter dialog box by choosing Filter from the Window menu.

2. Enter specific job filter criteria in the appropriate fields.

3. Click Save As.

4. Enter a name for the new template and click OK.

The new template is saved in the Templates pop-up menu in the Filter dialog box.

To view jobs in the Queues, Archive, FreeForm, and Job Log windows according to a 
filter template, open the Filter dialog box, choose the template by name from the 
Templates pop-up menu, and click OK.

To delete an existing template, open the Filter dialog box, choose the template by name 
from the Templates pop-up menu, and click Delete. Click OK to confirm that you 
want to delete the template.

Job properties
When logged in as Operator or Administrator at the Command WorkStation, you can 
use the Properties command to check and override the print option settings 
(properties) of most jobs. 

NOTE: You cannot override the print option settings of PCL jobs.
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You can use this command for several purposes:

• To check a user’s job settings, especially notes and instructions

• To override a setting based on printed output or other print device conditions

• To change settings for a duplicate of the original job

• To print a single copy of a job before printing the number of copies required by the 
user

Viewing and editing job properties
The Properties command lets you view, edit the print option settings of, and print 
multiple jobs simultaneously. You can use this feature to compare the properties of 
several jobs and thereby group together jobs with similar settings, if it is beneficial for 
throughput or efficiency. 

To view the properties of one or more jobs, select the job(s) and choose Properties from 
the Job menu or the right-mouse menu.

For information on using the Properties dialog box to change job settings, see 
“Viewing and overriding print settings” on page 4-22.
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NOTE: Some print options that are available in the printer driver are not displayed in 
the Properties dialog box. For information on specific print options and settings, and 
where they can be set, see Appendix A of the Printing Guide.

Thumbnails and full-screen previews (DocBuilder Pro)
The Command WorkStation includes a powerful DocBuilder Pro tool that allows you 
to preview and edit PostScript and raster data. (For information on how to identify a 
raster data job, see page 3-20.) DocBuilder Pro consists of two thumbnail windows 
and several page-manipulation commands (listed in the Page menu).

NOTE: The features of DocBuilder Pro are not available for PCL files or any job sent 
with the PCL printer driver.

The DocBuilder Pro tool can be used in the following ways:

• In the Thumbnail A window, you can see thumbnails of the currently RIPping job, 
as it is processed, or of any PostScript or raster data job (see “Previewing print jobs” 
on page 4-12).

• From the Thumbnail A and Thumbnail B windows you can open a full-screen 
preview of a PostScript or raster file (see “Full-screen previews” on page 3-44).

• Using the Thumbnail A and Thumbnail B windows together, you can merge 
PostScript or raster data from more than one file, even if the files were printed from 
different applications on different computer platforms (see the next section and 
“Merging PostScript and raster files with DocBuilder Pro” on page 4-15). 

DocBuilder Pro’s merge features eliminate the limitations of particular software 
applications. You can merge PostScript or raster pages of documents of different types, 
even different computer operating systems. You can merge color pages from graphics 
programs with text pages from a word processor. An outline of DocBuilder Pro’s 
features follows; for more information and applications, see “Merging PostScript and 
raster files with DocBuilder Pro” on page 4-15. 
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Editing and merging files with DocBuilder Pro
When you select a PostScript or raster data job and choose the Thumbnail A or 
Thumbnail B command (from the Job menu or from the right-mouse commands), the 
corresponding Thumbnail slider opens automatically, displaying thumbnails of the file. 
To close the Thumbnail slider, click anywhere in the tab along the right edge of the 
Thumbnail window. When the Thumbnail window is open, the arrows in the tab 
point to the right, indicating that clicking the tab retracts the slider.

NOTE: In order to open the Thumbnail windows for jobs in the Spool area, the jobs 
must first be converted to PDF files. In addition, the Adobe Acrobat 4.0 application 
and a dongle (included with the DocBuilder Pro Upgrade option for the Command 
WorkStation) are required to view the job. If the dongle is not attached, you will see an 
error message. When you select a job in the Spool area and choose Thumbnail A or 
Thumbnail B, the Acrobat Distiller application launches and the conversion process 
occurs automatically; wait a few moments as the Command WorkStation prepares and 
then opens the job for viewing.

With the Thumbnail A window you can see thumbnail views of any PostScript, PDF, 
or raster data job—that is, any file that is currently RIPping, or any file that has been 
RIPped and held to disk. You can also use the Thumbnail A window to edit a 
PostScript, PDF, or raster file—you can change the sequence of pages, delete pages, 
duplicate pages, insert blank pages, and copy pages from other PostScript, PDF, or 
raster files into the Thumbnail A window. You can save the edited PostScript or raster 
file as a new printable document.

The Thumbnail B window can also display thumbnails of a PostScript, PDF, or raster 
job, and the document displayed in Thumbnail B can be used as a source for editing 
the document shown in Thumbnail A.

In order to copy or merge jobs using the Thumbnail A and B windows, they must be 
jobs of the same page size and data type. In other words, both jobs must be PostScript, 
PDF, or raster jobs—you cannot merge a PostScript job from Thumbnail B with a 
raster job in Thumbnail A.

NOTE: Be careful not to delete all pages of a job in Thumbnail A without first saving a 
copy of the job.
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You can merge documents by dragging (copying) one or more entire pages from 
Thumbnail B to Thumbnail A. This creates a new document in the Thumbnail A 
window. If you select one or more pages in the Thumbnail A window, the commands 
in the Page menu give you additional editing possibilities. (Most of the Page menu 
commands are also made available by right-clicking pages in Thumbnail A.) Multiple 
undos of Page menu commands are possible.

You can merge pages from multiple documents into the Thumbnail A document by 
opening documents one after another in the Thumbnail B window. Documents in the 
Thumbnail B window are view-only, and while you can copy pages from Thumbnail B 
to Thumbnail A, you cannot edit the Thumbnail B document. A merged document 
that you create in Thumbnail A can be saved (with a different name) as a new 
PostScript, PDF, or raster data file. 

For more information, see “Merging PostScript and raster files with DocBuilder Pro” 
on page 4-15.

Thumbnail B (source)

Thumbnail A (target)

Click here to close the Thumbnail B window

Click here to close the Thumbnail A window

Click to expand or retract 
the Thumbnail B window

Click to expand or retract 
the Thumbnail A window
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Full-screen previews
Double-clicking any page in the Thumbnail A or Thumbnail B window opens a 
full-screen preview of the page. The full-screen preview is a view-only display, and it 
takes time to retrieve the data.

NOTE: If you have edited a PostScript, PDF, or raster job with DocBuilder Pro, you 
must save the edited file before you can view full-screen previews of all its pages.

Depending on which area the job comes from (Spool or RIP), you can use the icons in 
the full-screen preview to display adjacent pages, rotate the page, pan around the page, 
zoom, or close the preview. The top illustration below shows a job from the Spool area; 
the second illustration shows a job from the RIP area.

Click to view adjacent pages
Click to close the

full-screen preview

If scroll bar appears,
click arrows or in empty

spaces, or move bar to
scroll up or down

If scroll bar appears, click 
arrows or in empty spaces, or 
move bar to scroll left or right

Click to pan around the page

Click to zoom

Job from the Spool area
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Click to view adjacent pages
Click to close the

full-screen preview
Click to rotate 90, 180, or 
270 degrees

If scroll bar appears,
click arrows, in empty
spaces, or move bar to

scroll up or down

If scroll bar appears, click 
arrows, in empty spaces, or 
move bar to scroll left or right

Job from the RIP area
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This chapter provides some general information about managing printing with the 
Fiery and the DocuColor 12, and gives you some hints on using the Command 
WorkStation windows to monitor and manage print jobs. It suggests ways to guide 
users so their jobs are more likely to print correctly the first time. The chapter also 
follows the course of a print job and shows possible ways to expedite jobs and take 
advantage of the special capabilities provided by the Command WorkStation.

Communicating with users
The Command WorkStation interface facilitates communication between users and 
operators. All the same, users who originate print jobs may need to become better 
informed about the Fiery and the DocuColor 12, so they can choose the appropriate 
options for their jobs.

What the user needs to know
You or the network administrator should consider supplying some of the following 
information to your users:

• The name of the copier on the network and the names of servers sharing the copier

• User’s access status 

If jobs do not require operator intervention because they go to the Hold queue, 
which connections are published—Direct connection and/or Print queue?

• How long you will hold jobs on the server before you delete them

• List of default printer settings and other settings (from the Configuration page)

• List of installed fonts

If users’ applications do not download fonts automatically, can users download fonts 
to the Fiery? Should they embed them in documents or should they supply them to 
you so you can download them? 

Chapter 4:
Managing 
Print Jobs
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• Requirements for Notes fields (information which appears in the Job Log)

For example, department name, account code, phone number or extension. Is some 
information mandatory at your site?

• Resident calibration target and date of current measurements

• Custom simulations

If custom simulations are available, what type of targets do they represent? Although 
users see these print options (CMYK Simulation), they should not select them if 
there are no custom targets on the server.

• IP address or DNS name of server so users can access Fiery WebTools, at least to see 
if their jobs have printed

• Installed options

• Available media, alternative choices, standard tray/media configurations

• Suggestions for the Instructions field

• Information users might find in the WebLink web site

• Instructions for setting up the printer on client computers

• Sources of PostScript printer drivers, PPDs, color reference files, and additional 
information

• Recommended PPD settings

• FreeForm information regarding usage of master and variable data

• Imposition information regarding whether or not the DocBuilder Pro Upgrade for 
the Command WorkStation is installed

• Conflicting settings and common PostScript errors

XP12
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How users communicate print requirements
Explain to remote users the information you check and what you need to know in 
order to print the jobs they send. The Instructions field is suited for communication 
about the job requirements. Notes fields appear in the Job Log, so they are more suited 
for accounting, billing, and job cost information. 

Users can provide you information with the print job, for example:

• Information entered in the Instructions field or the Notes fields—special 
requirements at your site (see below)

• Job ticket information provided by PPD option settings (job properties)

Instructions and Notes fields

• User name and phone number

• Priority, due date, request for notification

• Number of copies needed

• Request that operator do color check

• Hold job for future printing or future reprinting

• Merge with another job, and merging instructions

• Quantity of paper required

• FreeForm information regarding usage of master and variable data

• Imposition instructions

For more information see Chapter 5.

• Future requirements for the job

XP12
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Customizing the Command WorkStation window
You can customize the display of job ticket information in the Queues window by 
rearranging the column headings. You can tighten the columns, add new column 
headings, move columns, and delete column headings. 

NOTE: The Job Title and User columns are always at the left and cannot be moved or 
deleted. You can only add column headings to the right of the User column.

TO CUSTOMIZE THE QUEUES WINDOW DISPLAY:

1. Right-click the column heading.

A menu appears. The Add submenu lists the headings that are not already displayed.

2. Choose the options you want to display, and the sequence in which you prefer to 
view them.

Add, delete, or move a column by holding down the right mouse button on the name 
of the appropriate column heading; release the button after choosing one of the menu 
options:

Add  one of the listed columns to the display at your mouse position.

Move Left, Move Right —move the selected column left or right.

Delete the selected column.

The Job Title and User columns are required—all others are optional.

3. Adjust the column widths. 

Adjust the width of a column by clicking the column border in the heading and 
dragging to the left or right. You can change the column widths at any time.

If you display the Instructions column, which shows information typed into the 
Instructions field by the user, you can reduce the width of the column so you can just 
see whether or not there are instructions in it. 

4. With a narrow Instructions column, if you want to read detailed instructions, 
double-click the job and choose Notes from the Job Properties window. 

This also allows you to read the notes. You can edit or annotate the information in the 
Instructions field if you wish. It remains with the job as long as the job is on the server. 
The operator cannot edit the Notes fields.
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Setting Command WorkStation Preferences
Choose Preferences from the File menu to access the Preferences dialog box.

Menu: Choose this: To do this:

Preferences\
General

Enable Animation Turn on or off animation of the status bars

Enable Popup Help Turn on or off short captions that appear when you 
pause the mouse over window elements; the 
captions identify the main parts of the Command 
WorkStation window

Units Specify the type of unit (Points, Inches, or 
Millimeters) to use in the display for custom page 
sizes and Imposition settings

Temporary path Specify a location for temporary files created by the 
Command WorkStation application
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Printing server information pages
Using the Print Pages command, you can print various special pages of information 
stored on the Fiery.

TO PRINT SERVER INFORMATION PAGES:

1. Choose Print Pages from the File menu.

2. In the Select Printer area, specify where you want to print the pages.

Server—The pages you specify are printed to the Fiery.

Local Printer —Enables you to print the Configuration page, Archive Log, and 
Queues to any printer installed on your Windows computer.

3. In the Select Pages area, specify the pages you want to print:

Configuration —Prints the Configuration page, which gives the current server and 
device configuration. This page lists general information about the hardware and 
software configuration of the Fiery, the current settings for all Setup options, 
information about the current calibration, and the Ethernet and Token Ring addresses 
of the Fiery. 

Preferences\
Filter

Helper Application Specify the path to a helper application from which 
to view data in the active window; this application 
opens automatically when you choose “View in 
Helper App” from the Window menu

Template path Specify the path to where Filter template files are 
saved; for more information on Filter templates, see 
page 3-39

Preferences\
Imposition

Template path Specify the path to where Imposition template files 
are saved

Menu: Choose this: To do this:

XP12
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PS Test Page/PCL Test Page —A Test Page enables you to confirm that the Fiery is 
properly connected to the copier, and provides color and grayscale samples to 
troubleshoot problems with the copier or the Fiery. The following settings are among 
those listed on the Test Page: Server Name, Printer Model, color settings, calibration 
information, date and time the Test Page was printed.

Control Panel Map —Prints the Control Panel Map, which is an overview of the 
screens you can access from the Control Panel. For information about using these 
screens to set up the Fiery, see the Configuration Guide.

PS Font List/PCL Font List —Prints a list of all fonts currently resident on the Fiery 
hard disk.

Color Charts —Prints samples of the RGB, CMY, and PANTONE colors available 
from the Fiery. 

Job Log—Prints a log of the last 55 jobs processed or printed. For information on the 
fields in the Job Log and on printing it in other forms, see “Using the Job Log” on 
page 4-35.

4. Click Print.

5. If you selected Server in step 2, specify the number of copies to print and click 
OK.

The page(s) are printed to the Fiery.

If you selected Local Printer in step 2, choose the desired printer in the Print 
dialog box, specify the number of copies to print, and click OK.

The Configuration page is printed to the printer you specified.

Server information pages printed with the Print Pages command appear in the Fiery 
Job Log with a User Name of “Operator” even if you logged in as Administrator.
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Workflow scenarios
The workflow at your site will depend on the number and complexity of jobs and the 
amount of responsibility given to the operator. This section suggests some ways you 
might interact with a job.

Scenario 1 At this site, the Print queue is enabled, and anyone at the Command 
WorkStation can view the progress of jobs. A small job is sent to a server and copier 
that are not busy. You watch the job progress from the top to the bottom of the Queues 
window.

The green light on the Fiery flashes, the network icon blinks; on the Command 
WorkStation, the Spool status bar is animated and the job title appears. As soon as 
spooling has finished, the Spool status bar is cleared and the RIP status bar animates. 
Almost immediately thereafter, the RIP status bar is cleared and the Print status bar 
animates. The printed job is listed below the Print status bar and the job pages emerge 
from the DocuColor 12. You move it to the mailbox of the person who sent the job.

Scenario 2 At this site, all jobs come to the Hold queue and therefore require 
operator intervention to proceed.

Again, the green light on the Fiery flashes, the network icon blinks, the Spool status 
bar is animated, and now in the Spool area (below the status bar) the job title comes 
into view. In a few moments the job is on the list, and you have time to scan the 
headings for the job ticket information—media type, special instructions, copies, and 
pages.

Are you ready for this job to print? Do other jobs have priority? What is the job for—
is it final output or a test print? The first choice is whether to put the job in the print 
queue or hold it before processing it further. If you do nothing, the job remains in the 
Spool area, and the file remains on the server disk.
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Perhaps this is a routine job and does not call for special handling. You right-click the 
job and choose Print. You notice the RIP status bar animate, and almost immediately, 
the Print status bar animates. The printed job is listed below the Print status bar and 
the job pages emerge from the DocuColor 12.

The next job is a large job that you have not seen before. The Instructions field 
indicates that the originator of the job wants to check one printout of the job before 
you print another 50 copies. You make sure the Copies field is set to 1, right-click the 
job, and choose Print and Hold.

The RIP status bar animates and displays the job title, and then the Print status bar 
and copy 1 of the job emerges from the DocuColor 12. You call the sender of the job 
for approval. When the job is approved, you set the number of copies to 50, right-click 
the job now being held in the RIP area and choose Print.

Scenario 3 Everyone has discovered the DocuColor 12 on the network and jobs are 
coming in rapidly. You right-click several routine jobs in the Spool area and choose 
Print to let the server print them one after the other. You choose Print and Hold if you 
know you will be reprinting the job soon. You remove printed jobs from the output 
trays and replenish media. 

While some jobs are flowing through the queues and printing, you are preparing for 
jobs that require more attention, such as obtaining special paper, using DocBuilder Pro 
to merge two documents, or notifying the originator of a job that a PostScript error 
occurred.

Before you load special paper, you make sure all pending jobs are in holding areas. 
When an especially important job is spooled for RIPping, you right-click Process Next. 
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Using the copier
If you have a copier job that has priority over the spooled incoming print jobs, you can 
temporarily close the Fiery connection to the DocuColor 12 and reopen it when you 
have finished copying.

When there are no active printing jobs competing for the DocuColor 12 engine (no 
white job lines in the Spool or RIP area), you do not need to suspend printing to make 
copies.

TO GIVE THE COPIER TOP PRIORITY AND LATER RESTORE FIERY PRIORITY:

1. From the Server menu, choose Suspend Printing, press the F5 key, or right-click 
the Print status bar and choose Suspend Printing. 

This suspends printing temporarily. Jobs continue to spool and RIP on the server as 
long as disk space and RAM are available. 

2. When you have finished with the copier job, choose Resume Printing from the 
Server menu, press the F6 key, or right-click the Print status bar and choose 
Resume Printing.

The printing connection between the Fiery and the copier is reopened and printing 
resumes.

Using the copier as a scanner
Scanning requires that you place the scan original on the copier and run Photoshop 
from a networked workstation. In a high-volume printing environment, however, 
remote users who want to scan might have to wait for a connection to the Fiery.

Under those circumstances, you or another operator may prefer to take over the 
scanning function. Ideally, you would set up a networked workstation near the copier 
and run Photoshop. From this workstation you can scan jobs for users in the slow 
printing times.
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Canceling jobs
You may need to cancel a job after it has been routed for processing or printing. You 
can cancel a job only while it is being RIPped or while it is being printed. You cannot 
cancel a waiting job (white job row) that is routed for RIPping or printing. 

• Canceling jobs during processing—While a job is being RIPped, and its name 
appears in the RIP status bar, choose the Cancel RIPping command from the Server 
menu, press the F7 key, or right-click the RIP status bar and choose Cancel RIPping. 

When the RIP job is canceled, the Canceling message appears on the Fiery Control 
Panel. The name of the canceled job appears in the Job Log.

• Canceling jobs during printing—While a job is printing, and its name appears in 
the Print status bar, choose the Cancel Printing command from the Server menu, 
press the F8 key, or right-click the Print status bar and choose Cancel Printing. 

When the print job is canceled, Canceling appears on the Fiery Control Panel.The 
name of the canceled job appears in the Job Log. 

NOTE: Canceled jobs may be partially printed, and may include pages with one or more 
missing color planes, or pages that are completely blank.

• Canceling at the Control Panel—If you are at the Fiery, the most direct way to 
cancel a job is to press the top button on the server Control Panel while you can read 
the name of the job that is processing or printing. For more information on the 
Control Panel, see Chapter 1.
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Page-level operations of the Command WorkStation
Page-level operations include generating Thumbnail images, adding pages, deleting 
pages, duplicating pages, reordering pages, and adding blank pages.

Previewing print jobs
You can use the Thumbnail A window to preview pages of the currently RIPping job. 
You can also use Thumbnail A, as well as Thumbnail B, to preview any held PostScript 
or PDF job in the Spool area; or any held PostScript or raster data job in the RIP area.

The thumbnail windows also allow you to open an thumbnail view of a held PostScript 
or PDF job in the Spool area, or any held PostScript or raster data job in the RIP area 
and perform electronic collation or document merging. This feature, called 
DocBuilder Pro, is described on page 4-15.

NOTE: In order to open the Thumbnail windows for jobs in the Spool area, the jobs 
must first be converted to PDF files. In addition, the Adobe Acrobat 4.0 application 
(included with the DocBuilder Pro Upgrade for the Command WorkStation) is 
required to view the job. When you select a job in the Spool area and choose 
Thumbnail A or Thumbnail B, the Acrobat Distiller application launches and the 
conversion process occurs automatically. Wait a few moments as the Command 
WorkStation prepares and then opens the job for viewing.

Thumbnail generation

If your held PDF job in the Spool area already holds thumbnail data, you can open it 
in the Thumbnail A or B windows without modifying the temporary file; otherwise, 
DocBuilder Pro generates thumbnail images and adds them to the temporary file. 
Because the generation of thumbnails may take a few moments, DocBuilder Pro 
prompts you to permit or deny this action.

When you close the window, you are prompted to save or discard thumbnail data. To 
avoid modifying your original PostScript or PDF data, you can discard newly 
generated thumbnail data. However, in most cases, thumbnail data is worth keeping as 
it takes up very little space and saves you the time required to generate it again.
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Another way to maintain an unmodified copy of the original spool file is to save the 
job under a new name immediately upon opening it in the Command WorkStation; 
this action discards any newly generated thumbnail data.

Previewing the currently rasterizing job

To see the progress of jobs as they are RIPped, you can leave the Thumbnail A window 
open in RIP preview mode.

TO VIEW THUMBNAILS OF THE CURRENTLY RIPPING FILE:

1. Click the Thumbnail A tab at the right of the Queues window to open the slider.

2. Click the RIP preview icon at the left side of the window.

In this mode, Thumbnail A displays each page of the currently processing job after it 
has been RIPped.

3. Choose a PostScript file in the Spool or Print area and select RIP and Hold, Print, 
or Print and Hold.

As pages are RIPped, they are displayed in the Thumbnail A window. 

4. When you have finished viewing, click the Thumbnail A tab to close the 
thumbnail window.

Click to display the currently 
rasterizing job Click to close the

thumbnail window
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TO VIEW THUMBNAILS OF ANY POSTSCRIPT, PDF, OR RASTER DATA FILE:

1. Select any PostScript or PDF job in the Spool area, or select any PostScript, PDF, 
or raster data job in the RIP area.

2. Choose Thumbnail A or Thumbnail B from the Job menu.

If you choose Thumbnail A, make sure the raster data preview icon (at the left side of 
the window) is selected.

If you choose a job in the Spool area, the Adobe Acrobat 4.0 application automatically 
opens in the background, enabling you to view the job.

NOTE: Wait until all pages have been displayed before opening another PostScript, 
PDF, or raster file with Thumbnail A. If the job contains many pages, it may take some 
time for the entire job to be displayed.

3. When you have finished viewing, click the Thumbnail A or Thumbnail B tab to 
close the thumbnail window.

Raster data preview icon

Click to close the
thumbnail window
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Merging PostScript and raster files with DocBuilder Pro
The ability to work with PostScript and raster files gives you new opportunities to 
combine documents from different sources into a single file. For example, you can 
combine full color covers and chapter head pages created in a page layout application 
with two-color text pages created in a document processing application. Or, you can 
customize a slide presentation by inserting slides from a different presentation. 

NOTE: The features of DocBuilder Pro are not available for PCL files or any job sent 
with the PCL printer driver.

You can display two PostScript or raster files at once: a source file and a target file. The 
target file is displayed in the Thumbnail A window, the source in Thumbnail B. Both 
files must be of the same page size, data type (i.e., held PostScript or raster data jobs), 
and both must be located in the same area (Spool or RIP). You cannot merge a 
PostScript job from Thumbnail B with a raster job in Thumbnail A.

NOTE: You cannot create a new PostScript file in this process; you must print the 
merged file, which has references to the original PostScript files. Before editing or 
merging raster files with DocBuilder Pro, make sure the source files were RIPped using 
the print option settings and the resident calibration you want for the final output. 
Raster files edited with DocBuilder Pro cannot be reRIPped.

Page manipulations

Page-level manipulations in the Thumbnail A window (adding pages, deleting pages, 
reordering pages, or inserting blank pages) modify the temporary PDF file. If you do 
not want to modify the original PDF spool file, you must save the job under a different 
name or discard the changes. The Thumbnail B window is read-only—you cannot 
make content changes to it.
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TO VIEW AND EDIT POSTSCRIPT, PDF, OR RASTER DATA JOBS:

1. Select a PostScript, PDF, or raster data job and choose Thumbnail A from the Job 
menu.

The file must be a held PostScript or PDF job in the Spool area, or a held PostScript, 
PDF, or raster data job in the RIP area.

2. In the Thumbnail A window, right-click a thumbnail image to see the commands 
available for pages in Thumbnail A. 

These commands can also be accessed from the Page menu (see page 3-10) as well as 
from buttons along the left side of the Thumbnail A window (see illustrations below).

To scroll through the pages in Thumbnail A, you can drag the slider bar at the bottom 
of the screen, click the empty area to the left or right of the slider bar, or click the 
arrows. The illustration below shows a job from the Spool area.

Delete—Deletes the currently selected page(s).

Duplicate —Duplicates the currently selected page(s).

Click to open a full-screen 
preview of the page

Click to duplicate a page

Click to delete a page
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Preview —Opens a full-screen preview of the currently selected page (see “Full-screen 
previews” on page 3-44).

Insert blank page —Inserts a blank page after the currently selected page(s).

The illustration below shows a job from the RIP area.

Delete—Deletes the currently selected page(s).

Duplicate —Duplicates the currently selected page(s).

Preview —Opens a full-screen preview of the currently selected page (see “Full-screen 
previews” on page 3-44).

3. To move pages within Thumbnail A, left-click to select the page(s) and hold down 
the mouse button as you drag the selected page(s) to the new location.

Shift-click to select multiple, sequential pages; Ctrl-click to select multiple, 
non-sequential pages.

If you move the page(s) on top of existing page(s), the page(s) will be overwritten.

Click to open a full-screen 
preview of the page

Click to duplicate a page

Click to delete a page



44-18 Managing Print Jobs
If the icon does not have an arrow, the page(s) will be replaced; if the icon has an arrow, 
the page(s) will be inserted.

4. When you are finished editing, click the Thumbnail A tab. 

If you have edited the job, you are prompted to save the job (click Yes) and enter a new 
name.

5. Enter a new name and click OK.

Depending on the location of the original files, the new file is now located in the Spool 
or the RIP area, ready to print. If you saved the edited file with a new name, the 
original source file remains held in the Spool or the RIP area.

…

…

Replace single page Replace multiple pages

Move single page Move multiple pages
between two pages between two pages

…

Move single page Move multiple pages
before first page before first page

…

Move single page Move multiple pages
after last page after last page
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TO MERGE TWO POSTSCRIPT, PDF, OR RASTER DATA JOBS:

1. In the Thumbnail A window, display the document you wish to edit.

The file must be a held PostScript or PDF job in the Spool area, or a held PostScript, 
PDF, or raster data job in the RIP area.

2. Right-click another like-data source document file from the same area (a held job 
with a raster icon) and select Thumbnail B.

The Thumbnail B tab opens a second thumbnail view which cannot be edited but can 
be a source for pages added to the document in Thumbnail A.

NOTE: To merge documents, the page sizes of the source document and the target 
document must be the same, the jobs must both be located in the same area (Spool or 
RIP), and the jobs must be of like data type (i.e., both are PostScript, or both are raster 
jobs).

3. In the Thumbnail B window, left-click to select the page(s) and hold down the 
mouse button as you drag the selected page(s) to the new location in Thumbnail 
A.

Shift-click to select multiple, sequential pages; Ctrl-click to select multiple, 
non-sequential pages.

To scroll through the pages in Thumbnail A and Thumbnail B, you can drag the slider 
bar at the bottom of the screen, click in the empty area to the left or right of the slider 
bar, or click on the arrows.
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To replace page(s), drag Thumbnail B page(s) on top of page(s) in Thumbnail A; to 
add page(s), drag the page(s) to a new position between pages, before the first page, or 
after the last page in Thumbnail A.

NOTE: To insert a Thumbnail B page directly after the last Thumbnail A page, drag the 
Thumbnail B page so that it is just to the right of the last Thumbnail A page and 
shows an arrow pointing to the right. If the Thumbnail B page is placed too far to the 
right of the last Thumbnail A page, the Thumbnail B page will replace the last 
Thumbnail A page.

…

…

Replace single page Replace multiple pages

Move single page Move multiple pages
between two pages between two pages

…

Move single page Move multiple pages
before first page before first page

…

Move single page Move multiple pages
after last page after last page

+

+

+

+ + +

+ +

+ +

+ +
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Multiple undos are available; use Ctrl-Z or the Undo command to undo all the way 
back to your first edit. There is no Redo function.

NOTE: Make sure to save the merged job before deleting any of the jobs you used to 
create the merged job.

Thumbnail B pages moved into Thumbnail A adopt some specific attributes of the 
Thumbnail A job, such as the document and user name. However, many color-related 
print options that are set in the Thumbnail B page, such as CMYK Simulation and 
Rendering Style, remain with the specific page. This could result in a merged job being 
made up of pages with different attributes.

Thumbnail B

Page 4 copied from the 
document in Thumbnail B
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Generally, the print option settings specified for the Thumbnail A job that are adopted 
by the pages copied from Thumbnail B do not require reRIPping to take effect. The 
one exception is the setting specified for the Save Fast Reprint option, which requires 
reRIPping if you want to change it.

The print option settings that remain with the pages copied from Thumbnail B into 
Thumbnail A are generally those that do require reRIPing to take effect.

Attributes that do not require reRIPping can be changed for the newly merged job 
without having to reRIP any original PostScript files. Attributes that require reRIPping 
result in reRIPping of the original PostScript file(s) associated with Thumbnail A.

4. To close the Thumbnail view, click once the same tab you used to open it (Thumbnail A 
or Thumbnail B tab).

5. If you have edited Thumbnail A, you are prompted to save the job (click Yes) and 
enter a new name. Enter a new name and click OK.

Depending on the location of the original files, the new PostScript or raster file is now 
in the Spool or the RIP area, ready to print, together with the original source and 
target files.

Since you cannot create a new PostScript file by merging two jobs, you must print the 
merged file, which has references to the original PostScript files. If a merged job is 
reRIPped and printed, then only the pages of the original PostScript job in Thumbnail 
A will be processed and printed.

NOTE: In cases where multiple users are connected to the Fiery via the Command 
WorkStation, Fiery WebSpooler, or Fiery Spooler, and one user makes changes to a 
Thumbnail A job, not all users may see the results of those changes. If you are unable 
to view changes in a job, or if selecting a Thumbnail window results in a message 
indicating zero pages, then close and relaunch the Command WorkStation, Fiery 
WebSpooler, or Fiery Spooler.

Viewing and overriding print settings
When logged in as Operator or Administrator at the Command WorkStation, you can 
view, override user job settings of, and print any job in the Queues window and view 
job settings for jobs in the Archive and FreeForm windows. Using the Properties dialog 
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box, you can view and override job settings for a single job or for multiple jobs at once. 
When viewing multiple jobs, you can override settings for each job independently or 
override a setting for all the jobs at once.

NOTE: You cannot override the print option settings for PCL jobs.

• To view the properties for a single job, double-click the job line or select the job and 
choose Properties from the Job menu or right mouse menu. 

• To view the properties for multiple jobs at once, shift-click to select contiguous jobs, 
or Ctrl-click to select non-contiguous jobs, and choose Properties from the Job 
menu or right mouse menu.

NOTE: To retain a copy of the job with its original settings, duplicate the job and 
rename the duplicate before you change any settings (see “Job commands” on page 3-
24). 

To override a setting for a single job, right-click the current setting and choose the 
override setting from the pop-up list.

NOTE: For some options, changing the setting requires that the job be reRIPped; these 
options show an icon to the left of the option name.

Indicates reRIPping is required
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To override settings for all jobs listed in the Properties dialog box, right-click the name 
of the print option (the row header) at the left of the dialog box and choose the 
override setting from the pop-up list.

The Properties dialog box displays all the job settings encoded by the PostScript or 
PCL printer driver that can be decoded by the Fiery. If you (as operator) have not 
changed anything, these are the settings a user entered before sending the job. There 
are two exceptions to this: Page Range and Scale. 

For jobs from the Spool area that have been viewed and edited in the Thumbnail 
windows or PDF files printed using Fiery Downloader, you cannot override the 
following print options:

• Remove White PPT Background

• Spot Color Matching

NOTE: Some print options that are available in the printer driver are not displayed in 
the Properties dialog box. For information on specific print options and settings, and 
where they can be set, see Appendix A of the Printing Guide.
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When the Properties dialog box opens, the page range is always shown as All pages and 
the scale is always shown as 100%. All pages denotes all the pages specified by the user 
in printing the job; it may not include all the pages in the original document on the 
user’s disk. Similarly, 100% scale indicates 100% of the magnification specified by the 
user.

The Properties dialog box does display all the remaining user settings, including user 
Instructions and Notes fields.

• Instructions fields are intended to be viewed and annotated by the operator, but 
their contents are associated with the job and are deleted when the job is deleted 
after printing.

• Notes fields can be viewed but cannot be changed by the operator; their contents are 
transcribed to the Job Log just as the user sent them.

Printing variable data documents (FreeForm)
The ability to override job settings is especially important for variable data printing 
with FreeForm. As described on page 3-33, the Fiery can store up to one hundred 
FreeForm Masters; however, users are limited to a range of 1 to 15 as values they can 
specify for the Create Master and Use Master print options. In order to make use of all 
one hundred available FreeForm Masters, the operator must override the Create 
Master and Use Master job settings from the Properties dialog box on the Command 
WorkStation.

NOTE: The FreeForm printing feature is not available for PCL jobs.

TO PRINT A VARIABLE DATA DOCUMENT:

1. Right-click to select the job comprising the variable elements of the document 
and choose Properties.

See page 4-22 for details.

2. Scroll to find the FreeForm section in the Properties dialog box and right-click 
the Use Master print option.
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3. Choose the number of the FreeForm master job that you want to use as the master 
document.

See page 3-33 for information on FreeForm masters.

4. Click OK.

5. Assign the job a destination of RIP and Hold, Print, or Print and Hold.

Particularly with a variable data job, you may want to RIP and Hold the job so that 
you can preview it before printing.

For more information on using FreeForm features, see the Printing Guide.

Downloading files and fonts
From the Command WorkStation, you can download a variety of file types, as well as 
fonts, to the Fiery. These files and fonts can be located anywhere on the network or on 
an external device connected to the Command WorkStation computer. You browse to 
locate the files and fonts, select them, and add them to a list of items to be 
downloaded. You can specify a limited number of print option settings for files that 
you download (see page 4-28).

To download fonts, you must use the Direct connection. If the Direct connection is 
not currently published in Setup, see the Configuration Guide for instructions on how 
to publish it. 

NOTE: You cannot download TrueType fonts. If you use TrueType fonts in Windows, 
you can print them by converting them to Adobe Type 1 fonts. To do this with the 
PostScript printer driver on Windows 95/98 or PCL printer driver on Windows 95/98 
or Windows NT 4.0, click the Fonts tab in the Properties dialog box and set up the 
Font Substitution Table as necessary. 

The Manage Fonts command (in the Server menu) provides another way to download 
fonts to the Fiery (see page 4-29).



44-27 Downloading files and fonts
TO DOWNLOAD FILES OR FONTS:

1. Choose Download from the Job menu, or right-click the Spool status bar and 
select Download. 

The main Fiery Downloader window appears.

2. In the Files of type pop-up menu, choose the file types to display.

You can leave this at the default All Known Formats or choose All Files . All Known 
Formats  lists all files in supported formats; All Files  lists all files.

3. In the Connection Type pop-up menu, choose the queue to which you will 
download the files.

The options available in this menu depend on the print connections currently enabled 
in Setup. The potential choices are Direct Connection , Hold Queue , or Print Queue . If 
your administrator has not enabled one or more of these connections, you cannot 
choose it.

To download fonts, you must choose Direct Connection .

For fonts, choose Direct 
connection
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PDF files are always spooled to the Fiery hard disk before being printed. PDF files 
must be sent to the Print queue (or to the Hold queue if the Print queue is not 
enabled). Do not choose Direct Connection  to download PDF files.

4. In the Look in pop-up menu, browse to the file(s) you want to download.

5. Select the filename and click Add.

The Filename field displays the name of the selected file before you click Add .

You can navigate to different drives and folders to select files and fonts to download.

To select multiple sequential files, select the first file and then Shift-click the last file. 
Ctrl-click to select multiple non-sequential files.

If you change your mind about a file, select the filename in the Files to be downloaded 
list and click Remove .

6. To change the attributes of a file, select it from the “Files to be Downloaded” list 
and click Options. 

The Options dialog box for PostScript and EPS files is different from that for PDF 
files, as explained below. 

NOTE: You cannot change any attributes of PCL files.

7. Specify the following information in the dialog box and click OK.

The options you set apply only to the selected file. You can set different options, or 
leave the default settings, for each file.

Copies—Specify the number of copies.

PostScript options PDF options
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Brightness  (PostScript and EPS files only)—Change the Brightness  setting if a file 
appears to be too dark or too light. Choose 85% for a substantially lighter image, 
115% for a substantially darker image, or one of the options in between. 

NOTE: Some applications, including Adobe Photoshop, provide transfer functions that 
let you specify density settings for an image. If the file you are printing includes 
transfer functions, the Brightness option has no effect. For more information on using 
transfer functions, see the documentation for your application.

‘showpage’ (after EPS files) —In most cases, you do not need to use this option. 
Select the ‘showpage’ (after EPS files) option only if an EPS file fails to print without 
it. This option adds a ‘showpage’ PostScript language command at the end of the print 
job. Some applications omit this necessary PostScript language command when they 
generate EPS files. Select this option when printing EPS files generated by these 
applications. If you select this option unnecessarily, extra blank pages may print.

If you experience problems downloading EPS files, you can print the file directly from 
the application in which you created it.

Page Range  (PDF files only)—Specify the page range you want to print.

8. Click Download.

To cancel downloading, click Cancel or press the <Esc> key.

Managing server fonts
The Fiery includes a number of built-in printer fonts. You can download additional 
fonts to the Fiery using the Manage Fonts command (see below) or the Download 
command (see page 4-26). Users on the network can also download fonts to the server 
using Fiery Downloader (see the Printing Guide). Downloading fonts, either from the 
Command WorkStation or with Fiery Downloader, requires that the Direct 
connection is published in Setup (see the Configuration Guide).

NOTE: The Manage Fonts command is available only if you logged in as Administrator.

Although no special privileges are necessary to download fonts, Administrator 
privileges are required to remove fonts from the server. The built-in printer fonts are 
locked and cannot be removed by anyone.

To print a list of fonts currently resident on the Fiery, use the Print Pages command 
(see page 4-6). 



44-30 Managing Print Jobs
TO MANAGE FONTS:

1. Choose Manage Fonts from the Server menu.

The Server Fonts window displays Add, Delete, Update, and Print buttons. Choose 
either PostScript or PCL fonts.

2. To download additional fonts to the Fiery, click Add and refer to the instructions 
on page 4-26.

3. To delete a font, select it in the font list and click Delete. Shift-click or Ctrl-click 
to select multiple fonts.

NOTE: The printer fonts included with the Fiery (built-in fonts) are locked. These fonts 
appear with a lock icon next to the name and cannot be deleted.

4. To refresh the font list display, click Update.

5. To print the font list, click Print.

Managing jobs with multiple color servers
You can connect to up to five Fiery color servers simultaneously from the Command 
WorkStation. This allows you to view and manage jobs being processed by multiple 
servers from a single location, and also to balance the job load between servers of 
similar capabilities.

• If you connect to multiple servers from the Command WorkStation, you can easily 
switch between them by clicking the server selection tabs (see page 3-13).

• With Fiery color servers that support the feature, you can use the Send to <Server> 
command to transfer jobs between color servers (see page 3-26). 

Click to update the font list display

Click to delete font(s)

Locked fonts

Click to download additional fonts

Downloaded fonts

Click to print the font list

Choose PostScript or PCL fonts
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TO VIEW AND MANAGE JOBS ON MORE THAN ONE COLOR SERVER:

1. Configure the connection to the first server and log in. 

See Getting Started for information on configuring the connection to the server.

2. Click a blank server selection tab.

3. Configure the connection to the next server and log in.

The Command WorkStation windows show the job lists for the additional server. You 
can route and manage the jobs processed by this server as long as you are logged in.

4. To switch servers, simply click the other server selection tab. 

Once you have logged in, you do not need to log in again unless you have logged out.

If the servers are extremely busy with continuous jobs, you may see some delay in 
updating the Command WorkStation window when you switch between servers. Job 
lists may be blank for some seconds until updating is complete.

TO TRANSFER JOBS BETWEEN COLOR SERVERS:

1. Log in to more than one color server, as described above.

To transfer jobs between color servers, both color servers must support the Send 
to <Server> command. 

2. In the Queues window of the source color server, select the job(s) you want to 
transfer.

You can select any held jobs in the Spool or RIP areas.

3. Choose the Send to <Server> command from the Job menu.

The actual command contains the name of the other color server currently connected 
to the Command WorkStation; for example, Send to Aero_ DC12. If two or more 
additional color servers (in addition to the originating server) are connected to the 
Command WorkStation, multiple Send to <Server> commands appear in the Job 
menu.
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Jobs are transferred from the source server to the same area on the target server (from 
Spool to Spool, from RIP to RIP).

NOTE: You cannot perform any other Command WorkStation functions while files are 
being transferred between servers.

4. After verifying that the jobs were successfully transferred, you can delete them 
from the originating server, if you wish.

Archiving jobs
PostScript and raster data jobs can be archived internally to the Fiery hard disk or the 
ZIP drive, or externally to the Command WorkStation hard disk or network drives.

TO ARCHIVE A POSTSCRIPT OR RASTER JOB:

1. In the Queues window, select any held job in the Spool or RIP areas.

2. Choose Archive from the Job menu.

3. To archive the job(s) internally to the Fiery hard disk or to the ZIP drive, click 
OK.

The job(s) are archived internally.

4. To archive the job(s) externally to the Command WorkStation hard disk or to a 
device on the network, click Add.

Click to add a device
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5. Browse to the device and folder to which you want to archive the job(s) and click 
OK.

The Archive Options dialog box shows external devices as available archive volumes.

6. If applicable, select Archive rasters.

The Archive rasters option is dimmed for PostScript data jobs and for jobs being 
archived to Server Internal.

NOTE: Raster data files may be large and therefore may take considerable time to 
archive.

7. Select an archive volume and click OK.

To retrieve jobs archived to external devices, use the Import command.

You can copy or move the archived job to your choice of destinations by right-clicking 
the selected job in the Archive window and selecting Move To or Copy To.
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NOTE: You cannot select the Fiery as the archive destination. Additionally, if you 
archived the job by selecting Server Internal, you cannot copy or move the archived 
job.

Importing archived jobs from external media
You can use the Import command to find and retrieve jobs previously archived to 
external devices. This command can be used to retrieve files archived from the current 
Fiery or from another Fiery that supports external archiving.

TO IMPORT AN ARCHIVED JOB FROM AN EXTERNAL DEVICE:

1. Choose Import from the Job menu in the Queues window, or right-click the Spool 
status bar and choose Import.

2. Select the device containing the job(s) you want to import.

Click Add to import files from other archived volumes.

3. Click OK.

The job is imported to the same area in the Queues window (Spool or RIP) from 
which it was archived.
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Using the Job Log
Chapter 3 introduced the Job Log, which is the list of all processed and printed jobs, 
including the date and time printed, and all the characteristics of the job. It explained 
that the Administrator can set Job Log preferences for clearing and printing the Job 
Log automatically, and for Job Log page size (page 3-34).

If you want to view the Job Log in a specific application, you can specify one in the 
Preferences dialog box (see page 4-5); then select View in Helper App from the 
Window menu.

After displaying the Job Log you can print it (use the Print Pages dialog box or choose 
Print from the Window menu), or export it to a tab-delimited text file (choose Export 
from the Window menu). The exported Job Log file can be imported into a 
spreadsheet, database, or word processing application for job accounting purposes. If 
the Filter command is used to display only a portion of the Job Log (such as jobs for 
the current day), only that portion of the Job Log is printed or exported.

To update the Job Log, choose Refresh from the Window menu.

After printing or exporting the entire Job Log, you may want to clear it; choose Clear 
Job Log from the Server menu.

The Job Log window displays a list of all the jobs and the following information about 
them: status, document name, user, date, start time, end time, process time, page 
description language, size, device, page size, media, number of originals, number of 
color pages, number of black-and-white pages, and total number of pages. Information 
in the Notes 1 and Notes 2 fields is displayed if users entered this information when 
they printed.
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NOTE: If a PostScript or raster job was saved in DocBuilder Pro with a new name and 
then printed, it appears in the Job Log with the name of the original job, not the new 
name you specified for the edited job.

The text in the Status column provides information about the job: 

Use the scroll bar at the bottom of the window to view all the fields in the Job Log 
window.

Duplex Alignment
Duplex Alignment allows you to adjust the placement of text and images on the page 
so that both sides of a duplex sheet have the exact same alignment.

TO ALIGN TEXT AND IMAGES FOR DUPLEX PRINTING:

1. Select Duplex Alignment from the Server menu.

2. In the dialog box, select a page size and click Print test page.

The test page consists of a duplexed page with a grid on each side. The grid ranges 
from A through W on the horizontal axis and 0 through 22 on the vertical axis. The 
grid range appears on only one side of the paper. The second side is a matching grid 
without the range.

3. Hold the test page up to a strong light source and choose the coordinates at 
which the two grids are best aligned.

For example, the grids may be best aligned at a point which is D on the horizontal axis 
and 4 on the vertical axis.

OK The job was printed normally.

Cancel The job was canceled before printing was completed.

Error An error occurred during processing or printing.
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4. Select the coordinates in the dialog box in the Shift value area.

The horizontal and vertical coordinates are each selected from a separate pull-down 
menu.

5. Click Apply.

NOTE: Duplex Alignment is specific to a page size and the paper source. For example, if 
you perform a Duplex Alignment for the Letter size paper in Tray 1 and then print a 
job from Tray 2 on Letter size paper, the Duplex Alignment will not apply. You must 
perform Duplex Alignment for each combination of page size and paper source you 
will be using. 

Other server management commands
These additional Server menu commands are used to manage server performance, 
configuration, and status. Some of these commands are available only when logged in 
as Administrator:

• Manage Color —Opens ColorWise Pro Tools (see the Color Guide)

• Manage Fonts —Allows you to delete fonts from, as well as add fonts to, the Fiery 
(see page 4-29)

• Clear Job Log —Clears the Job Log only

• Reboot—Causes the Fiery to be rebooted, just as if you had selected Restart Server 
from the Shut Down menu on the Control Panel (see page 1-6)

• Clear—Clears all jobs in all server queues, as well as all jobs archived on the Fiery 
hard disk, the index of archived jobs (in the Archive window), all FreeForm masters, 
the index of FreeForm masters (in the FreeForm windows), and the Job Log

• Setup—Invokes Fiery Setup (see the Configuration Guide)

• Log out —Closes the connection to the Fiery
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Imposition is a special feature of DocBuilder Pro. You must have the DocBuilder Pro 
Upgrade for the Command WorkStation installed to use this feature. This chapter 
describes the graphical user interface for imposition functions. For background 
information on imposition and its uses, see Appendix A.

NOTE: The Imposition feature is not supported for PCL jobs.

Main window
From the Imposition main window, you can impose the pages of a document in an 
order and positioning suitable for printing and binding. 

NOTE: The Imposition main window is referred to as the “main window” in Chapters 5 
and 6.

TO OPEN A JOB IN THE MAIN WINDOW:

• Send the job you want impose to the Hold queue or move it to the Spool area 
using the Command WorkStation.

For more information on sending jobs to the Fiery, see the Printing Guide. For 
information on using the Command WorkStation, see Chapter 3.

• Select any held job in the Spool area and choose Impose from the Job menu. Or 
you can right-click the job and choose Impose from the right-mouse menu.

Chapter 5:
Using 
Imposition
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You can open a PostScript or a PDF (Portable Document Format) file, but it must be 
held in the Spool area.

NOTE: If you have installed DocBuilder Pro as an optional kit, you will also need to 
install a dongle on your workstation. If the dongle is not attached, you will see an error 
message. 

When you choose the Impose command, a page-imaging process is invoked that 
generates a PDF version of the job on which DocBuilder Pro will perform imposition.

A status window is displayed while the job is imaged for the main window. 
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When it opens, the main window displays the job. No layout will be applied unless the 
the job has been previously imposed. Templates for common layouts are provided and 
can be invoked from the main window as described in “Using templates” on page 5-8.

Job previews
The main window provides a preview of a job’s pages before the job is RIPped, 
allowing you to manipulate the source PDF before rasterizing the job.

Pages appear as a printer’s spread; that is, they appear in the order in which they are 
printed as an imposed job. In contrast, a reader’s spread shows pages in the order they 
are intended to be read. You’re already familiar with such a view—the Thumbnail A 
and Thumbnail B windows image jobs as reader’s spreads. 

Printer’s spread

Reader’s spread
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Navigating in the main window
You can use the icons and menus at the top and bottom of the window to:

• Switch from preview mode (thumbnails of actual content) to layout mode (page 
numbers only)

• Zoom in and out

• Drag the job preview around to make a particular page or sheet visible

• Go directly to a particular page or sheet

The Zoom tool, Pan tool, preview mode and layout mode buttons are located in the 
top-right corner of the window. 

Pan tool

Zoom tool

View menuSheet menu

Layout mode

Preview mode
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When you position the cursor over the Pan or Zoom tool, a 3-D border surrounds it to 
provide the appearance of a raised button. Click once to select the tool. The 3-D 
border inverts, as if the button has been pressed, indicating that the tool is selected. 

When you select the Pan tool or Zoom tool, the appearance of the cursor changes to 
indicate that you can now use that tool to manipulate the preview. When you choose 
the preview or the layout mode, a blue border appears around the selected view and the 
appearance of the job in the main window changes immediately.

The sheet menu, view menu, and scroll bar (shown above) appear at the bottom of the 
window. These menus and controls affect the display in the main window immediately. 

Switching between page view and layout view
You can use the view mode buttons to switch between a page view and a layout view of 
the job. 

• Preview mode approximates the appearance of the final printed output very closely; 
for this reason, it is sometimes called a WYSIWYG (“what you see is what you get”) 
preview.

• Layout mode displays numbered, generic pages that allow you to determine the 
location of source document pages in the imposed job; and you can rotate individual 
pages or signatures in a layout view. 

Different viewing modes may display different sets of printer’s marks; for more 
information, see the table below.

NOTE: The graphically-rich preview mode puts more stress on your system’s processor 
than the relatively lightweight layout view mode. You can improve performance on 
slower systems by doing most of your work in layout mode, switching to preview mode 
only when you actually need to see content. 

In layout mode, you can rotate individual pages on the sheet; for more information, 
see “Rotating pages” on page 6-12.
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The following table summarizes the characteristics of the layout and preview modes: 

Setting magnification levels
You can use the Zoom tool to increase or decrease the level of magnification in the 
main window from 12% to 800%.

TO ZOOM IN AND OUT:

1. Click the Zoom tool once to select it. 

The cursor changes to a magnifying glass when in the preview area of the main 
window.

2. Position the magnifying glass cursor over a page and click to zoom in.

The magnifying glass cursor displays a plus sign (+) to indicate that it increases the 
magnification of page views. Each time you click, the current magnification doubles, 
up to a maximum of 800%.

3. Hold the Ctrl key and click with the left mouse button to zoom out. 

Each time you click, the current magnification halves, down to a minimum of 12%.

4. Click the right mouse button with either the Zoom tool or the Pan tool to see the 
zoom pop-up menu.

Select Zoom In or Zoom Out from the pop-up menu. Zoom In doubles the current 
magnification and Zoom Out halves the current magnification.

Feature: Layout mode: Preview mode:

Shows page content No WYSIWYG content view 

Quick redraw on slower computers Yes No

Shows printer’s marks Yes Yes

Reorder pages Yes No

Rotate pages Yes No

Define gutter Yes No
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The View menu at the bottom of the window provides several ways to set the level of 
magnification at which DocBuilder Pro displays the contents of the window. The View 
menu allows you to choose preset zoom values ranging from 50% to 800%. You can 
also choose to make the current preview fit in the window. 

• To choose a zoom value, click on the View menu and choose a zoom percent. 

• To preview the entire sheet, click on the View menu and choose Fit Page.

NOTE: The View menu changes only the appearance of pages, not their actual content. 
To change the scaling of pages in finished output, change Scaling area settings, as 
described on page 6-6.

In addition to preset zoom percents, you can specify a custom zoom value. 

TO SPECIFY A CUSTOM ZOOM VALUE:

1. Click the View menu at the bottom of the main window.

The current zoom value is displayed in the box. 

2. Specify a new zoom value.

You can type a new zoom value in the box or you can select a value from the pop-up 
menu.

3. Click OK or press Enter to confirm the new value. 

The window reflects the change immediately. 

Viewing the sheets
You can use the Pan tool to drag the entire preview around in the window. For 
example, if you are working with many pages on a large sheet, you can use this tool to 
drag a particular portion of the sheet into view. 

TO MOVE THE PREVIEW AROUND:

1. Click the Pan tool once to select it.

The cursor changes to a hand when in the preview area of the window. 
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2. With the Pan tool cursor positioned over a sheet, press and hold the left mouse 
button while moving the mouse.

The page preview moves in the same direction as the cursor. You can repeat this step as 
necessary to make a particular portion of the preview visible. 

At the bottom of the window, you can manipulate the content view using a standard 
scroll bar or the Sheet menu. The Sheet menu provides the Go To Sheet dialog box, 
which allows you to specify numerically the sheet to display in the preview area. 

TO GO DIRECTLY TO A SHEET BY NUMBER:

1. Click in the Sheet menu at the bottom of the window.

When the Go To Sheet dialog box appears, the entry box displays the number of the 
sheet currently displayed.

2. Enter the number of the sheet to display.

3. Click OK or press Enter to go to the specified sheet.

Using templates
A saved group of imposition settings is known as a template. A template saves all 
current imposition settings except custom rotations of individual pages on a finished 
sheet and the page size setting. You can apply any template to any job, making it easy 
to apply imposition settings quickly and efficiently. 

DocBuilder Pro supplies built-in templates that define settings for commonly-used 
layouts, such as 2-up saddle, 3-up trifold brochure, 4-up gatefold, and so on. You can 
also create your own templates. For a complete listing of built-in templates, see 
Appendix B. For information on creating your own templates, see “Imposition 
settings” on page 6-1. Both built-in templates and your own templates appear in the 
Template pop-up menu. 
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Template pop-up menu
You can apply a template by choosing its name from the Template pop-up menu, in 
the top-left corner of the main window. The new settings take effect immediately.

TO SAVE THE CURRENT SETTINGS AS A TEMPLATE:

You can save the current combination of Sheet, Layout, Scaling, and Finishing settings 
as a template.

NOTE: The Size setting of the Sheet menu cannot be saved.

1. Click the Save template icon to the right of the Template pop-up menu. 

2. In the dialog box that appears, type a name for the template and click OK or 
press Enter. 

For more information on creating templates, see “Managing templates” on page 6-14.

Saving your work
To close the Imposition window, click the close box in the top-right corner. 

TO SAVE THE IMPOSED JOB:

1. Click the close box in the top-right corner of the main window. 

If the job has changed since it was opened in the main window, you are prompted to 
save it.

Delete template

Save template

Name of current template

Close box
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2. In the Save As dialog box, type a name for the job and its settings.

3. Click Yes. 

In the Save As dialog box, the name of the original spooled source file appears with a 
new extension (.dbp) as the suggested name. If you mistakenly close the main window 
when you intend to keep working, click Cancel in the Save As dialog box. The original 
PostScript or PDF file remains intact even after the converted file has been edited and 
saved in the Imposition window.

For more information on how files are saved to the Fiery, see “File management” on 
page 6-16.
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This chapter provides information about the advanced features of DocBuilder Pro. You 
can use Imposition settings to alter various aspects of a job and to create custom 
templates.

Imposition settings
Imposition settings apply only to the job currently displayed in the main window. 
Because these settings usually affect the job’s printed layout, they are saved with the job 
and used whenever the job is opened. For example, as you open jobs that were saved 
with different layouts, you see the display change accordingly. Changes to imposition 
settings are applied to the current job immediately, but are not saved permanently until 
you save the job itself. 

You can specify imposition settings using controls in the settings panel on the left side 
of the main window. The settings panel appears the first time you open the main 
window, but can also be hidden to make additional space for viewing an imposed job. 
To display or hide the settings panel, click the triangle next to the Template pop-up 
menu in the top-left corner of the window.

The icons to the right of the Template pop-up menu are also related to imposition 
settings; however these icons are always visible in the main window, even if you hide 
the settings panel. For information on these icons, see “Managing templates” on 
page 6-14. 

Chapter 6:
Advanced 
Features of 
DocBuilder Pro

Click to view or hide the 
settings panel
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NOTE: You can change the default unit of measure for all input fields in the Preferences 
dialog box of the Command WorkStation. You can also specify any unit of measure in 
any field that accepts input by suffixing one of the following abbreviations to the new 
value:

“i”, “in,” or the inch symbol (") specifies inches, for example: 8.5 i, 8.5 in, 8.5"
“mm” specifies millimeters, for example: 8.5 mm
“pt” or “pts” specifies points, for example: 8.5 pts

Sheet area
Sheet settings allow you to specify characteristics of the paper on which the job is to be 
printed, such as its dimensions, thickness, orientation, and whether it will be printed 
on one or both sides.

Because these settings affect virtually every other aspect of the imposition process, you 
should specify sheet settings immediately after opening a job in the main window. If 
necessary, you can change the settings later; the job is revised accordingly. 

In general, experimentation with job settings does not cause permanent changes (or, 
potentially, loss of original job data) until the job is RIPped or saved with the new 
settings. 

Size

You can select an item in the Size menu to specify the dimensions of the sheet and see 
the change reflected in the main window preview immediately. The Size popup menu 
includes items representing all page sizes defined by the currently selected print 
engine’s PostScript printer description (PPD) file. To choose a custom size, enter the 
width and height of the custom page.



66-3 Imposition settings
The sheet size setting also defines a sheet orientation; for example, a paper size of 
8 x 10 indicates a portrait sheet orientation, while a paper size of 10 x 8 indicates a 
landscape sheet orientation. It is not necessary, however, to choose a sheet size based on 
the sheet orientation it determines. You can rotate the sheet display in the main 
window with the Orientation setting (described below).

NOTE: Sizes with an SEF prefix (for “short edge feed”) also specify a landscape 
orientation for the sheet. 

Creep Adjustment

You can choose either Plain or Thick from the Creep Adjustment menu to specify the 
thickness of the sheet. When saddle stitch binding is specified, DocBuilder Pro uses 
this value to compensate automatically for binder’s creep (see “Shingling and creep” on 
page A-7). 

NOTE: Even if you select Thick from the Creep Adjustment menu, your job will still 
print on Plain paper unless you have specified Thick paper in the job properties. For 
more information on changing the job properties from the Command WorkStation, 
see Chapter 3.

Orientation

Choose an item from this menu to specify the orientation of the sheet displayed in the 
main window. This setting does not effect the orientation of pages on the sheet (which 
is determined by the layout you specify) or the way in which sheets are fed through the 
DocuColor 12. It affects only the angle at which you view sheets in the main window, 
allowing for optimal viewing regardless of the sheet size you specify. You can also 
perform custom rotations on any page in the main window. For more information, see 
“Rotating pages” on page 6-12.

Duplex

You can use the Duplex menu to specify the relationship of content areas on opposing 
sides of a sheet. Specify On for duplex (two-sided) printing, Off for simplex (one-
sided) printing, or Manual for duplex printing using the Manual Feed tray. When you 
choose On, the job is printed as duplex using a Top-Top setting, meaning that the tops 
of pages on opposing sides of a sheet are located on the same edge (usually the 
preferred choice for imposed book layouts). 
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Layout area
A layout is a plan that specifies the number, ordering, and rotation of page images on 
the sheet. DocBuilder Pro supports layouts of up to 25 pages per sheet, in a matrix of 
up to 5 rows by 5 columns (50 pages duplex). All combinations of rows and columns 
allow gang printing; however, only certain layouts in the 5 x 5 matrix support 
imposition.

NOTE: If the number of pages in your job does not divide evenly into the number of 
rows and columns in the layout you select, you may see some sheets with blank spaces. 
The layout you select should correspond to the number of pages in your job.

Rows

Click the Rows up and down arrows to specify the number of rows in a layout. Or
you can specify the number of rows in the layout by typing a value in the Rows box. 
Changes to the Rows value are reflected immediately in the main window, whether you 
are in layout or preview mode.

The Rows value interacts with the Columns and Scaling values. When you choose a 
value that causes content to extend beyond the edge of the sheet, DocBuilder Pro 
provides a visual warning. For more information, see “Clipping indicators” on 
page 6-7. 
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Columns

Click the Columns up and down arrows to specify the number of columns in a layout. 
Or you can specify the number of columns in the layout by typing a value in the 
Columns box. Changes to the Columns value are reflected immediately in the main 
window, whether you are in layout or preview mode.

The Columns value interacts with the Rows and Scaling values. When you choose a 
value that causes content to extend beyond the edge of the sheet, DocBuilder Pro 
provides a visual warning. For more information, see “Clipping indicators” on 
page 6-7. 

Printer’s Marks

Select Printer’s Marks to add trim, fold, and job information to all sheets in a job. 
Because the set of marks required varies according to the job, DocBuilder Pro allows 
you to define the set of printer’s marks displayed. For example, ganged up business 
cards do not require fold marks, while a 4 x 4 book layout requires them. To specify 
which marks are shown, choose options in the dialog box that the Define button 
displays. 
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In this dialog box, you can enable or disable trim marks, fold marks, and the individual 
elements of the job label. The job label stores descriptive text used for the job name, 
sheet information, and date and time.

NOTE: Not all layouts will display all of the Printer’s Marks. For example, if the layout 
you select does not require that the sheet be folded, fold marks will not be displayed 
even if you have selected them in the Define Marks dialog box.

Bleeds

Select Bleeds in the Layout area.When bleeds are enabled, marks are repositioned by 
the specified bleed amount. Because the bleed amounts required for each job vary, 
DocBuilder Pro allows you to specify both the horizontal and vertical bleeds in the 
Define Bleeds dialog box.

Scaling area
You can use the controls in the Scaling area to enlarge or shrink the page by a specified 
amount. The values in this area interact with each other based on the specified layout 
and page size. When you specify one or more values in the Scaling area, 
DocBuilder Pro calculates the others for you.

Fold mark

Trim marks

Job label
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For example, when you specify a scaling percentage, DocBuilder Pro calculates the 
resulting finished page size and supplies appropriate height and width values in the 
Finished area. Conversely, if you specify the height and width of the finished page, 
DocBuilder Pro supplies the percentage by which the original page must be scaled to 
achieve that result. 

Clipping indicators

If you supply scaling values that would cause the page to print past the edge of the 
sheet, DocBuilder Pro provides a visual warning. When the window is in layout mode, 
any clipped page edge is highlighted in yellow. When the window is in preview mode, 
the clipping icon appears in the top-left corner of the Scaling area. In addition, the 
appearance of the page preview itself makes scaling problems obvious—content 
truncates at the edge of the preview sheet, just as it would on a printed sheet. 

Clipping icon

Clipped page edge
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Finished height and width

The Finished Height and Width fields display current values for the height and width 
of a scaled page. When you enter values for the height or width of the scaled page, 
DocBuilder Pro supplies calculated values for scaling, finished height, and finished 
width. 

Scale to fit

When you select Scale to fit, DocBuilder Pro calculates the page size that fills the sheet 
without printing past its edge. DocBuilder Pro fills in the values for scaling, finished 
height, and finished width.

Finishing area
In the Finishing area, you can specify the binding method and compensate 
automatically for creep according to the grouping of signatures in the job and the way 
in which the job is to be bound. 

Binding

To enable binding settings and disable gang printing, select Binding. When binding 
settings are enabled, you can click the Binding menu to specify Saddle, Perfect, or 
Nested Saddle as the binding method. DocBuilder Pro compensates automatically for 
binder’s creep according to the specified binding method, the number of sheets in a 
group, the layout in use, and the size of the job.

Saddle —a group of folded sheets stitched or stapled on a common, centered fold line. 
Saddle-stitched binding is the most common type of binding, and is usually used for 
booklets.

Perfect—signatures folded and stacked for binding. The spine edges are trimmed and 
glued together.
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Nested Saddle —combination of saddle and perfect binding methods. As with saddle 
stitch, pages are grouped together and stapled or stitched across a common center fold. 
The saddle groups are then stacked one on top of another and glued as with perfect 
binding. When imposing a book for nested saddle binding, you specify the number of 
sheets in each saddle; this number is called a group. 

NOTE: If you have selected a layout with more than two columns or rows, the Binding 
selection will be unavailable. A layout with three or more columns or rows cannot be 
bound as a book or booklet because the pages must be cut from the sheet, not simply 
folded over.

Groups

You can type a whole number into the “Groups of” box to specify the number of 
signatures gathered together in each saddle when the book is bound. As the number of 
signatures in a saddle increases, the effect known as binder’s creep becomes more 
prevalent. DocBuilder Pro shifts images on the page to compensate for creep 
automatically according to the value in the groups field, the value in the paper 
thickness field, the specified binding type and the ordering and orientation of pages 
specified by the current layout. 

Gang Up

To enable gang printing and disable binding settings, select Gang Up. In gang printing 
mode, you place pages on the sheet in an arbitrary order for “collate and cut” finishing, 
rather than having DocBuilder Pro impose them in the order required by a particular 
binding method. 

A collate and cut layout reorders pages in a manner that causes them to fall into easily-
collated stacks when the sheets in the job are cut into individual pages. The use of such 
a layout may allow multiple small jobs to be printed on a single sheet; thus, gang 
printing is commonly used as a means of saving paper when printing small jobs on 
imaging devices that use large sheets. 

When gang printing is enabled, choose Repeat from the Gang Up menu to repeat the 
image of a page until the sheet is filled; for example, when printing both sides of a 
sheet, the front side of the first sheet is filled with images of page one, and the back side 
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is filled with images of page two; the front side of the second sheet is filled with images 
of page three, and the back side is filled with images of page four; and so on, until all 
pages in the job are imaged.

Documents laid out this way may tend to be collated more easily than when printed in 
another order. The Repeat option in this menu enables what is commonly known as 
“step-and-repeat” printing. Step-and-repeat is most often useful when printing 
multiple copies of a single document; for example, when printing business cards, you 
would print multiple copies of the same image to fill a larger sheet. 

Conversely, Gang Up Unique is often more appropriate for printing single copies of a 
document. This option does not fully collate itself (collate and cut is necessary), but it 
optimizes the sheet size while limiting the run to a single copy.
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To disable gang printing and enable binding settings, select the Binding setting. When 
gang printing is disabled, DocBuilder Pro imposes pages in the order defined by the 
current layout. 

Modifying the layout manually
Whether you apply a predefined layout or specify custom settings, you can manually 
modify the job’s layout by:

• Reordering pages

• Rotating pages

• Setting gutter sizes

To make any of these modifications, you must first select layout mode (see page 5-5).

NOTE: You should specify the Duplex setting before reordering or rotating pages.

Reordering pages in layout mode
When you impose a job, its pages are automatically arranged in a particular order 
according to the specified layout. Each page number in layout view represents the page 
from the source document that DocBuilder Pro images in a designated position on the 
finished sheet. However, if you want to reorder individual pages manually, you can do 
so in the main window. Use the following procedure to assign a different page to a 
particular location in the layout.

TO REORDER PAGES:

1. Verify that layout mode is currently selected.

2. Select the location’s current page number, type the new value, and press Enter, or 
press Tab to move to the next page in the layout. 

You can add a blank cover page by typing 0 (zero) for any page number. Page 0 will be 
printed as a blank page if Duplex is set to On. If Duplex is set to Off or Manual, page 
0 will not be printed.
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NOTE: When you use the procedure above to reorder pages, the page number which 
you type in overwrites the original. For example, if you typed page 3 in place of page 5, 
you will now have two of page 3 and none of page 5. Also, you cannot type in a page 
number that does not already exist in your job. For example, if your job has 10 pages, 
you cannot type in 12.

Rotating pages
You can manually rotate individual pages or sets of pages in the job. To do this, the job 
must be displayed in layout mode. Rotation is performed in 90° clockwise increments 
when you click the rotate icon in the upper-right corner of a page.

• To rotate a single page, click the rotate icon on that page.

• To rotate all pages in the job, press the Shift and Ctrl keys and click the rotate icon 
on any page.

Rotate icon

16 1 2 5

Sheet 1, 
front side

Sheet 1, 
back side

14 3 4 13

Sheet 2, 
front side

Sheet 2, 
back side

12561110789



66-13 Modifying the layout manually
• To rotate all pages in a certain location on the front side of each duplex sheet, press 
the Shift key and click the rotate icon on any page in that location on any sheet. For 
example, in the graphic above, if you press the Shift key and click the rotate icon on 
page 8, page 6 would rotate as well because they are both in the same location on the 
front side on the sheet.

• To rotate all pages in a certain location on the front and back sides of each duplex 
sheet, press the Ctrl key and click the rotate icon on any page in that location on any 
sheet. For example, in the graphic above, if you press the Ctrl key and click the 
rotate icon on page 1, pages 5, 3, and 13 would also rotate because they are in the 
same location on the front and back sides of the sheet.

Setting gutter sizes
DocBuilder Pro defines the locations of gutters for you according to the layout and 
sheet size governing the imposition of the job. In layout view, you can specify the size 
of a gutter by entering a value in its gutter size field and pressing Enter. For example, 
perfect-bound jobs typically require larger gutters than saddle stitch ones, in order to 
provide room for grinding off the spines and gluing signatures together when the book 
is bound. 

NOTE: The size and location of the margin (the area between the outside edge of a 
group of imposed pages and the edge of the sheet) is a function of layout and sheet 
settings. You cannot define custom margins. 

Vertical gutter size field

Horizontal gutter size field

Margin
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Managing templates
You can name and save the current combination of Sheet, Layout, Scaling, and 
Finishing settings as a template. 

NOTE: The Size setting of the Sheet menu cannot be saved. You can use the Preferences 
item in the File menu to set the folder or directory in which the Command 
WorkStation saves templates. For more information, see Chapter 4.

TO SAVE IMPOSITION SETTINGS AS A TEMPLATE:

1. Click the save template icon—the disk icon on the right side of the Template 
pop-up menu.

2. In the Save Template As dialog box, type a name for the settings file.

When saving a template, choose a descriptive name, such as “4-Up Nested Saddle” 
rather than something that won’t provide as much information, like “My Settings.” If 
you plan to use the same template for a particular document, name the template after 
the document type, for example, “Status Report.”

3. Click OK or press Enter. 

Delete template

Save template

Name of current template
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TO DELETE A SAVED TEMPLATE:

1. Click the delete template icon—the trash can icon on the right side of the 
Template pop-up menu.

2. In the dialog box that appears, select the template to delete.

3. Click OK or press Enter to delete the specified template.

Tips for using the Imposition feature of DocBuilder Pro
This section provides information that will help you get the most out of the 
Imposition feature of DocBuilder Pro. 

DocBuilder Pro and Acrobat technology
DocBuilder Pro makes use of Adobe Acrobat technology to perform certain page-level 
operations. Keep the following tips in mind to ensure success:

• Avoid the Touch-Up tool in Acrobat Exchange

If you need to use this tool on a source document, do so before opening the document 
in DocBuilder Pro. Do not use this tool on PDF files created by DocBuilder Pro, such 
as saved impositions, RIPped and held jobs, or printed jobs because the changes will 
not be saved to the server and will not be reflected in the printed output.

• Adding a binding offset

You can set gutters on each page independently to allow extra room for binding. For 
more information, see “Setting gutter sizes” on page 6-13.
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File management
An awareness of how DocBuilder Pro structures data can help you maintain the 
integrity of source documents and create interim copies of work in progress. This 
section describes the temporary files that DocBuilder Pro creates at various stages in 
the process of imposing a document, and suggests file-management techniques you can 
use to preserve your work. 

When a workstation on the network prints a source document to the Fiery, the server 
creates a spool file containing the same kind of data (PostScript or PDF) that the 
workstation sent. The spool file simply records (for subsequent “playback” to a print 
engine) the image of every page in the print job, in the order the pages are to be 
printed. Unlike the source document, a spool file is quite literal in its record of the 
print job—if there are duplicate pages in the print job, the associated data is duplicated 
in the spool file as well. Thus, spool files tend to be significantly larger than the source 
documents they represent. 

To maximize efficient use of server disk space, it is strongly recommended that spool 
files not be kept on the Fiery any longer than necessary. The Command WorkStation 
operator must delete spool files explicitly. 

When you open a spool file in DocBuilder Pro, a temporary file in PDF format is 
created on the Command WorkStation hard disk. A PDF spool file is simply copied to 
the temporary file; however, when you open a PostScript spool file, DocBuilder Pro 
writes a PDF version of the PostScript data to the temporary file. The temporary PDF 
file resides on the Command WorkStation hard disk until you close or save the job. 

When you close the job, the name of the original spooled source file appears with a 
new extension (.dbp) as the suggested name in the Save As dialog box. The original 
PostScript or PDF remains intact even after the converted file has been edited and 
saved in the Imposition window.
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All operations that modify a job’s data are performed on its temporary file or on 
associated imposition data. Page-level operations modify the temporary PDF file. 
DocBuilder Pro functions modify the imposition data associated with the temporary 
PDF file. 

Saving imposed jobs
When you save an imposed job, DocBuilder Pro does two things:

• If new data has been added to the temporary PDF file, it is written back to the 
Fiery under the name you specify in the Save As dialog box.

The default name that appears in the Save As dialog box is that of the original spool file 
with a new extension (.dbp). The original PostScript or PDF remains intact even after 
the converted file has been edited and saved in the Imposition window. 

• If imposition data has changed, the data is written back to the Fiery and 
associated with the new PDF. 

Maintaining associated imposition data separately from the job’s PDF data allows 
DocBuilder Pro to impose in-RIP without modifying the PDF data, and allows you to 
reuse PDF data that has been modified in the imposition process. 
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This chapter introduces Fiery WebTools and provides instructions on their use. For 
more information on specific Fiery WebTools, you are referred to other chapters in this 
book and to other manuals in the documentation set.

Fiery WebTools
Fiery WebTools reside on the Fiery but can be accessed over the network from a variety 
of platforms. The Fiery has a home page that lets remote users view server functions 
and manipulate jobs. 

Fiery WebTools can be used on Windows 95/98, Windows NT 4.0, and Mac OS 
client computers with certain Internet browsers that support the Java language. For 
specific information on the browsers supported with Fiery WebTools, see Getting 
Started.

Access privileges
The Fiery system allows the site administrator to choose and implement a level of 
access and control appropriate for your particular site. There is a spectrum of control 
that can be implemented; the levels of access allowed to remote users depend on 
whether the administrator has enabled use of Fiery WebTools, and whether or not a 
password is required to use the job management features of Fiery WebTools. 

If you have been given the Operator password, you can manage job flow and override 
print settings of your jobs with Fiery WebSpooler. If not, you can still track the status 
of your jobs with the Status tool, and with Fiery WebSpooler, as a Guest. Check with 
your site administrator for information on your Fiery WebTools access privileges.

Chapter 7:
Overview of 
Fiery WebTools
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Using Fiery WebTools
Fiery WebTools are accessed from the Fiery home page.

WebTool: Summary: For more information:

Status Shows you the jobs currently processing 
and printing.

See the Printing Guide

WebSpooler Allows you to view, manipulate, reorder, 
reprint, and delete jobs currently 
spooling, processing, or printing on the 
Fiery. It also allows you to view, print, 
and delete the Job Log.

See “Tracking and managing 
jobs with Fiery WebSpooler” 
on page 8-1

WebLink Provides a link to another web page, 
provided you have a valid Internet 
connection. The WebLink destination is 
initially set to www.xerox.com. The 
WebLink destination can be changed; 
this function requires the Administrator 
password, if one has been set.

See the Printing Guide and 
the Configuration Guide

Installer Allows you to download the Fiery Link 
installer and Fiery printer file installers 
directly from the server.

See Getting Started

WebSetup Allows you to modify the Fiery 
configuration (Setup) remotely. This 
function requires the Administrator 
password, if one has been set. 

See the Configuration Guide

WebDownloader Allows you to download PostScript, 
PCL, EPS, and PDF files to the Fiery.

See the Printing Guide
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TO ACCESS FIERY WEBTOOLS:

1. Launch your Internet browser application. 

2. Enter the IP address or the DNS name of the Fiery.

Check with the operator or administrator for this information.

The Fiery home page appears.

3. Click one of the buttons at the left to select one of the Fiery WebTools.

Move the cursor over the buttons to display information about the selections.
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Fiery WebSpooler and Fiery Spooler duplicate many of the functions and features of 
the Command WorkStation. Each provides additional flexibility by allowing job 
tracking and management from multiple platforms over the Internet or an intranet.

NOTE: Fiery Spooler is available for Mac OS computers only.

• Fiery WebSpooler, one of the Fiery WebTools, is accessed with an Internet browser 
and the Fiery home page (see Chapter 5). 

• Fiery Spooler is installed from the User Software CD. To use Fiery Spooler, users 
need only a network connection to the Fiery. 

The interface of Fiery Spooler for Mac OS computers is virtually identical to that of 
Fiery WebSpooler. Moreover, the interfaces of these tools are so similar to that of the 
Command WorkStation that this chapter often refers you to Chapters 3 and 4 (on the 
Command WorkStation) for information about icons and commands that is common 
to all three tools.

Tracking and managing jobs with Fiery WebSpooler
You can use Fiery WebSpooler (and Fiery Spooler for Mac OS) to perform the 
following functions from your workstation:

• Override current job option settings

• Delete jobs and cancel processing

• Duplicate or rename jobs

• RIP a job and hold the raster data

• Hold jobs in the spooled area or the RIPped area

• Remove raster data from RIPped files

• Change the priority of jobs

• Edit and merge raster data jobs (DocBuilder)

• Display, print, or delete the Job Log 

Chapter 8:
Fiery WebSpooler 
and Fiery Spooler
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Most of these functions require the Administrator or Operator password. However, 
even without a password, you can log in to Fiery WebSpooler as Guest with view-only 
privileges.

NOTE: Most Fiery WebSpooler commands function identically to those of the 
Command WorkStation. For more information on specific commands, see Chapters 3 
and 4.

TO ACCESS THE FIERY WEBSPOOLER WINDOW:

1. From the Fiery home page window, click WebSpooler.

For instructions on how to access the Fiery home page window, see page 7-3. 

2. To log in as Administrator, enter the Administrator password and click OK.
To log in as Operator, enter the Operator password and click OK.
To log in as Guest, click OK, without entering any password.

The Fiery WebSpooler window appears in a new browser window.
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About the Fiery WebSpooler window
Like the Command WorkStation, Fiery WebSpooler is a window to view Fiery and 
copier functions, and an interface from which you can control those functions.

The Fiery WebSpooler window is divided into three areas by Spool, RIP, and Print 
status bars. When the Fiery receives print jobs, the Fiery WebSpooler window becomes 
a dynamic display, filled with the names of jobs and their characteristics.

The Spool, RIP, and Print areas of the Fiery WebSpooler window represent the stages 
of printing a job. Jobs come in at the top level (Spool) and drop down to the Print 
level, unless they are held along the way.

The job icons displayed in the Fiery WebSpooler window are explained in “Job icons” 
on page 3-20.

NOTE: In the Fiery WebSpooler window, the background color for the yellow and white 
printer icons is the same.

Spooled jobs—Jobs listed in the area below the Spool status bar are PostScript files 
stored on the Fiery disk. These jobs were sent to either the Print queue (white icons) or 
the Hold queue (yellow icons).

RIPped jobs—Jobs listed in the area below the RIP status bar are ready to print. They 
have already been rasterized (RIPped, or processed for printing) and are waiting, in 
order, for access to the printer. Rasterized jobs can also be held; held jobs are shown 
with a yellow icon.

Printed jobs—Jobs listed in the area below the Print status bar have already been 
printed. Printed jobs can be stored on the Fiery disk. The number of jobs that can be 
stored (from 1 to 99) is defined in Setup.

If you are logged in as Administrator or Operator, you can interact with a job wherever 
it appears in the window by selecting it and choosing a command from the Job menu, 
or by double-clicking the job and setting override options. See “Manipulating job 
options and job flow” on page 8-4 for information.
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Errors—Jobs with an error are shown in red. To display the error, double-click the job 
line. Note that you cannot check the job properties or hold a job with an error.

NOTE: If your job does not appear anywhere in the Fiery WebSpooler window, it may 
have already been printed; if so, it will appear in the Job Log. To view the Job Log, 
choose Show Job Log from the Window menu. (For more information on the Job Log, 
see page 8-9.)

If the job does not appear in the Job Log, it may have been moved to the Archive 
window by the operator. The Archive window cannot be viewed with 
Fiery WebSpooler; you must contact the operator or look at the Command 
WorkStation display to check this.

Manipulating job options and job flow

Using the commands in the Job menu, you can alter the destinations, priorities and 
other characteristics of jobs that appear in the Fiery WebSpooler window.

To understand the effect each of these commands has on a job, you need to understand 
the way the Fiery handles PostScript, PCL, and raster data, and how jobs are activated 
or held in the various stages of processing. See Chapter 3 for this background 
information before manipulating jobs with Fiery WebSpooler. Also, the commands in 
the Fiery WebSpooler Job menu have identical counterparts on the Command 
WorkStation. For background and information about these commands, see Chapters 3 
and 4.
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Choose this command 
from the Job menu: To do this: Raster data is:

Delete Job(s) Delete the job(s) from the list Deleted

Cancel Printing Cancel the currently printing job Deleted

Cancel RIPping Cancel the currently processing job Deleted

Duplicate Job(s) Duplicate one or more selected PostScript or 
PCL data jobs in the Spool or Print areas 
(creates a reference to the original job, with the 
same name)

n/a
(The Duplicate command is not available for 
raster jobs)

Rename Rename the job (PostScript or PCL file with or 
without raster)

Unaffected, but associated with the new name

NOTE: If the renamed job is printed, the Job 
Log reflects the job’s original name.

Hold Hold the job in the current place (except for a 
printed job, which is moved to the Spool or 
RIP area)

Held in RIP area indefinitely, if included with 
job

RIP and Hold RIP the job and hold it in the RIP area Held in RIP area indefinitely

Print Print the job in its turn (RIP it first if it does 
not have raster data). Keep the printed job in 
the Print area until the job limit is reached

Temporarily held in RAM until memory is 
needed for another job

Print and Hold
(like the PPD option 
Save Fast Reprint)

Print the job in its turn (RIP it first if it does 
not have raster data)
After printing, hold the PostScript or PCL data 
and the raster in the RIP area

Held in the RIP area indefinitely (saved to 
disk)

Process Next Give top priority to this job
Print the job (or RIP and print) as soon as the 
processor and copier are free, before other 
waiting jobs

Held in RAM after printing (can be selected in 
the Print area while it remains there), or Held 
in RIP area (saved to disk) if destination was 
RIP and Hold

Remove Raster Remove the raster from a job that has raster 
data; leave the PostScript or PCL job in place

Deleted

Override Print Settings Change the print options for the job
(see page 8-6)

Deleted and regenerated, if the newly selected 
options require reRIPping, or reprinted with 
the new settings, if none require reRIPping
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Overriding job option settings

To change the job options of a job, double-click the job line or select the job and 
choose Override Print Settings from the Job menu. If necessary, scroll down to see all 
the various job options.

For PostScript files, you cannot override the Orientation option. For PDF files, you 
can only override the number of copies and the range of pages printed.

Thumbnail A Open the selected held raster data job in the 
Thumbnail A window where you can view a 
full-screen preview of the job, edit the job, or 
merge it with raster data from other jobs 

Changed if job is edited, unaffected if job is 
only viewed

Thumbnail B Open the selected raster data job (not 
necessarily a held job) in the Thumbnail B 
window for viewing or for merging into a job 
in the Thumbnail A window

Unchanged

Choose this command 
from the Job menu: To do this: Raster data is:

Indicates reRIPping is 
required
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NOTE: For some options, changing the setting requires that the job be reRIPped; these 
options show an icon to the left of the option name.

The options you set here are the same ones you set from the Print dialog box when you 
print from an application. For information about setting and overriding these print 
options, see the Printing Guide.

Thumbnails and full-screen previews (DocBuilder)

Like the Command WorkStation, Fiery WebSpooler includes a powerful DocBuilder 
tool that allows you to preview and edit raster data. DocBuilder consists of two 
thumbnail windows and several page-manipulation commands (listed in the Page 
menu). The DocBuilder tool can be used in the following ways:

• In the Thumbnail A window, you can see thumbnails of the currently printing job, 
as it is processed, or of any raster data job.

• From the Thumbnail A window you can open a full-screen preview of a raster file.

• Using the Thumbnail A and Thumbnail B windows together, you can merge raster 
data from more than one file, even if the files were printed from different 
applications on different computer platforms. 

DocBuilder’s merge features eliminate the limitations of particular software 
applications. You can merge raster pages of documents of different types, and even 
different computer operating systems. You can merge color pages from graphics 
programs with text pages from a word processor. 

NOTE: In cases where multiple users are connected to the Fiery via Fiery WebSpooler 
and/or the Command WorkStation, and one user makes changes to a Thumbnail A 
job, not all users may see the results of those changes. If you are unable to view changes 
in a job, or if selecting a Thumbnail window results in a message indicating zero pages, 
then close and relaunch Fiery WebSpooler or the Command WorkStation.
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DocBuilder differences in Fiery WebSpooler

The DocBuilder tool in Fiery WebSpooler functions almost identically to that in the 
Command WorkStation. For detailed information on using DocBuilder, see Chapters 
3 and 4 (for instructions on editing and merging raster files, see “Merging PostScript 
and raster files with DocBuilder Pro” on page 4-15). Though the interfaces are almost 
identical, there are some feature differences:

• The additional features of DocBuilder Pro are not available from Fiery WebSpooler. 
These include Thumbnails of PostScript or PDF jobs in the Spool queue and the 
Imposition feature.

• Thumbnail A right-click commands are not available; instead click on a page to 
select it, and either click the appropriate button in the Thumbnail A window or 
choose the appropriate command from the Page menu.

• Page icons and arrows do not appear when moving page(s) from Thumbnail B to 
Thumbnail A. Instead, a blue outline appears around a Thumbnail A page that is to 
be replaced; and a blue bar appears adjacent to or between Thumbnail A page(s) to 
indicate where the Thumbnail B page(s) are to be inserted.

• The full-screen preview window has a status bar (the Command WorkStation does 
not), the “X” button used to close the full-screen preview is in a different location, 
there are no page advance arrows, and there is no rotate button.

• The Ctrl-Z keyboard shortcut for the Undo command is not available. To undo one 
or more DocBuilder commands, choose Undo from the Page menu.
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Using the Job Log
From Fiery WebSpooler, you can view and print a log of all jobs printed by the Fiery, 
including jobs downloaded with Fiery Downloader. 

NOTE: If you logged in as Administrator, you can delete the Job Log from 
Fiery WebSpooler (see page 8-11). The Job Log is not available if you logged in as 
Guest.

TO DISPLAY, UPDATE, PRINT, AND DELETE SAVE THE JOB LOG:

1. Choose Show Job Log from the Fiery WebSpooler Window menu.

2. Click All or specify a date range.

3. Click OK.
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The Job Log appears in a new browser window.

NOTE: The Delete button appears only if you logged in as Administrator.

The Job Log displays each job and the following information: status, document name, 
user name, date, start time, end time, process time, page description language, file size, 
device, paper size, media, number of originals, number of color pages, number of 
black-and-white pages, total number of pages, Notes1, and Notes2.

The Status column provides the following information about jobs:

OK The job was printed normally.

ERROR An error occurred during processing or printing.

CANCEL The job was canceled before printing was completed.

Update

Print

Delete
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4. To update the Job Log, click the Update button.

5. To print the Job Log, choose Print Job Log from the File menu or click the Print 
button.

The information displayed in the Job Log window prints to the current Fiery. When 
you print the Job Log, totals are printed for all appropriate columns.

6. If you logged in as Administrator, you can choose Delete Job Log from the File 
menu or click the Delete button to clear the Job Log.

The system administrator can also print and clear the Job Log from the Control Panel.

To return to the job list, choose Show Job List from the Window menu.

Fiery Spooler for Mac OS computers
For Mac OS, the Fiery Spooler interface is almost identical to that of 
Fiery WebSpooler (see “Differences between Fiery Spooler for Mac OS and 
Fiery WebSpooler” on page 8-13), and both interfaces are very similar to the job 
management interface of the Command WorkStation. For details on the icons and 
commands in Fiery Spooler (and Fiery WebSpooler) see Chapters 3 and 4.

TO LAUNCH FIERY SPOOLER ON A MAC OS COMPUTER:

1. Double-click the Fiery Spooler icon.

2. Select the Fiery in the Chooser window that appears.

For information on setting up the connection to the server, see Getting Started.
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3. Click OK.

The Fiery Spooler main window appears.

For information on using Fiery Spooler for Mac OS computers, see “Tracking and 
managing jobs with Fiery WebSpooler” on page 8-1 and Chapters 3 and 4.
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Differences between Fiery Spooler for Mac OS and 
Fiery WebSpooler

Though the interfaces for both Fiery Spooler for Mac OS and Fiery WebSpooler are 
almost identical, there are some feature differences.

Connecting to a different Fiery

With Fiery Spooler, you can connect to a different Fiery from within the application 
using the following procedure.

TO CONNECT TO A DIFFERENT FIERY:

1. Choose Open Fiery from the File menu.

2. Select the Fiery in the Chooser window that appears.

For information on setting up the connection to the server, see Getting Started.

3. Click OK.

The Fiery Spooler main window appears.
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This chapter introduces the basic concepts of imposition and can be used as an 
introductory tutorial for imposing a document that will be printed as a book or 
booklet. For more detailed information on the Imposition main window and its 
components, see Chapter 5, “Using Imposition.”

Printing books with the Imposition feature of 
DocBuilder Pro
This section describes the process of transforming an application-specific file into a 
bound book; along the way, concepts and terminology are introduced to help you take 
advantage of all the features of DocBuilder Pro. 

Print engines that image documents on standard letter- or legal-sized paper at high 
speeds are common in office environments. Although the image quality and output 
efficiency of such devices is adequate for correspondence and office memos, they 
cannot image jobs with complex document layouts, or those that require higher 
resolution or a large number of copies. 

Until recently, the only way around these limitations was to use traditional printing 
systems to impose your document—that is, to arrange its pages in the correct order 
and orientation for printing and a variety of binding styles. You might have used a 
service bureau to access high-volume, high-resolution color printers. Today Fiery 
technology teamed up with digital color print engines makes it cost-effective to 
produce short-run, fully-imposed (also called “ganged-up”) documents.

Basics of imposition layout
Commercial offset printers and web presses use wide rolls of paper and large printing 
plates capable of imaging numerous pages on a single sheet. For example, it is common 
for such printers to image up to 32 full-size pages on a single press sheet, a process 
inherently faster than printing a single page at a time. DocBuilder Pro lets you image 
multiple pages on a single sheet, but the output devices it supports are digital color 
print engines, rather than traditional printing presses; in this manual the paper on 
which a job is imaged is referred to as the sheet. 

Appendix A: 
Basics of 
Imposition
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The printed sheet is subsequently folded into something resembling a booklet having 
connected pages. The folded sheet is called a signature, which is then trimmed to the 
finished size.

For pages to appear in normal reading order and position in the final booklet, their 
ordering and positioning on the sheet must differ from the normal book-reading order. 
You can demonstrate this for yourself using an ordinary sheet of paper. 

MODELING AN EIGHT-PAGE BOOKLET:

1. Fold the paper in half horizontally.

Fold the top edge of the sheet down to meet the bottom edge.

2. Fold the paper again vertically. 

Fold the left edge of the sheet over to the right edge. Now you have a miniature version 
of a signature. 
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3. Position the signature with the vertically folded edge to the left and the 
horizontally folded edges across the top.

The paper should now resemble a small eight-page booklet (with the tops of pages 
joined at the fold). 

4. Page through the booklet as if you were reading it, and number each page 
sequentially.

Don’t forget to number the front and back of each page—in general books have 
content on both sides of each page. The front cover of the booklet should be page 1 
and the back cover of the booklet should be page 8. You can also underline each 
number to highlight the page orientation.

NOTE: Printing on both sides of the sheet is called duplex printing; printing on only 
one side of the sheet is called simplex printing. Not all print engines support duplex 
printing; and of those that do, variations in implementation exist. DocBuilder Pro 
supports duplex printing that corresponds to the print options of the output device.

When you unfold the signature, the page numbering should look something like the 
following illustration.

4 5

1 8

6 3

7 2

Front Back
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Notice that:

• The folds subdivide the sheet into areas representing pages in the final booklet.

• Page numbers do not appear in book-reading order.

• Some page numbers are upside down.

Some pages must be printed upside down on the sheet in order for them to appear 
right-side up in the final booklet, and pages must also be printed out of numerical 
sequence on the sheet in order for them to appear in numerical sequence in the final 
booklet.

This process of folding paper and numbering pages to approximate the finished piece 
is called making a folding model, and it’s a common first step in planning a print job. 
The folding model provides valuable information about page placement, which you 
can use to create a plan, or sketch, of how pages are placed on the sheet. This plan is 
called a layout. 

DocBuilder Pro frees you from the tedious and error-prone process of creating accurate 
physical models of the imposed book in order to lay out pages. With DocBuilder Pro, 
you simply open the source file to be imposed and specify how many rows and 
columns of pages to image on a sheet. DocBuilder Pro simplifies this process even 
further by providing predefined layouts for common impositions such as booklets and 
brochures. You can also save your own custom layouts for easy reuse.

Printer’s marks
In addition to specifying the placement of pages on a sheet, the layout also specifies 
how the finished sheet will be cut and folded. For example, the layout specifies whether 
the large finished sheet is folded and cut to create a booklet, or simply folded (and not 
cut) like a map. 

A DocBuilder Pro layout designates the location of folds, cuts, and other special 
elements by means of special markings called printer’s marks, which appear on the 
printed sheet outside the main content area of the job. 

• The job label comprises descriptive text such as the name of the job, a sheet 
identifier, and the date and time the sheet was printed. 
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• The location of a fold is defined by a dotted line called a fold mark; similarly, the 
location of a cut is defined by a solid line called a trim mark. 

• Specialized marks also define the size and locations of margins (space surrounding 
the page’s content area), gutters (space between pages), and bleeds (extensions of 
content beyond a trim mark; used to ensure that printed area extends to the very 
edge of a trimmed page). 

DocBuilder Pro makes it easy to set up gutters and specify a set of printer’s marks to 
image on the finished sheet as illustrated below.

Additional sheets
A book layout must also adjust the placement of pages according to the total number 
of pages in the job. For example, a book is often composed of more pages than can be 
printed on a single sheet. When the number of pages in the book is a multiple of the 
number of pages on a sheet, the same layout plan is used to place pages on additional 
sheets until all of the pages in the book are printed. However, if the total page count is 
not an even multiple of the number of pages in the layout, one signature may be laid 
out to accommodate the discrepancy. 

Job label

Trim marks

Gutter

Margin

Fold mark
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For example, if your layout places 8 pages on a sheet and the total page count in the 
book is 12, one of its signatures holds only 4 content pages, with the rest of the space 
on the sheet blank. If you don’t want blank pages in the middle of the finished book, 
insert blank pages intentionally, for example after cover page, after table of contents, or 
between chapters. To insert blank pages, open the job in the Thumbnail A window, 
right click on the page you want to add blank to (or pull down on Page menu) and 
select insert blank page. 

DocBuilder Pro lets you add blank pages or add, delete, and rearrange pages from 
multiple source documents easily, so you can quickly preview the results of page 
manipulations. 

Binding methods
A book layout also specifies the means by which sheets are gathered and bound. 
Stitching or stapling finished pages across a common center fold, or spine, is called 
saddle stitch binding and the stitched pages are called a saddle. Multiple folded sheets 
can be stitched into the same saddle as a group. Stacking signatures, grinding the 
spines off, and then gluing them together is called perfect binding. You can combine 
saddle stitch and perfect binding methods by stacking two or more groups one on top 
of another on a common fold line and gluing them together; this is called a nested 
saddle. 

The binding method to be used affects the order in which pages are placed on the 
sheet; for example, the page ordering used to perfect bind a book must be different 
from that used to saddle stitch the same job. Thus, the layout must also specify the 
method by which the finished job will be bound. 

Saddle Nested SaddlePerfect
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The choice of a binding method is determined by the job’s size, complexity, and 
budget. Saddle stitch binding is very cost-efficient, but is more suitable for small 
booklets than for large jobs. (A rule of thumb says that saddle stitch binding works best 
for booklets or brochures with a maximum of 88 pages.) Conversely, perfect binding is 
more expensive but more suitable for larger jobs.

DocBuilder Pro reorders imposed pages automatically according to your choice of 
binding method, which can save a significant amount of time and effort. Consider, for 
example, what must be done when a book that was to be saddle stitched exceeds the 
bindery’s maximum page count and must be reimposed as a perfect-bound book. To 
redo the imposition by traditional means would be labor-intensive; with 
DocBuilder Pro, it takes only moments.

Shingling and creep

All books and brochures use a sheet that is folded to create separate page areas. Because 
the sheet itself has some thickness, each fold causes a very small incremental shift in the 
location of the edge of each page relative to the others. The result is that the edges of 
pages furthest from the saddle’s innermost fold seem to move away from the edges of 
pages closest to the innermost fold. As the number of pages in the saddle increases, so 
does the amount of this shift, which is known as shingling. To counteract the effects of 
shingling (illustrated in an exaggerated manner below), the bindery trims the edges of 
the finished book to a common edge.

Trimming the bound pages resolves only half of the problem, however—as the edges of 
pages move, so do the content areas imaged on them. The apparent shift of content 
area caused by folding a sheet multiple times is known as creep or binder’s creep. The 
effect of creep is that the content area of pages closer to the innermost fold in a saddle 
appear to move towards the outer margins of the page.

Shingling
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Creep becomes more noticeable as the number of groups in a saddle increases, and its 
effect is most noticeable on pages farthest from the center fold of the saddle. 
Consequently, a book layout must also specify the number of groups in each saddle 
because the number of groups in each saddle affects the amount of creep needs to be 
accounted for.

Compensating for creep is tedious, exacting work which DocBuilder Pro does for you 
automatically when you change any aspect of the imposed job that is affected by creep. 

Gang-up printing
It’s clear that a layout is essential to define the elements of complex print jobs such as 
booklets and books, but it can also be useful for smaller jobs. Consider, for example, 
how you might approach the task of printing business cards. It is slow, wasteful, and 
expensive to print a single business card per sheet, when you can repeat the image of 
the business card until the entire sheet is filled. This printing technique is known as 
Gang Up Repeat because the image is repeated in each page area, or step, on the sheet. 
After printing, the sheet is cut apart to produce individual cards. 

Creep

Gang Up Repeat layout
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This job can be made even more efficient by eliminating the gutters between cards, 
allowing you to reduce significantly the number of cuts required to separate each card 
from its neighbor. Defining zero-width gutters on a shared cut line in this manner is 
called using a common blade for those cuts. 

If you need to print business cards for several different clients, you could perform a 
Gang Up Repeat printing job for each, but you might still wind up wasting paper and 
time if the jobs don’t fit easily into a simple multiple of sheets. A more efficient 
approach is to print several jobs on a single sheet, and then print that sheet as many 
times as required. The technique of printing multiple jobs on the same sheet is known 
as Gang Up Unique. DocBuilder Pro provides both Gang Up Repeat and Gang Up 
Unique.

Gang Up Unique layout
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This appendix gives descriptions of the built-in templates that DocBuilder Pro 
provides. 

1-Up Full Bleed
The 1-Up Full Bleed layout is used to print one page per sheet. The printer’s marks 
show where to cut the paper so that the color content extends to the edge of the paper. 
The following settings are applied for this layout:

• Bleeds

• Printer’s Marks (trim marks and job label only)

• Scale to Fit

• Gang Up Unique

There are no page number restrictions for the 1-Up Full Bleed layout.

Appendix B: 
Templates
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2-Up Perfect
The 2-Up Perfect layout is used to create signatures for a perfect bound book. Each 
sheet is folded once and stacked on top of one another. For more information on 
binding methods, see page A-6.

The following settings are applied for this layout:

• Duplex

• Bleeds

• Printer’s Marks (fold marks, trim marks, and job label)

• Scale to Fit

• Binding Perfect



BB-3 Templates
The 2-Up Perfect layout should be used with jobs that have multiples of four pages, 
but it can be used with jobs that have any number of pages. Additional blank pages will 
be added if necessary. Pages will be ordered in groups of four so that when folded each 
sheet will have four sequential pages. For example:

• 4 pages

• 8 pages

NOTE: The Creep Adjustment option has no effect on this template.

4 1 2 3

Sheet 1, 
front side

Sheet 1, 
back side

4 1 2 3

Sheet 1, 
front side

Sheet 1, 
back side

8 5 6 7

Sheet 2, 
front side

Sheet 2, 
back side
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2-Up Saddle
The 2-Up Saddle layout is used to create signatures for a saddle bound book. All of the 
sheets are folded together, one inside the other. For more information on binding 
methods, see page A-6.

The following settings are applied for this layout:

• Duplex

• Bleeds

• Printer’s Marks (fold marks, trim marks, and job label)

• Scale to Fit

• Binding Saddle
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The 2-Up Saddle layout should be used with jobs that have multiples of four pages, 
but it can be used with jobs that have any number of pages. Additional blank pages will 
be added if necessary. Pages will be ordered so that when sheets are folded and stitched 
together into signatures, the pages will be sequential. For example:

• 4 pages

• 8 pages

4 1 2 3

Sheet 1, 
front side

Sheet 1, 
back side

8 1 2 7

Sheet 1, 
front side

Sheet 1, 
back side

6 3 4 5

Sheet 2, 
front side

Sheet 2, 
back side
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3-Up Trifold Brochure
The 3-Up Trifold Brochure layout consists of a single sheet folded into three sections. 
Although the three sections are the same width, the space between each section varies 
so that the leftmost panel can be folded over the other two panels.

The following settings are applied for this layout:

• Duplex

• Printer’s Marks (trim marks and job label only)

• Scale to Fit

• Gang Up Unique
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The 3-Up Trifold Brochure layout can be used only with jobs that have six pages. If the 
job contains more or less than six pages, an error message will appear. The pages will be 
ordered as follows:

The 3 Up Trifold Brochure is usually folded as illustrated below.

3 6 2 4

Sheet 1, 
front side

Sheet 1, 
back side

1 5
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4-Up Gate Fold
The 4-Up Gate Fold layout is used most often in the case of a four panel brochure. The 
finished brochure unfolds to double and then four times the original size.

The following settings are applied for this layout:

• Duplex

• Printer’s Marks (trim marks and job label only)

• Scale to Fit

• Gang Up Unique
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The 4-Up Gate Fold layout can be used only with jobs that have eight pages. If the job 
contains more or less than eight pages, an error message will appear. The pages will be 
ordered as follows:

The 4-Up Gate Fold is usually folded as illustrated below.

3 8 4 5

Sheet 1, 
front side

Sheet 1, 
back side

1 62 7
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4-Up Head to Head
The 4-Up Head to Head layout is used to create booklets from a layout of four pages 
on each side of the printed sheet. By rotating the two topmost pages, the signature can 
be folded both horizontally and vertically, and trimmed. The finished booklet will have 
all pages in the correct order and rotation.

The following settings are applied for this layout:

• Duplex

• Bleeds

• Printer’s Marks (fold marks, trim marks, and job label)

• Scale to Fit

• Binding Saddle

The 4-Up Head to Head layout should be used with jobs that have multiples of eight 
pages, but it can be used with jobs that have any number of pages. Additional blank 
pages will be added if necessary. Pages will be ordered so that when sheets are folded 
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with two folds at 90º, trimmed, and stitched together into signatures, the pages will be 
sequential. Note that although this layout requires two folds, the template applies a 
fold mark on the spine fold only. For example:

• 8 pages

• 16 pages

The 4-Up Head to Head is usually folded as illustrated below.

8 1 2 7

Sheet 1, 
front side

Sheet 1, 
back side

6345

16 1 2 15

Sheet 1, 
front side

Sheet 1, 
back side

14 3 4 13

Sheet 2, 
front side

Sheet 2, 
back side

12561110789
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4-Up Z-Fold
The 4-Up Z-Fold layout allows many panels to be folded on top of one another 
without stressing the folded spine. The most common example is a road map.

The following settings are applied for this layout:

• Duplex

• Printer’s Marks (trim marks and job label only)

• Scale to Fit

• Gang Up Unique
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The 4-Up Z-Fold layout can be used only with jobs that have eight pages. If the job 
contains more or less than eight pages, an error message will appear. The pages will be 
ordered as follows:

The 4-Up Z-Fold is usually folded as illustrated below.

1 2 5 6

Sheet 1, 
front side

Sheet 1, 
back side

3 74 8
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This section lists error messages you might see, and provides some troubleshooting 
guidelines should a problem arise with the Fiery or the Command WorkStation. If you 
are unable to resolve a problem after referring to this chapter, contact your authorized 
service/support center. 

Error messages
Error messages can result from problems with the print job, the Fiery, the Command 
WorkStation, or the DocuColor 12. Some of the most common error conditions are 
listed here.

A DocuColor 12 error message sometimes remains displayed on the Command 
WorkStation even after you have resolved the error. A time lag in communicating the 
resolution of the error to the Command WorkStation may lead you to believe the error 
has not been resolved. However, printing will resume and the Command WorkStation 
display will be updated after a short delay.

When an error interferes with printing, you will see a message at the Command 
WorkStation. The status bar that displays the message indicates the process where the 
error occurred. Following are the messages (listed in alphabetical order), with the 
appropriate corrective action for each one. You can cancel the pending print job while 
you attend to the error condition. A few normal status messages are included in this list 
in case they cause concern.

Fiery message: Corrective action/additional information:

Black dry ink empty Add Black toner.

Check power & cable There is a problem with the print engine power or cable 
connection. First check to make sure that the print engine is 
turned on. There may also be a problem with the cable connection 
between the Fiery and the print engine. Make sure that the cable 
has not come loose. The Fiery will resume printing when the cable 
is securely connected to both the Fiery and the print engine.

Appendix C: 
Troubleshooting
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Check scanner power 
& cable

There is a problem with the scanner power or cable connection. 
First check to make sure that the scanner is turned on. There may 
also be a problem with the cable connection between the Fiery and 
the scanner. Make sure that the cable has not come loose. The 
Fiery will resume scanning when the cable is securely connected to 
both the Fiery and the scanner.

Cleaning auger full The copier cleaning auger bottle is full. Replace the container with 
a new one according to the instructions in your copier manual. 
The Fiery will resume printing when you have replaced the 
cleaning auger bottle.

Cleaning web empty The copier’s fuser web is used up. Printing will resume when it is 
replaced.

Cleaning web 
misplaced

The copier’s fuser web in not correctly placed in the copier. Check 
the fuser web and reinstall it as necessary.

Close door One of the doors on the copier is open. Close the specified door to 
resume printing.

Communication fail-
ure while printing. 
Please resubmit job.

An error occurred with the copier. You must resubmit the job for 
printing.

Copier busy The Fiery has received a print job, but the copier is busy. The job 
will print when the copier resumes printing.

Copier in Energy Save 
Mode

The copier is in Energy Save Mode. You must wait for the copier 
to warm up before you can print.

Copier offline The Suspend Printing option has been selected from the 
Functions menu. Press Resume Printing in the Functions menu to 
reconnect the Fiery to the copier.

Cyan dry ink empty Add Cyan toner.

Dispenser Black
broken.

There is a problem with the black toner dispenser. Make sure that 
it is present and there is no mechanical problem.

Dispenser Cyan 
broken.

There is a problem with the cyan toner dispenser. Make sure that it 
is present and there is no mechanical problem.

Dispenser Magenta 
broken.

There is a problem with the magenta toner dispenser. Make sure 
that it is present and there is no mechanical problem.

Fiery message: Corrective action/additional information:
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Dispenser Yellow 
broken.

There is a problem with the yellow toner dispenser. Make sure that 
it is present and there is no mechanical problem.

Fuser oil empty The copier does not have any fuser oil. Printing will resume when 
you add fuser oil.

Idle This is a normal status message (LCD is solid green). The Fiery is 
idle, waiting for the next job.

Load ___ in any tray The copier is not loaded with the paper size specified. The Fiery 
will print when the required paper is loading into any tray.

Load ___ in tray ___ The copier’s specified tray (1 through 6) is not loaded with the 
paper size specified. The Fiery will print when the named tray is 
loaded with the required paper.

Load ___ transp 
in tray 5

The copier’s tray 5 is not loaded with the transparency size 
specified. The Fiery will print when the tray is loaded with the 
required transparency.

Load staples The copier is out of staples. The Fiery will resume printing when 
staples have been added.

Magenta dry ink
empty

Add Magenta toner.

Output bin __ broken. There is a problem with the named output bin. Make sure that it is 
present and there is no mechanical problem.

Output bin __ full. 
Remove paper.

The specified output bin is full. The Fiery will print when all paper 
has been removed from the bin.

Paper jam There is a paper jam in the copier. Open the copier doors and 
check the locations indicated on the copier display. The Fiery will 
resume printing when you have cleared the paper jam and closed 
the copier doors.

Platen Scan in 
progress

The copier is completing a scan It will be ready for printing in a 
few minutes.

Print/Copy Cartrdg. 
misplaced

The print/copy cartridge is not correctly placed in the copier. 
Check the cartridge and reinstall it as necessary.

Print/Copy Cartrdg. 
type mismatched

The print/copy cartridge installed is not the correct cartridge for 
this copier. Remove the cartridge and check your copier manual 
for specifications on the correct cartridge to install.

Fiery message: Corrective action/additional information:
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Printing . . . This is a normal status message indicating that printing is in 
progress.

Push in paper tray __ One of the trays on the copier is open. Close the tray to resume 
printing.

Ready within 1 minute This is a normal status message. The print engine is powering up. 
It will be ready for printing in a minute.

Ready within ___ 
minutes

This is a normal status message. The print engine is powering up. 
It will be ready for printing in a few minutes.

Replace Print/Copy 
Cartridge

The print/copy cartridge needs to be replaced. Install a new 
cartridge to resume printing.

Run setup and enter
correct security key

This message is displayed if your model requires that you enter a 
security code.

Selected paper size 
not available

You have selected a paper size that is not available with this copier. 
Select a different paper size to continue printing.

Stacker bin broken. There is a problem with the stacker bin. Make sure that it is 
present and there is no mechanical problem.

Stacker bin full. 
Remove paper.

The stacker is full. You must remove the paper in the stacker before 
continuing the job.

Stapler cartridge is 
not in position.

There is a problem with the stapler cartridge. Make sure that it is 
present and there is no mechanical problem.

Stapler disabled. There is a problem with the stapler. Make sure that it is present 
and there is no mechanical problem.

Stapler is broken. There is a problem with the stapler. Make sure that it is present 
and there is no mechanical problem.

Tray __ broken. There is a problem with the named tray. Make sure that it is 
present and there is no mechanical problem.

Trickle bottle full The copier trickle bottle is full. Replace the container with a new 
one according to the instructions in your copier manual. The Fiery 
will resume printing when you have replaced the trickle bottle.

Trying to connect
Please wait . . .

When the Fiery is not communicating with the printer, it displays 
this message while it tries to connect. An error may have occurred 
with the copier. See the copier message panel for information.

Fiery message: Corrective action/additional information:
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Maintaining optimal system performance
The Fiery does not require maintenance. Beyond the routine requirements of servicing 
and maintaining the print engine and replenishing consumables there are a few things 
you can do to improve the overall performance of your system:

• Reduce unnecessary two-way communication.

If users notice that the server is frequently too busy to receive jobs, it may be because 
several users are running utilities that are updated often. Large numbers of remote 
users running Fiery Downloader or Fiery WebTools may have a significant effect on 
Fiery performance.

• Schedule the printing workload by checking job ticket information before printing. 
Print jobs with the same output and paper specifications together to minimize paper 
changes. Also, print routine jobs while you prepare to print jobs with special 
instructions or special media.

• Reduce unnecessary server connections at the Command WorkStation. If you use a 
second or third Fiery server on an occasional basis, performance will be improved if 
you log off when you are not using it.

• Avoid printing with the server Disk full  warning. 

If you see this warning, delete jobs from the Queues or Archive windows that have 
been held for a long time and are not likely to be needed. Avoid this condition by 
deleting old jobs on a regular basis. The date associated with a job is the original date 
it was sent. As a last resort, you can use the Clear Server or the Clear command.

Turn copier power off
and on

Turn off the copier power switch, then turn it on again.

Warming Up . . . This is a normal status message. The print engine is powering up. 
It will be ready for printing in a few minutes.

Waste dry ink full The copier waste toner container is full of used toner. Replace the 
container with a new one according to the instructions in your 
copier manual. The Fiery will resume printing when you have 
replaced the waste toner container.

Yellow dry ink empty Add Yellow toner.

Fiery message: Corrective action/additional information:
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Troubleshooting
In case of problems, and before you call for service, check the guidelines in this section. 
If you are unable to resolve the problem, make a note of the error condition and 
contact your authorized service/support center.

Command WorkStation hangs
If the Command WorkStation windows do not update, try clicking the Log in/out 
slider and logging out, and then exiting the Command WorkStation. Restart the 
Command WorkStation application or restart the computer.

If the Command WorkStation windows do not update, or no jobs are displayed, and 
the mouse has no effect (you cannot select a job or a window, use a right mouse 
command, or select a menu item) the Fiery is down or communication over the 
network has failed.

To force an exit from the Command WorkStation application, press Ctrl-Alt-Delete , 
and with the Command WorkStation selected, click End Task. At the Fiery, disconnect 
and reconnect the network cable, and try printing a Test Page or Configuration page. If 
that fails, reboot the server.

If the Fiery Control Panel does not respond to the Menu button, press the Reset 
button, turn off the server and turn it on again. When it reaches Idle, restart the 
Command WorkStation application.

Command WorkStation fails to connect to a Fiery
If a remote Command WorkStation cannot connect to a server that was connected 
previously, you may need to reconfigure the connection.

1. If you can, choose Exit from the Command WorkStation File menu.

2. In the C:\Windows folder, find the Efinl.ini file and move it out of the C:\Windows 
folder to another folder. 

If the Efinl.ini file contains a limited amount of configuration information that is easily 
recreated (i.e., information for only one or two servers), you can delete the file 
altogether. A new Efinl.ini file will be created in the C:\Windows folder when you 
reconfigure the connection.
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If the Efinl.ini file contains configuration information for several servers, or 
information that is not readily recreated, keep the Efinl.ini file as a backup.

3. Print a Configuration page.

You will use the information on this page to configure the connection to the server.

4. Launch the Command WorkStation application.

5. When you are prompted to configure a server connection, click OK. 

Use the instructions in Getting Started to configure the connection.

6. If you still cannot connect to the Fiery, the administrator should reinstall Command 
WorkStation software. 

See Getting Started for details.

Unexpected printing results

If this happens: This is the problem:

A cover page is not printed 
when you reprint a saved 
raster job.

The cover page identifies the originator of the job and the 
time the job was sent. Time stamp and user information on 
the cover page of a reprinted job are not meaningful.

The job settings are not 
carried out as you expected.

If the user printed from Mac OS, there may be two 
conflicting print settings. You can check the job properties by 
double-clicking the job. See the Printing Guide for a table of 
job properties and conflicting properties. Notify the users of 
these conflicts so they can avoid them in the future.
If you expected the settings you see in the Properties window, 
be aware that the Copies field does not currently reflect user 
settings, and that Page Range and Scale percent are All and 
100%, respectively, unless they were changed after being sent 
for printing.

The job doesn’t print. Some printing errors may be displayed in the Print status bar. 
When the job is in the Printed queue, jobs that had a 
PostScript error are displayed in a light red job row. Double-
click anywhere in the row to see the error message.
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Clearing the server
Clearing the server is an Administrator option that can be used as a last resort if a job 
persists in the system and prevents printing despite attempts to cancel or delete it. 
Clearing the server deletes all jobs currently saved on the server in any queue, all locally 
archived jobs, and all FreeForm master jobs. It also clears the Job Log, the index of 
archived jobs, and the index of FreeForm masters.

Before clearing the server, export the Job Log if you haven’t recorded the information 
in it. If you can, notify users that you will clear their jobs from the server so they can 
back them up and resend them when the server is back in operation.

You can clear the server from the Control Panel (see page 1-6) or by using the Clear 
command from the Command WorkStation (see page 3-12).

Users are unable to connect to the DocuColor 12
If users are unable to connect to the DocuColor 12, or are unable to find the 
DocuColor 12 from their workstations, the network administrator may need to 
troubleshoot their network connections, and check settings on the servers they use for 
printing. If settings have changed, it may be necessary to reconfigure the Fiery.

For example, if print servers or print queues on a Novell server are renamed or deleted, 
or if accounts or permissions are changed, the Fiery administrator may have to edit 
settings or enter new settings in IPX (Novell) Setup to reflect the new configuration.

There are font errors. If user-specified fonts that are not resident on the Fiery are 
not printing correctly in PostScript files that are downloaded 
by users, request that they embed the fonts in the PostScript 
file or print directly from their application. When users print 
from their applications, if special fonts are not downloaded 
automatically, they should be downloaded directly to the 
Fiery with Fiery Downloader. This can be done by the user or 
by the operator, provided the Direct connection is enabled. 
For information about Fiery Downloader, see the Printing 
Guide.

If this happens: This is the problem:
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If users cannot connect to the DocuColor 12 with Fiery Downloader from 
Windows 95/98 or Windows NT 4.0, you may need to reconfigure the utility’s 
connection to the server. See Getting Started for details.

Mac OS users may fail to see the DocuColor 12 if a network administrator has 
assigned it to a different zone, or has added zones where previously there were none.

If you have configured the Fiery and set up client computers and network servers 
according to guidelines in the Configuration Guide and Getting Started, try printing a 
Test Page (at the Command WorkStation, choose Print Pages from the File menu).

If you are able to print the test page but still can’t print a file from a remote computer, 
contact the system administrator to troubleshoot the network connection.

If you are unable to connect, and you cannot print the Test Page, check the 
DocuColor 12’s touch panel display.

Setup error messages
For information on Setup error messages, see the Configuration Guide.

If this happens: Try this:

It displays a diagnostic or 
error message.

Take the appropriate corrective action, as described in the 
DocuColor 12 manual or in the section “Error messages” on 
page C-1.

The display is completely 
blank.

Check the DocuColor 12’s Standby function. If the 
DocuColor 12 is in Standby mode, press the Standby key to 
see any messages on the display.

The DocuColor 12 is not 
in Standby mode.

The DocuColor 12’s Automatic Power-Off function may 
have shut down the DocuColor 12. 
Turn the DocuColor 12 on, and then try printing a Test Page 
again when the DocuColor 12 has warmed up.

You still cannot print a 
Test Page.

Make a copy. If you can make a copy, restart the Fiery, and 
when you see Idle on the status line of the Fiery display, try 
printing a Test Page again. If the Test Page still fails to print, 
contact your authorized service/support center.
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AutoCal error messages
AutoCal error messages can result from problems during the AutoCal procedure.

Fiery message: Additional information:

Error 5 The calibration file cannot be opened.

Error 6 The calibration file was not read correctly.

Error 8 The measurement page did not scan properly, either because it is 
crooked or the data is corrupted.

Error 11 The color strips on the measurement page are inconsistent.

Error 12 The DocuColor 12 model being used is not supported.

Error 20 The measurement page cannot be scanned because the dots per inch 
(dpi) are incorrect.

Error 102 The grayscale strip is crooked or is positioned incorrectly.

Error 103 The grayscale strip is positioned too far to the left or to the right of the 
measurement page.

Error 104 The grayscale strip is positioned too far above the measurement page.

Error 111 The grayscale strip could not be found; either reposition the strip 
correctly or position it vertically.
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A
About command 3-13
access

levels xvii, 3-6
restricting xvii

Acrobat Exchange, touch-up tool 
problems 6-15

active jobs 3-20
activity light

Control Panel 1-2
FieryBar 2-2

adjusting columns (Queues window) 3-16
Administrator password xvii, 1-7, 3-1, 3-7
Adobe Photoshop,  see Photoshop
Alert Status screen 1-3
animation, see status bars
applying templates 5-9
Archive command 3-11, 3-26, 4-32
archived jobs, filtering 3-28
Archive window

adjusting column width 3-29, 3-32
changing displayed headers 3-28
deleting held jobs C-5
exporting job list 3-29
features 3-28, 3-29
Filter 3-36
job icons 3-27
routing jobs 3-28
sorting jobs 3-28

archiving a job 3-19, 3-26

B
binder’s creep

compensating for automatically 6-8
effects A-7
groups 6-9
sheet thickness 6-3

binding offset 6-15

binding options 6-8
binding styles

nested saddle 6-9, A-6
perfect 6-8, A-6
saddle stitch 6-8, A-6

bleeds 6-6, A-5
broken LCD xviii
buttons, Control Panel 1-2

C
calibration from the Control Panel 1-6
Cancel Job

from the Control Panel during 
printing 1-3

from the Control Panel during 
RIPping 1-3

Cancel Print command, on FieryBar 2-3
Cancel Printing command

from Command WorkStation 3-12, 
4-11

from Fiery WebSpooler 8-5
Cancel RIP command, on FieryBar 2-3
Cancel RIPping command

from Command WorkStation 3-12, 
4-11

from Fiery WebSpooler 8-5
Change (Administrator) Password 

option 1-8
Clear command

archived jobs 3-27, C-8
FreeForm master jobs 3-31
from Command WorkStation 3-12, 

4-37
Job Log 3-35

Clear Job Log command 3-12
Clear Server command

archived jobs 3-27
FreeForm master jobs 3-31
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from Control Panel 1-6
Job Log 3-35
on FieryBar 2-3

clipping icon 6-4, 6-7
clipping indicators

layout mode 6-7
preview mode 6-7

clipping views 6-7
collate and cut finishing 6-9
Color Charts 1-5, 4-7
Color Setup option 1-8
ColorWise Pro Tools command, on 

FieryBar 2-2
column width, adjusting 3-15
Command WorkStation

Archive window 3-27
command on FieryBar 2-2
display, described 3-7
FreeForm window 3-29
introduction to 3-1
Job Log window 3-34
logging in to server 3-6
main window, parts of 3-7
menus 3-10
starting 3-4
troubleshooting C-6, C-7

Configuration page
printing from the Command 

WorkStation 4-6
printing from the Control Panel 1-5

connection to server, configuring 3-5
Control Panel

activity light 1-2, 1-4
buttons 1-2
down button 1-2
Functions menu 1-5
line selection buttons 1-2
Menu button 1-2
status screens 1-3
up button 1-2

Control Panel map
printing from the Command 

WorkStation 4-7
printing from the Control Panel 1-5

Create Master option 4-25
creep

compensating for automatically 6-8
effects A-7
groups 6-9
sheet thickness 6-3

customizing printer settings 3-10
custom templates 6-14

D
date 6-6
Define Marks dialog box 6-6
Delete (job) command 3-10
Delete (page) command 3-12
Delete command 3-24, 4-16, 4-17
Delete Job command (Fiery 

WebSpooler) 8-5
Delete Template icon 6-15
deleting print jobs 3-10
differences

between DocBuilder for Fiery 
WebSpooler and for the 
CommandWorkStation 8-8

between Fiery Spooler for Mac OS and 
Fiery WebSpooler 8-13

Direct connection 3-21, 4-29, C-8
disk space used 3-15
display window 1-3
DocBuilder

Delete command 4-16, 4-17
Duplicate command 4-16, 4-17
editing options 4-16, 4-17
Imposition feature 5-1
Insert blank page command 4-17
merging two files 4-19
Open Preview command 4-17
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page manipulations 4-15
Preview command 4-17

DocBuilder differences 8-8
down button 1-2
Download command 3-11, 3-25, 4-29
downloading files and fonts 4-26
Duplex Alignment option 3-12
duplexing 6-3
Duplex menu 6-3
duplex printing

defined A-3
enabling 6-3
print engines A-3
print options A-3

Duplicate (job) command 3-10
Duplicate (page) command 3-12, 4-16, 4-17
Duplicate Job command (Fiery 

WebSpooler) 8-5

E
Efinl.ini file C-6
Enable Animation 4-5
Enable Popup Help 4-5
error display 3-18
error messages

AutoCal C-10
during Setup C-9
general C-1 to C-5

Exit command 3-10
Exit Setup option 1-7
Export command 3-13
exporting archived job list 3-29
exporting FreeForm job list 3-32

F
F7 key 4-11
F8 key 4-11
FieryBar

activity light 2-2
commands 2-2
status 2-1

Fiery Spooler for Mac OS
differences from Fiery WebSpooler 8-13
interface 8-1

Fiery WebSpooler
accessing 8-2
Cancel Printing command 8-5
Cancel RIPping command 8-5
Delete Job(s) command 8-5
functions available with 8-2
Guest (view-only) privileges 8-2
Hold command 8-5
Job menu 8-4
Operator password 8-2
overview 7-2
Print and Hold command 8-5
Print command 8-5
Process Next command 8-5
raster data 8-5
Remove Raster command 8-5
Rename command 8-5
RIP and Hold command 8-5
RIPped jobs 8-3
status bars 8-3
window 8-3

Fiery WebTools
accessing 7-3
home page 7-3
Installer 7-2
overview 7-1
passwords 7-1
Status 7-2
WebDownloader 7-2
WebLink 7-2
WebSetup 7-2
WebSpooler 7-2

File management tips 6-16
File menu commands 3-10
files, temporary 6-16, 6-17
Filter 3-36
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Filter command
Archive window 3-28
FreeForm window 3-31
from Command WorkStation 3-13

Finished Height field 6-8
finished page size 6-7
Finished Width field 6-8
Finishing area 6-8
Fit Page command 5-7
folding model

creating A-2
defined A-4

Fold Marks 6-6, A-5
fonts

Adobe Type 1 4-26
deleting 4-30
displaying font list 4-30
downloading 4-26, 4-30, C-8
managing 4-29 to 4-30
printer fonts on server 1-5, 4-30
printing font list 1-5, 4-7, 4-30
TrueType 4-26

Font Substitution Table 4-26
FreeForm

master jobs, filtering 3-31
master jobs, job commands for 3-32
overview 3-29
printing variable data documents 4-25

FreeForm window
changing displayed headers 3-31
exporting job list 3-32
features 3-31, 3-32
Filter 3-31, 3-36
sorting jobs 3-31

Functions menu, Control Panel 1-4, 1-5

G
gang printing

enabling 6-9
Repeat option 6-9
suggested uses 6-9
Unique option 6-10

Gang Up 6-9
Gang Up Repeat 6-9, A-8
Gang Up Unique 6-10, A-9
General Setup option 2-4
Go To Sheet dialog box 5-8
group

binder’s creep 6-9
defined 6-9, A-6

Groups field 6-9
Guest access xviii, 3-7
gutters

defined A-5
defining size 6-13
location of 6-13
perfect binding 6-13
saddle-stitched binding 6-13

H
headers

Job Log window 3-35
Queues window 3-15, 4-4

held jobs 3-20, 3-22
Help

Command WorkStation 
information 3-13

Command WorkStation preferences 4-5
menu commands 3-13

Hide FieryBar command, on FieryBar 2-3
Hold command 3-10, 3-24, 8-5
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I
icons

Archive window 3-27
clipping 6-4, 6-7
Delete Template 6-15
FreeForm window 3-30
Job Log window 3-35
Print area 3-23
RIP area 3-22
Save Template 6-14
Spool area 3-20

Import command 3-11, 3-26, 4-34
Impose command 3-11, 3-25
imposing jobs 5-1
imposition

page reordering 6-11
saving settings as template 6-14

imposition data and temporary files 6-17
imposition settings 6-14
imposition window

Binding 6-8
clipping indicator 6-7
Columns menu 6-5
controls 6-1
Creep Adjustment menu 6-3
Finishing area 6-8
layout mode 5-5
navigating 5-4
opening 5-1
Orientation menu 6-3
preview mode 5-5
Printer’s Marks 6-5
printer’s spread 5-3
reader’s spread 5-3
reordering pages 6-11
rows menu 6-4
Scaling area 6-6
settings panel, displaying 6-1
size menu 6-2
template menu 5-9
view modes 5-5, 5-6

inches, abbreviation and keyboard 
shortcut 6-2

Info Status screen 1-4
Insert blank page command 4-17
Installer WebTool, see Fiery WebTools
Instructions field 4-3, 4-4, 4-25

J
job

active 3-20
areas 3-3
canceling 4-11
defined xv
deleting 3-24
environment xvii
flow 3-16
flow diagram 3-20
flow scenarios 4-8
held 3-20
imposing 5-1
imposition data 6-17
limit 3-23
order of display 3-20
overrides 4-23, 8-6
previewing 4-17
remove raster and reRIP 3-22, 3-30
saving imposed 5-9, 5-10
temporary files 6-17

job icons
Archive window 3-27
Fiery WebSpooler 8-3
FreeForm window 3-30
Print area 3-23
RIP area 3-22
Spool area 3-20

Job Label
date 6-6
defined 6-6, A-4
job name 6-6
sheet information 6-6
time 6-6
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Job Log
clearing 3-36, 4-35
deleting 3-36, 4-35
described 3-34
displaying 4-35, 8-9
exporting to a file 3-35, 4-35
Filter 3-36
printing automatically 3-36
printing from the Command 

WorkStation 4-7, 4-35
printing from the Control Panel 1-5, 

4-7
specifying a date range 3-35
updating the display 3-35, 4-35
using (from Fiery WebSpooler) 8-9
viewing printed jobs 8-4

Job Log Setup option 1-8
Job menu commands 3-10, 8-4
job name 6-6
Jobs Saved in Printed Queue 3-23
job ticket information 3-15, 4-4, C-5

L
landscape sheet orientation 6-3
layout

bleeds 6-6
defined 6-4, A-4
maximum number of pages 6-4
rows in 6-4, 6-5

layout mode
characteristics 5-6
clipping indicators 6-7
defined 5-5
reordering pages 6-11
Zoom tool disabled 5-6

layout view 6-11
LCD xviii
line selection buttons 1-2
load balancing between servers 4-30
logging in to a server 3-6
Log in/out slider 3-6, 3-15, C-6

Log Off Windows command, on 
FieryBar 2-3

Log out command 3-13, 4-37

M
Manage Color command 4-37
Manage Color option 3-12
Manage Fonts command 3-12, 4-29, 4-37
margins 6-13, A-5
masters for variable data jobs 3-29
memory

in use 3-15
total 3-15

Menu button 1-2
menus

Columns 6-5
Command WorkStation 3-10
Creep Adjustment 6-3
Duplex 6-3
File 3-10
Help 3-13
Job 3-10, 5-1
Orientation 6-3
Rows 6-4, 6-5
Server 3-12
Sheet 5-5
Size 6-2
Template 5-9
View 5-5, 5-7
Window 3-13

millimeters 6-2
multiple servers, balancing load 

between 4-30

N
nested saddle 6-9, A-6
Network Setup option 1-7, 2-4
Notes fields 4-2, 4-3, 4-4, 4-25
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O
Operator password xvii, 3-7, 7-1, 8-2
Orientation menu 6-3
original page size 6-7
Override Print Settings command 8-5

P
page

finished size 6-7
interaction of scaling values 6-8
maximum number in layout 6-4
numbers in layout view 6-11
original size 6-7
reordering automatically A-7
reordering on sheet 6-11
rotating 6-12
viewing individual 5-6

page numbers 6-11
PANTONE 1-5, 4-7
passwords

Administrator xvii, 3-7
Change (Administrator) Password 

option 1-8
for Command WorkStation access 3-1
Operator xvii, 3-7, 7-1, 8-2

PCL (Printer Control Language) xv
PDF data xv, 3-3
PDF files, downloading 4-28
perfect binding

defined 6-8, A-6
groups in 6-9
gutters 6-13

performance, optimizing C-5
permissions xvii, 3-1
Photoshop, transfer functions 4-29
points 6-2
PostScript

defined xv
icon 3-20
RIP xv, 3-17

PostScript data xv, 3-3

PostScript Setup option, see  PS Setup option
power switch 1-6
Preferences dialog box, commands 3-10, 4-5
Preview command 3-12, 4-17
previewing print jobs 4-14
preview mode

characteristics 5-6
clipping icon 6-7
defined 5-5

Print and Hold command 3-10, 3-25, 8-5
Print area 3-3, 3-23
Print command 3-10, 3-13, 3-24, 8-5
Printed queue 3-4, 3-23, 8-3
print engines and duplex printing A-3
printer (job) icon 3-20
Printer Control Language (PCL) xv
printer fonts, see fonts
printer settings, overriding 3-10
Printer Setup option 1-7, 2-4
printer’s marks

bleeds A-5
date 6-6
defining 6-5
disabling 6-6
enabling 6-5
Fold Marks 6-6, A-5
gutters A-5
Job Label 6-6
job label A-4
job name 6-6
margins A-5
overview A-4
sheet information 6-6
time 6-6
Trim Marks 6-6, A-5

printer’s spread 5-3
printing

Configuration page 1-5, 4-6
defined xv, 3-17
error 3-23
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font list 1-5, 4-7
server information pages 1-5, 4-6

printing duplex 6-3, A-3
print jobs

deleting from queue 3-10
previewing 4-13, 4-14
routing 3-24 to 3-26

Print Pages command
Command WorkStation 3-10, 4-6
Control Panel 1-5

Print status bar 3-18
Print Status screen 1-3
problems,  see troubleshooting
Process Next command 3-11, 3-25, 8-5
Properties command 3-11, 3-25, 4-23
Properties dialog box 4-22
PS Setup option 1-8

Q
queues 3-17
Queues window

changing the proportions 3-18
deleting held jobs C-5
described 3-16
elements 3-7
spooled jobs 3-17
update 4-31

R
raster

data 3-22, 3-24, 8-5
icon 3-20
image 3-17

raster files
editing 4-15
previewing 4-13
saving 3-17
saving an edited document 4-18, 4-22

rasterizing, see RIPping
reader’s spread 5-3
Reboot (server) command 3-12, 4-37

Refresh command 3-13
remote users C-5, C-8
Remove Raster command 3-11, 3-25, 8-5
Rename command 3-10, 3-24, 8-5
reordering pages

automatically A-7
layout mode 6-11

Repeat option 6-9
Restart Fiery command, on FieryBar 2-2
restricting access to server xvii
Resume Print command, on FieryBar 2-3
Resume Printing command

Command WorkStation 3-12
Control Panel 1-5

Revert to Default Settings command 3-13
right mouse button commands 3-24 to 3-26
RIP, defined xv
RIP and Hold command 3-10, 3-24, 8-5
RIP area 3-3, 3-22
RIPped jobs 3-4, 8-3
RIPping 3-17
RIP Status screen 1-3
rotating pages 6-12
rows

clipping of content area 6-4
selecting number in layout 6-4, 6-5

Rows menu 6-4, 6-5
Run Diagnostics command

from Control Panel 1-6
on FieryBar 2-3

Run Setup command 1-6

S
saddle

defined 6-8, A-6
groups in 6-9

saddle stitch binding
characteristics of 6-8
creep 6-3
defined A-6
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groups A-6
gutters 6-13

safety xviii
Save As dialog box 5-10
Save Template icon 6-14
saving imposition settings 5-9
Scale To Fit 6-8
Scaling area

Finished Height field 6-8
Finished Width field 6-8
interaction of controls 6-6
percentage 6-7

scanning 4-10
SEF prefix 6-3
Send to Server command 3-11, 3-26, 4-30
server

cleaning xviii
clearing C-8
configuring 3-5
connecting from Command 

WorkStation 3-5, 3-13, 4-30
display window xviii
managing multiple color servers 4-30
restarting 1-8, 2-4
selecting another 3-13, 4-30
shutting down 1-9, 2-5
working with more than one 4-30

server fonts, see fonts
Server Information slider 3-14
Server menu commands 3-12
Server Selection tabs 3-13
Server Setup option 1-7
Setup command 3-12, 4-37
Set Up Fiery command, on FieryBar 2-2
sheet

defined A-1
navigating to selected 5-5
number of columns 6-5
number of rows 6-4
orientation 6-3
reordering pages 6-11

short-edge feed (SEF) 6-3
size 6-2
thickness 6-3
viewing by number 5-8
viewing entire 5-7

Sheet area 6-2
sheet information 6-6
Sheet menu 5-5
shingling A-7
short-edge feed sheet size 6-3
‘showpage’ after EPS files option 4-29
Shut Down command, from Control 

Panel 1-6
signature A-2
simplex printing A-3
Size menu 6-2
sliders 3-14
sorting jobs 3-28, 3-31
source file 4-15
spine A-6
spool, defined xv
Spool area 3-3, 3-20
spooled jobs

displayed in Fiery WebSpooler 8-4
icons 3-20
in Queues window 3-3

spool file
managing 6-16
PDF format 6-16
PostScript format 6-16
size of 6-16

starting the server 1-6, 2-4
status, FieryBar 2-1
status bars

animation 3-18
in Queues window 3-2, 3-17
Print 8-3
RIP 8-3
Spool 8-3

status screens, Control Panel 1-3
Status WebTool, see Fiery WebTools
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step-and-repeat printing 6-9
Suspend Print command, on FieryBar 2-3
Suspend Printing command

from Command WorkStation 3-12
from Control Panel 1-5

switching servers 3-13, 4-31
system information 3-14
system performance C-5

T
target file 4-15
template

applying 5-9
creating 5-9
defined 5-8
deleting 6-15
saving 6-14
saving imposition settings 6-14
selecting 5-9

Template menu 5-9
temporary files 6-16, 6-17
Test Page

printing C-9
printing from 

Command WorkStation 4-7
printing from Control Panel 1-5
problem printing C-9

Thumbnail A
editing options 4-16, 4-17
page commands 4-15, 4-16
page display 4-13
window 4-15

Thumbnail A command 3-11, 3-25, 8-6
Thumbnail B 4-15
Thumbnail B command 3-11, 3-25, 8-6
time 6-6
Trim Marks 6-6, A-5
troubleshooting

Command WorkStation cannot connect 
to server C-6, C-7

Command WorkStation hangs C-6

file management tips 6-16
general guidelines C-6
slow redraw 5-5
touch-up tool problems 6-15
unexpected printing results C-7, C-8
users are unable to connect to the 

printer C-8

U
undo, in editing thumbnail views 3-43, 4-21
Undo command 3-12
Unique option 6-10
up button 1-2
Use Master option 4-25

V
variable data printing 3-29, 4-25
View in Helper App command 3-13
View menu 5-5, 5-7
view modes

compared 5-6
layout 5-5
preview 5-5

Volume column, in Archive window 3-28

W
warning

"Disk full" C-5
display window breakage xviii

WebDownloader WebTool, see Fiery 
WebTools

WebLink WebTool, see Fiery WebTools
WebSetup WebTool, see Fiery WebTools
WebSpooler,  see Fiery WebSpooler
WebTools, see Fiery WebTools
Window menu commands 3-13
window selection tabs 3-7, 3-16
workflow scenarios 4-8
working with more than one server 4-30

Z
Zoom tool 5-6
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